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ASG Support Numbers

ASG provides support throughout the world to resolve questions or problems regarding
installation, operation, or use of our products. We provide all levels of support during normal
business hours and emergency support during non-business hours. To expedite response time,
please follow these procedures.

Please have this information ready:

. Product name, version number, and release number
J List of any fixes currently applied
. Any alphanumeric error codes or messages written precisely or displayed

. A description of the specific steps that immediately preceded the problem

o The severity code (ASG Support uses an escalated severity system to prioritize service to
our clients. The severity codes and their meanings are listed below.)

. Verify whether you received an ASG Service Pack for this product. It may include
information to help you resolve questions regarding installation of this ASG product. The
Service Pack instructions are in a text file on the distribution media included with the
Service Pack.

If You Receive a Voice Mail Message:

1 Follow the instructions to report a production-down or critical problem.

2 Leave a detailed message including your name and phone number. A Support representative
will be paged and will return your call as soon as possible.

3 Please have the information described above ready for when you are contacted by the Support
representative.

Severity Codes and Expected Support Response Times

Severity Meaning Expected Support Response
Time
1 Production down, Within 30 minutes

critical situation
2 Major component of product disabled Within 2 hours

3 Problem with the product, but customer has ~ Within 4 hours
work-around solution

4 "How-to" questions and enhancement Within 4 hours
requests

ASG provides software products that run in a number of third-party vendor environments. Support
for all non-ASG products is the responsibility of the respective vendor. In the event a vendor
discontinues support for a hardware and/or software product, ASG cannot be held responsible for
problems arising from the use of that unsupported version.



Business Hours Support

Your Location

Phone

Fax

E-mail

United States and
Canada

Australia
England
France
Germany

Singapore

All other countries:

800.354.3578

61.2.9460.0411
44.1727.736305
33.141.028590
49.89.45716.222
65.332.2922

1.941.435.2200

941.263.2883

61.2.9460.0280
44.1727.812018
33.141.028589
49.89.45716.400
65.337.7228

Non-Business Hours - Emergency Support

Your Location

Phone

Your Location

support@asg.com

support.au@asg.com
support.uk@asg.com
support.fr@asg.com

support.de@asg.com

support.sg@asg.com

support@asg.com

Phone

United States and
Canada

Asia
Australia
Denmark
France
Germany
Hong Kong
Ireland
Israel/Bezeq
Japan/IDC

800.354.3578

65.332.2922
0011.800.9932.5536
00.800.9932.5536
00.800.3354.3578
00.800.3354.3578
001.800.9932.5536
00.800.9932.5536
014.800.9932.5536
0061.800.9932.5536

Japan/Telecom
Netherlands
New Zealand
Singapore
South Korea
Sweden/Telia
Switzerland
Thailand

United Kingdom

All other countries

0041.800.9932.5536
00.800.3354.3578
00.800.9932.5536
001.800.3354.3578
001.800.9932.5536
009.800.9932.5536
00.800.9932.5536
001.800.9932.5536
00.800.3354.3578

1.941.435.2200



ASG Web Site

Visit http://www.asg.com, ASG’s World Wide Web site.

Submit all product and documentation suggestions to ASG’s product management team at
http://www.asg.com/asp/emailproductsuggestions.asp.

If you do not have access to the web, FAX your suggestions to product management at (941)
263-3692. Please include your name, company, work phone, e-mail ID, and the name of the ASG
product you are using. For documentation suggestions include the publication number located on
the publication’s front cover.


http://www.asg.com/asp/emailproductsuggestions.asp
http://www.asg.com
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Preface

This ASG-SmartTest PLI User’s Guide provides user information about ASG-SmartTest
PL/I (herein called SmartTest-PLI). SmartTest-PLI provides testing and debugging
processes for applications in the PL/I environment. SmartTest-PLI is fully integrated with
ASG-SmartTest (herein called SmartTest). All basic and extended facilities are available
including: program view, execution control, Breakpoints, monitoring and changing data,
pseudocode, abend processing, Backtrack, and the COBOL intelligent search function.

Allen Systems Group, Inc. (ASG) provides professional support to resolve any questions
or concerns regarding the installation or use of any ASG product. Telephone technical

support is available around the world, 24 hours a day, 7 days a week.

ASG welcomes your comments, as a preferred or prospective customer, on this
publication or on any ASG product.

About this Publication

This publication consists of these chapters:

. Chapter 1, "Introduction," provides an introduction to SmartTest-PLI.

. Chapter 2, "SmartTest-PLI Test Session," introduces the SmartTest test session.

. Chapter 3, "Test Session: Additional Environments." provides information for
setting up SmartTest in additional environments.

. Chapter 4, "Testing Techniques." presents common SmartTest testing and
debugging techniques.

. Chapter 5, "Analysis Features." describes the SmartTest-PLI Intelligent Search
Function

. Chapter 6, "Additional Languages." provides information about SmartTest-PLI
with Assembler and COBOL.

. Chapter 7, "Help Facility," describes the comprehensive and context-sensitive Help
facility, including an online Help Tutorial.

vii
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Related Publications

viii

The documentation library for ASG-SmartTest PLI consists of these publications (where
nn represents the product version number):

Note:

ASG-Center Installation Guide (CNX0300-nn) contains installation and
maintenance information for ASG-Center, the common set of libraries shared by the
ASG-ESW suite of products.

ASG-SmartTest CICS User s Guide (STC0200-nn) contains specific commands and
test session setup information for the CICS environments.

ASG-SmartTest for COBOL and Assembler User’s Guide (STA0200-nn) contains
introductory and usage information for COBOL and Assembler. It also contains test
session setup information for the TSO, ISPF, IMS/DB, DB/2, BTS, and Batch
environments.

ASG-SmartTest IMS Users Guide (STM0200-nr) contains specific commands and
test session setup information for the IMS/DC environments.

ASG-SmartTest Installation Guide (STX0300-nn) contains information for
installing and maintaining ASG-SmartTest.

ASG-SmartTest PLI User's Guide (STL0200-nn) contains introductory and usage
information about how to use ASG-SmartTest with the PL/I language. It also
contains test session setup information for the TSO, ISPF, IMS/DB, DB/2, BTS,
and Batch environments.

ASG-SmartTest Quick Start for COBOL/ASM (STA0900-nn) summarizes how to
use ASG-SmartTest with the COBOL or Assembler language.

ASG-SmartTest Quick Start for PL/I (STL0900-nn) summarizes how to use
ASG-SmartTest with the PL/I language.

ASG-SmartTest Reference Guide (STX0400-nn) contains detailed reference
information about CUA pull-downs and pop-ups, ASG-SmartTest command
syntax, and pseudo code.

ASG-SmartTest Reference Summary (STX0600-nn) summarizes the syntax and
usage of ASG-SmartTest commands.

ASG-SmartTest TCA User’s Guide (STT0200-nn) contains procedures for using the
ASG-SmartTest-PLI-TCA (Test Coverage Analysis) option.

To obtain a specific version of a publication, contact the ASG Service Desk.
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ASG-Existing Systems Workbench (ASG-ESW)

ASG-ESW (herein called ESW) is an integrated suite of components designed to assist
organizations in enhancing, redeveloping, or re-engineering their existing systems. ESW
products use the Application Knowledge Repository (AKR) to store source program
analysis information generated by the Analytical Engine. Figure 1 represents the
components of ESW.

Figure 1 + ASG Existing Systems Workbench

Existing Systems Workbench I

HI ASG-Insight for Program Understanding |

HI ASG-Estimate for Resource Estimation |

ASG-SmartEdit for COBOL Editing
ASG-SmartEdit-Browse

ASG-SmartTest for Testing/Debugging
-TSO
-CICs

ASG-Center - IMS

- ASM

- APS

- PLI

-TCA

- DB2 Stored Procedure

N H ASG-SmartDoc for Program Documentation |
Application

Knowledge
Repository (AKR)

%| ASG-Recap for Portfolio Analysis |

HI ASG-Alliance for Application Understanding |

%I ASG-Encore |

HI ASG-AutoChange |

3} ASG-Bridge |

X
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This table contains the name and description of each ESW component:

ASG-Alliance Alliance

The application understanding component that is
used by IT professionals to conduct an analysis of
every application in their environment. Alliance
supports the analysis and assessment of the
impact of change requests upon an entire
application. Alliance allows the programmer/
analyst to accurately perform application analysis
tasks in a fraction of the time it would take to
perform these tasks without an automated
analysis tool. The impact analysis from Alliance
provides application management with additional
information for use in determining the resources
required for application changes.

ASG-AutoChange AutoChange

The COBOL code change tool that makes
conversion teams more productive by enabling
quick and safe changes to be made to large
quantities of code. AutoChange is an interactive
tool that guides the user through the process of
making source code changes.

ASG-Bridge Bridge

The bridging product that enables field expansion
for program source code, without being required
to simultaneously expand the fields in files or
databases. Because programs are converted in
smaller groups, or on a one-by-one basis, and do
not require file conversion, testing during the
conversion process is simpler and more thorough.

ASG-Center Center

The common platform for all ESW products.
Center provides the common Analytical Engine to
analyze the source program and store this
information in the AKR. This common platform
provides a homogeneous environment for all
ESW products to work synergistically.
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ASG-Encore

Encore

The program re-engineering component for
COBOL programs. Encore includes analysis
facilities and allows you to extract code based on
the most frequently used re-engineering criteria.
The code generation facilities allow you to use the
results of the extract to generate a standalone
program, a callable module, a complement
module, and a CICS server. Prior to code
generation, you can view and modify the
extracted Logic Segment using the COBOL
editor.

ASG-Estimate

Estimate

The resource estimation tool that enables the user
to define the scope, determine the impact, and
estimate the cost of code conversion for COBOL,
Assembler, and PL/I programs. Estimate locates
selected data items across an application and
determines how they are used (moves, arithmetic
operations, and compares). Time and cost factors
are applied to these counts, generating cost and
personnel resource estimates.

ASG-Insight

Insight

The program understanding component for
COBOL programs. Insight allows programmers
to expose program structure, identify data flow,
find program anomalies, and trace logic paths. It
also has automated procedures to assist in
debugging program abends, changing a
computation, and resolving incorrect program
output values.

ASG-Recap

Recap

The portfolio analysis component that evaluates
COBOL applications. Recap reports provide
function point analysis and metrics information,
program quality assessments, intra-application
and inter-application comparisons and
summaries, and historical reporting of function
point and metrics information. The portfolio
analysis information can also be viewed
interactively or exported to a database,
spreadsheet, or graphics package.

ASG-SmartDoc

SmartDoc

The program documentation component for
COBOL programs. SmartDoc reports contain
control and data flow information, an annotated
source listing, structure charts, program summary
reports, exception reports for program anomalies,
and software metrics.

xi
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ASG-SmartEdit SmartEdit The COBOL editing component that can be
activated automatically when the ISPF/PDF
Editor is invoked. SmartEdit provides
comprehensive searching, inline copybook
display, and syntax checking. SmartEdit allows
you to include an additional preprocessor (for
example, the APS generator) during syntax
checking. SmartEdit supports all versions of IBM
COBOL, CICS, SQL, and CA-IDMS.

ASG-SmartTest SmartTest The testing/debugging component for COBOL,
PL/I, Assembler, and APS programs in the TSO,
MVS Batch, CICS (including file services), and
IMS environments. SmartTest features include
program analysis commands, execution control,
intelligent breakpoints, test coverage, pseudo
code with COBOL source update, batch connect,
disassembled object code support, and full screen
memory display.

Invoking ESW Products

Xii

The method you use to invoke an ESW product depends on your system setup. If you
need assistance to activate a product, see your systems administrator. If your site starts a
product directly, use the ISPF selection or CLIST as indicated by your systems
administrator. If your site uses the ESW screen to start a product, initiate the ESW screen
using the ISPF selection or CLIST as indicated by your systems administrator and then
typing in the product command on the command line.

The product names can also vary depending on whether you access a product directly or
through ESW. See "ESW Product Integration" on page vii for more information about
using ESW.
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To initialize ESW products from the main ESW screen, select the appropriate option on
the action bar pull-downs or type the product shortcut on the command line.

Alliance AL Understand » Application
AutoChange CcC Change P Conversion Set
Bridge BR Change » ASG-Bridge
Encore (Re-engineer) EN Re-engineer » Program
Estimate ES Measure » ASG-Estimate
Insight (Understand) IN Understand » Program
Recap (Portfolio Analysis) RC Measure » Portfolio
SmartDoc (Document) DC Document » Program
SmartEdit SE Change » Program

Or

Change » Program with Options

SmartTest ST Test » Module/Transaction

ESW Product Integration

Because ESW is an integrated suite of products, you are able to access individual ESW
products directly or through the main ESW screen. As a result, you might see different
fields, values, action bar options, and pull-down options on a screen or pop-up depending
on how you accessed the screen or pop-up.

Certain ESW products also contain functionality that interfaces with other ESW products.
Using SmartTest as an example, if Alliance is installed, SmartTest provides a dynamic
link to Alliance that can be used to display program analysis information. If Insight is
installed and specified during the analyze, the Insight program analysis functions are
automatically available for viewing logic/data relationships and execution path. For
example, the Scratchpad option is available on the Options pull-down if you have Insight
installed. Access to these integrated products requires only that they be installed and
executed in the same libraries.

xiii
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Examples

Example 1. Figure 2 shows the Encore Primary screen that displays when you access
Encore directly.

The Encore Primary screen contains these eight action bar menu items: File, View,
Extract, Generate, Search, List, Options, and Help.

Figure 2 « Encore Primary Screen

File Uiew Edtract Generate 3Zearch List Options  Help

AEG-Encare
CoHHand ===
etttk e e Wbtk
Aotk debookk dobolelolk ebototck
eddoth eddotk dehdettck  tedetokk Hefok
oot oot debtsok etttk Hepok
Hefototok
etk

Copykight Allen Swsteds Graup, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Uizit the ASG Zupport Web fite at www.asg.cod

Figure 3 shows the Encore Primary screen that displays when you access Encore through
ESW by selecting Re-engineer P Program from the ESW action bar menu. Notice that the
Primary screen name changes to ASG-ESW - Program Re-engineering when you enter
Encore through ESW. Also, the Logic menu item displays if Insight is installed.

Figure 3 « ESW Encore Primary Screen

File UView Edtract Generate Search Logic List Options Help

ASE-EIN - Prograd Re—engineering

CoHHand ===
Aottt Hetebbt bbb Aottt
Aettsick desteik etttk etetotek:
Aottt Aottt Hebetebbt bbbk Hebek
Aottt Aottt debebbebk bbbk Hebek
Atk
Aotk

Copyright Allen Systeds Group, Inc., an unpublished wark.
A proprietary product of ASG, Inc. Use restricted to authorized licensess.
Visit the ASE Support Web Zite at wuw,asg.cod
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Example 2. Figure 4 shows the File - Analyze Submit pop-up that displays when you
access SmartTest directly. Figure 5 shows the File - Analyze Submit pop-up that displays
when you access SmartTest through ESW.

Notice that the Analyze features field in Figure 5 lists additional ESW products than
shown on Figure 4. This field is automatically customized to contain the ESW products
you have installed on your system.

The actions shown on these screens also vary. For example, the D action (ASG-SmartDoc
Options) is available on the File - Analyze Submit screen if the SmartDoc product is
installed on your system. In Figure 4, the ASG-SmartDoc Options action is not available.

Figure 4 « File - Analyze Submit Screen

File - Analyze SUbHiT
CorAdand ===

E - Edit JCL 2 - EUbHIit JCL

CoMpile and link JoL (PDE or sequential):
Data set nane 'USER1Z2.REL.CGHNTL{VIAPCOBC)

Analyze features [v-M]i
REG—EMartTests ¥ Extended Analy=isl M

AKR data set naWe 'USER1Z2, GEMERAL.AKR’
AKR prograd nade [if overriding PROGRAA-IO0)

Analyze options:

CoHpile? [Y<H] o« v o« v o o o o T [¥ if needad by features)
Link l1oad Hodule reusable® [Y-M] T

Figure S« File - Analyze Submit Screen (Accessed through ESW)

File - Analwze ZubHit
CoHHand ===

E - Edit JCL ¥ - EubMiT JOL 0 - A%E-EnartDoc Options

CoHpile and link JCL [PDS or sequentiall:
Data sef nade 'USER1Z2.REL.CNTLIHTEST)

Analyze features [Y-M]:
AEG-In=sights T AEG-EHartTestl I Exdtended Analwsi=l N
AEG-ERarthoc: N AEG-Encores N

AKR data =set naHe 'UZERL1Z.GEMERAL.AKR’

AKR prograd nade [if owverriding PROGRAA-I0]

Analyze options:

CoHpile? (YNl « o o« o &« & & & & T [ if needed by features)
Link l1oad Hodule reusable® [veM] T [ASG-5HartTest
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Publication Conventions

Xvi

ASG uses these conventions in technical publications:

Convention

Represents

ALL CAPITALS

Initial Capitals on Each Word

lowercase italic
monospace

Monospace

Vertical Separator Bar (| )
with underline

Directory, path, file, dataset, member, database,
program, command, and parameter names.

Window, field, field group, check box, button, panel (or
screen), option names, and names of keys. A plus sign
(+) is inserted for key combinations (e.g., Alt+Tab).

Information that you provide according to your
particular situation. For example, you would replace
filename with the actual name of the file.

Characters you must type exactly as they are shown.
Code, JCL, file listings, or command/statement syntax.

Also used for denoting brief examples in a paragraph.

Options available with the default value underlined (e.g.,
YIN).



Introduction

This chapter provides an introduction to SmartTest and contains these sections:

Interactive Testing/Debugging 1
Testing Support 3
SmartTest-PLI Interfaces 4
Command Targets 5
PL/I Optimization Considerations 9
Limitations 9

SmartTest is the testing and debugging component of ESW for COBOL, PL/I, Assembler,
and APS programs in the TSO, MVS Batch, CICS (including file services), and IMS
environments. SmartTest features include program analysis commands, execution
control, intelligent breakpoints, test coverage, pseudo code with COBOL source update,
batch connect, disassembled object code support, and full screen memory display

Interactive Testing/Debugging

PL/I programs are prepared for a SmartTest testing and debugging session using the
Analyze feature. Output from the Program Analyze process is stored in the AKR. This
information then becomes an integrated component of the test session.

Once a PL/I program is prepared for SmartTest testing, interactive testing and debugging
can begin.

SmartTest-PLI enables PL/I programs to be viewed, analyzed, tested, and debugged at
the source level. It executes in the TSO/ISPF environment and provides full ISPF
compatibility, which facilitates learning and usage through a standard IBM interface.
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SmartTest-PLI interfaces features Common User Access (CUA) screens, pull-downs, and
pop-ups that are designed to provide easy access to all of the product features. Powerful
SmartTest-PLI commands can be used instead of, or in conjunction with, the selections
offered from the action bar.

SmartTest-PLI provides these comprehensive testing and debugging features and

functions:

Comprehensive
Program Knowledge

The testing environment contains complete knowledge about
the program including its syntax, logic relationships, and
execution flow. This knowledge is stored in the AKR.

PL/I Intelligence

Dynamic Breakpoints can be set based on PL/I syntax
statements or conditions.

Script Automation

A predefined command sequence can be included in any test
session. These script files can be created automatically during
a test session, then used for regression testing of a program.

Scrollable Window In-context windows for data display and logic provide easy
Displays access to related information.
Hot Key Branching Hot key branching between paragraphs, sections, and called

routines provides easy access to related logic.

Assembler Integration

Full screen Assembler integration of programs, called
modules, or memory display of data elements is provided.

ESW Integration

ESW integrates the ESW family of products that support the
automation of the software maintenance cycle.

Execution Review
(Backtrack)

Execution history may be viewed using the Backtrack Facility.
This feature allows you to step backward or forward through
the executed code and view data values as they existed when
specific statements were executed.

The dramatic advantage SmartTest-PLI has over conventional program debugging tools
is that it is PL/I intelligent. It provides comprehensive analysis information about a

program.

SmartTest-PLI effectively presents information in an interactive environment for online
querying and/or testing on a display screen. The results of new code or enhancements can
be quickly and accurately tested to determine their impact on the rest of the program
logic. Program errors are easily recognized and can be quickly corrected.



Testing Support

1 Introduction

SmartTest runs under MVS (XA/ESA) TSO/ISPF (Release 3.x) and supports these

languages, execution environments, and databases:

Supported Languages

COBOL II

OS PL/I Version 2.3
PL/IMVS & VM
COBOL/370
CASE-generated COBOL
High-level Assembler
CA-Optimizer I (COBOL 1)
INTERSOLV APS

Supported Execution Environments

TSO

BTS

DLI

CICS Version 3.3 through Version 4.1
CICS/TS 1.1, 1.2,and 1.3

CICS command level programs
IMS/DC

ISPF Dialog Manager

HOGAN

LANGUAGE ENVIRONMENT
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Supported Databases
« VSAM
« IMS/DB (DL/1)
« DB2
« IDMS/DB

. SYSTEM 2000
. DATACOM/DB
. TOTAL/TIS

SmartTest-PLI Interfaces

SmartTest-PLI provides Common User Access (CUA) screens, pull-downs, and pop-ups
designed to provide easy access to all of the product features. In addition, all functions are
available using primary or line commands.

The CUA Interface

All CUA screens include action bars. An action bar is the line of keywords displayed at
the top of the screen. Each keyword represents actions that are available on that screen.
To view the list of actions on a pull-down, move the cursor to the desired keyword, and
press Enter. To make a selection, enter the number that corresponds to the desired action,
or place the cursor on the desired action and press Enter. Selecting an action followed by
an ellipsis (...) displays a pop-up requesting more information.

A pop-up is a window that is superimposed on your screen to allow entry of information
for the requested action. Complete the requested action by entering the desired data and
options and pressing Enter.

Command Processing

SmartTest-PLI provides both primary commands, entered in the command input area at
the top of the screen, and line commands, entered in the line sequence number area of the
screen.

SmartTest-PLI line commands are processed before primary commands.

Commands entered by pressing a PF key are handled as if entered in the primary
command input area. If a command is entered by pressing a PF key, the contents of the
command input area are appended to the PF key command. The combined text is then
executed as a whole.
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Multiple commands entered in the command input area are separated by an ISPF
command delimiter (usually a semicolon) and are processed in a left-to-right sequence.

Note:

The command delimiter is defined for ISPF in the COMMAND DELIMITER field on the
ISPF Terminal Characteristics screen.

See the ASG-SmartTest Reference Guide for details on CUA and command syntax.

Screen Format

SmartTest screens are modeled after the TSO/ISPF edit screen. Figure 6 shows a
SmartTest Program View screen.

Figure 6 « SmartTest Screen Example

File View Test Search List Options Help
(A) (B)

Program View VIAPPLI.VIAPPLI1 -A
Command ===> (C) Scroll ===> (D) CSR
>>>>>> DATA PACKED DEC = DATA PACKED DEC + 1;
veeeow o T T T T +
ttrrrt | 03 DATA_PACKED_DEC DEC FIX (15,0) ADDR 000D6870 |
rrerne VALUE > < * INVALID NUMERIC * |
L T T T T ey +
000483
- - - - - - - - - - - - - - - - - - 20 LINES NOT DISPLAYED
000504
(F)005 SOCTFIX1:
000506 RETURN;
000507
000508 END sSOC7_DEMO;
000509
(E)
(G)
o +
|STATUS: DATA EXCEPTION (0C7) PROGRAM: VIAPPLI1 DATE: DDMMMYYYY |
| STMT: 000482 OFF: 000C10 AMODE: 31 MODULE: VIAPPLI ~ TIME: HH:MM:SS |
| SOURCE: DATA_PACKED DEC = DATA_ PACKED_DEC + 1; I
o +
(A) Program View Name of the screen.

(B) VIAPPLL.VIAPPLI1  Module/program being viewed (module.program). This

area of the screen is called the short message area and is also
used to temporarily display short informational or error
messages. A value of -A (Active program) following the
module.program name indicates that this program is
currently being tested. A value of -Q (Qualified) indicates
this program has been displayed for viewing on the Program
View screen while another program is being tested.

(C) Command ===> This is the primary field for entering SmartTest-PLI

commands.
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(D) Scroll ===>

Scroll specifies the number of lines or columns to scroll the
display screen. The Scroll ===> field is omitted from
screens that cannot be scrolled. These are the valid values:

1- 9999: Specifies the number of lines or columns to scroll.

CSR: Specifies the screen is to be scrolled until the cursor
is at the top, bottom, left side, or right side of the screen.

MAX: Specifies that the top, bottom, right, or left margin is
the scroll value.

HALF: Specifies a scroll value of a half screen.
PAGE: Specifies a scroll value of one screen.

DATA: Specifies a scroll value of one line less than a
screen. This field is omitted from screens that cannot be
scrolled.

(E) Long message area

Descriptive, informational, or error messages are displayed
in this area. Long messages are displayed when there are no
corresponding short messages, or when HELP is entered in
the command input area while a short message displays.

(F) Line command input
area

SmartTest line commands may be entered over the
displayed line numbers in columns 1 through 6 as with other
TSO/ISPF editor screens.

(G) Status box at the
bottom of the SmartTest
screen

This provides current status information about the program
being tested including the reason for an interruption in
execution, the current statement number and offset in the
program, and the text of the next source statement to be
executed.
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Command Targets

A target is the object of a SmartTest primary command. Targets are defined in these
categories:

. Label name

. Variable name
. Pattern string

. Line range

. Procedure name

. Subset name

Label Name Target

A label name in a program is any section name. A label in PL/I is any PL/I block or label
name. A label name in an Assembler program is any Assembler label. A label name in
COBOL is any paragraph or section name. The label name specifies all transfers of
control to a section.

Variable Name Target
A variable name can be:
. Elementary variable name - String or arithmetic

. Program control variable - Pointers

. Aggregates - Arrays and structures

Any legal reference for a data element can be specified as a variable name. Any reference
to an entry in an array is treated as an individual element. When variable items overlap so
a name can refer to parts of multiple variable items, searches are performed on each part
and all references are reported.

Fully qualified variable names can be specified by the high- to low-level qualifiers
separated by periods, for example:

PROCEDURE NAME.DATA NAME ELEMENT

Multiple variable names can be located at the same time by concatenating the variable
names with a plus sign (+) between them, for example:

DATA NAME1l + DATA NAME2
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Pattern String Target

A pattern string is a sequence of characters. It must be surrounded by single or double
quotes if it contains blanks. Strings of non-alphanumeric characters can be specified by
the X'string', T'string',and P'string' operands. The string can be further qualified
using the WORD, PREFIX, or SUFFIX subordinate operands.

Syntax Element Description

X'string' Specifies a hexadecimal string, enclosed in single or double quotes.

T'string Specifies a text string, which disregards upper and lowercase,
enclosed in single or double quotes.

P'string Specifies a picture string, enclosed in single or double quotes. These
are the valid picture strings
P'=" Any character
P—"  Any nonblank character
P Any nondisplay character
P'# Any numeric character
p- Any non-numeric character

P'@' Any alphabetic character (upper or lowercase)
P'<"  Any lowercase alphabetic character

P™>'"  Any uppercase alphabetic character

P'$' Any special character (not alphabetic or numeric)

WORD Specifies a string preceded and followed by any non-alphanumeric
character (except hyphen).

PREFIX Specifies a word that begins with the specified string.

SUFFIX Specifies a word that ends with the specified string.

Line Range Command Target

A line range target can be a single line or a group of lines. Line ranges are specified by
placing a hyphen (-) between the first and last line numbers in the range (e.g., 214 - 376).
Line numbers are shown in the first six columns on the Program View screen. If the
specified line number is greater than the last line in the program, the last line is assumed.

Procedure Name Target

The procedure name is the internal CSECT name assigned by PL/I to the specified PROC
statement.
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Subset Name Target

This is one of the PL/I language subsets. See "Searching for PL/I Language Subsets" on
page 163 for a table of subsets.

PL/l Optimization Considerations

SmartTest-PLI may test optimized PL/I programs differently than non-optimized
programs because of modifications made to the program code by the optimizer. Testing
optimized PL/I programs may produce these results:

. Certain source lines may appear not to be executable from the Program View
screen, and cause unexpected results for commands such as STEP, BREAK, and
ZA (Zoom Assembler).

. Use the GO command with care. Source code can be altered or even eliminated in
the optimization process. As a result, unpredictable or erroneous results can occur
with the GO command. See the optimized assembler output generated by the
compiler as a navigational tool for testing optimized programs.

. The PL/I Optimizer often moves all or part of the processing for one statement to
another statement. When this occurs, you may find that certain variables remain
unchanged, even after a statement that modifies the field.

Note:
For the SmartTest-PLI test session, you should not use the PL/I Optimizer. After
completion of testing and correction, you can recompile using the Optimizer to get a
more efficient program.

Limitations

These PL/I coding techniques are unsupported in all current and past versions of
SmartTest-PLI. ESW is currently unable to support Based variables when the variable is
based on a pointer that is defined as part of an array of pointers. For example, this code is
supported by SmartTest-PLI:

DCL 1 BASIS BEREICH, /* Individual pointer declarations */
3 Pl PTR,

P2 PTR,

P3 PTR,

P4 PTR,

P5 PTR;

w w w w

DCL BEREICHI1 CHAR (20) ;
DCL BEREICH2 CHAR (20) ;
DCL BEREICH3 CHAR (20) ;
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DCL
DCL

BEREICH4
BEREICHS

P_BASIS = ADD

Pl
P2
P3
P4
P5

DCL

DCL

DCL

DCL

However, this variation on the same code is not currently supported by SmartTest-PLI:

= AD
= AD
= AD
= AD
= AD

1 STRUKI1A
3 F1
3 F2
1 STRUK2A
3 F1
3 F2
1 STRUK3A
3 F1
3 F2
1 STRUK4A
3 F1
3 F2
DCL 1 STRU
3 F1
3 F2

STRUK1A.F1
STRUK1A.F2
STRUK2A.F1
STRUK2A.F2
STRUK3A.F1
STRUK3A.F2
STRUK4A.F1
STRUK4A.F2
STRUKS5A.F1
STRUKS5A.F2
STRUK4A.F1

CHAR(20) ;
CHAR(20) ;

R (BASIS BEREICH) ;

DR (BEREICH1) ;
DR (BEREICH2) ;
DR (BEREICH3) ;
DR (BEREICHY) ;
DR (BEREICHS) ;

BASED (P1),
CHAR (10),
CHAR(10) ;
BASED (P2),
CHAR (10),
CHAR(10) ;
BASED (P3),
CHAR (10),
CHAR(10) ;
BASED (P4) ,
CHAR(10),
CHAR(10) ;
K5A BASED (P5),
CHAR(10),
CHAR(10) ;

= '"AIA1AIAIAL";
= 'B1B1B1B1B1';
= 'A2A2A2A2A2';
= 'B2B2B2B2B2';
= 'A3A3A3A3A3';
= 'B3B3B3B3B3';
= '"A4A4A4RA4A4";
= 'B4B4B4B4B4';
= 'AS5ALA5A5A5L';
= 'B5B5B5B5B5S';
= 'XXXXXXXXXX';

DCL 1 BASIS_BEREICH,

DCL
DCL
DCL
DCL
DCL

3P (5 P
BEREICH1
BEREICH?
BEREICH3
BEREICH4
BEREICHS

SIS = ADD
) = ADDR(
) = ADDR(
) = ADDR(
) = ADDR(
) = ADDR(

TR;
CHAR (20) ;
CHAR (20) ;
CHAR (20) ;
CHAR (20) ;
CHAR (20) ;

R (BASIS BEREICH) ;
BEREICHI) ;
BEREICH2) ;
BEREICH3) ;
BEREICH4) ;
BEREICHS) ;

DCL 1 STRUK1 BASED(P_(1)),

3 F1
3 F2

CHAR(10),
CHAR(10) ;

/* TABLE OF POINTER'S

*/



DCL 1 STRUK2 BASED(P_(2)),

3 F1 CHAR(10),

3 F2 CHAR (10) ;
DCL 1 STRUK3 BASED(P_(3)),

3 F1 CHAR(10),

3 F2 CHAR (10) ;
DCL 1 STRUK4 BASED(P_(4)),

3 F1 CHAR(10),

3 F2 CHAR (10) ;
DCL 1 STRUK5 BASED(P_(5)),

3 F1 CHAR(10),

3 F2 CHAR (10) ;
STRUK1.F1 "A1AIA1ALAL';
STRUK1.F2 '"B1B1B1B1B1';
STRUK2.F1 "A2A2A2A2A2"';
STRUK2.F2 "B2B2B2B2B2';
STRUK3.F1 "A3A3A3A3A3"';
STRUK3.F2 "B3B3B3B3B3';
STRUK4.F1 "A4A4R4R4A4"T;
STRUK4.F2 "B4B4B4B4BA4';
STRUK5.F1 "AS5A5ASASAS';
STRUK5.F2 "B5B5B5B5B5 ' ;
STRUK4.F1 TXXXXXXKKXK " 7

1 Introduction

The Dictionary dumps used for analysis do not contain enough information about the

Base Pointer when the pointers are contained in an array.

11
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SmartTest-PLI Test Session

This chapter introduces the SmartTest test session and contains these sections:

Topic Page

Introducing the Test Session 13
Beginning a SmartTest Session 14
SmartTest User Options 16
Application Knowledge Repository (AKR) 27
Program Analyze 30
Setting Up the Test Session 35
Saving the Test Session Setup 47
Restoring the Test Session Environment 49
Terminating a Test Session 49

Introducing the Test Session

The first time you use SmartTest, verify parameters that are initially set to installation
defaults. This section describes how to perform these tasks:

. Begin a SmartTest session.

. Set and verify these user options from the Options pull-down:

Online operation parameters. These parameters establish online operational
defaults.

Log, List, Punch, and Work file allocations. The Log, List, Punch, and Work
files are used by SmartTest for recording and printing selected information such
as error messages and printed output, and as work space.

13
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— Log, List, and Punch file processing options. The processing options determine
the processing of these files upon exiting SmartTest.

—  Script file allocations. The default script file concatenation sequence can be
altered for your session.

—  PFkey values. The PF keys can be redefined to appropriate commands for your
sessions.

. Allocate an AKR.

. Analyze a program.

Beginning a SmartTest Session

14

The method that you use to invoke SmartTest depends on your system setup. If you need
assistance to activate SmartTest, see your systems administrator.

If your site starts SmartTest directly, use the ISPF selection or CLIST as indicated by
your systems administrator. After you activate the session, the ESW Primary screen,
shown in Figure 7, displays.

Figure 7 « Existing Systems Workbench Primary Screen

File Understand Change Test Docunent Re-engineer  Heasure  Help

AEG-Exizting EFystens Workbench - ASG-ESW
CoMHand ===k _

ettt Hebbtk bbbk ettt
Aottt Eoss S s o Atttk
Aotk Aotk Eoss 5 O S 2 Hetek
Hetetek Hetetek Aotttk dstsiolek Ftk
Aetststek
Aotttk

copwright ALlen $ystens Group, IncC., an unpublished vork.
A proprietary product of A%G, IncC. Use restricted to authorized 1icensess.
Visit the ASE Support Web $ite at wuw.asq.coH




2 SmartTest-PLI Test Session

To start SmartTest, follow this step:

» Select Test » Module/Transaction. After you activate the session, the SmartTest
Primary screen, shown in Figure 8, displays.

Figure 8 « SmartTest Primary Screen

File Uiew Test =fearch List Options Help

AZG-EHartTest

Corrand ===
Aottt Aebebebt kbbbl Atttk
Aottt Aetebbt bbbk Aotttk
Hetetek Hetetek Aotttk dstsiolek Ftk
Aetststek Aetststek Atttk debstsiek Atk
Aotttk
etttk

Copyright Allen Eystens Group, IncC., an unpublished vork.
A proprietary product of ASG, IncC. Use restricted to authorized licensees.
Visit the ASG Support Web Site at wWW.asq.coH

Note:

If you start your SmartTest session using the ESW Primary screen, the product name
displays on the screens as ESW - Testing/Debugging.

15
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SmartTest User Options

16

Upon initial use of SmartTest, options should be customized to reflect the appropriate
settings for your situation. Some options are given defaults during installation.

To display the Options pull-down

1

Select Options on the action bar and press Enter. The Options pull-down, shown in
Figure 9, displays.

Figure 9 « Options Pull-down

File Uiew Test Search List Options Help

« Product paraneters...
« Product allocations...
. Log-list-punch...

. ECRipt file allocations... | seeeek
. PF kews... Hetedek
. Hodes - ZET Options...
. Equate...

CoHAHand ===

= Ry R

Copyright ALlen $ystens Group, IncC., an unpublished wark.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Web Site at wuN.asq.coH

Select one of these options from the pull-down to customize the SmartTest
environment:

Product parameters Displays the Options - Product Parameters pop-up used to
set parameters that affect the online operation of
SmartTest.

Product allocations Displays the Options - Product Allocations pop-up used to
specify allocations for the Log, List, Punch, and Work
files.

Log/list/punch Displays the Options - Log/List/Punch Definition pop-up
used to set values for allocating, formatting, and
processing the SmartTest Log, List, and Punch files.

Script file allocations Displays the Options - Script File Allocations pop-up used
to set the default script libraries.
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PF Keys Displays the Options - PF Key Definition pop-up used to
edit PF key values.

Modes Displays the Options - Modes pop-up used to enable and
disable SmartTest processing modes (LEARN, SCRIPT,
XMODE).

Equate Displays the Options - Equate pop-up used to define a

substitute name for any character string. Equated names
are used in the same manner as any dataname is used. They
can be saved in the AKR and may be viewed on the
Equates List by typing LIST EQUATES.

Note:

If you have Insight installed, this option displays as
Scratchpad on the Options pull-down. See the online help
or the ASG-Insight Reference Guide for more information
about the Scratchpad option.

Online Operation Parameters

Use the Options - Product Parameters pop-up to set parameters affecting the online
operation of SmartTest. This includes specifying whether pseudo code and equates are to
be saved.

To set online operation parameters

1

2

Select Options » Product Parameters. The Options - Product Parameters pop-up,
shown in Figure 10, displays.

Figure 10 » Options - Product Parameters Pop-up

Options - Product Paradeters

ConHand ===k
ALAFH & w4 w0 w0 m YES [YES ar NO)
Zave pseudo code . . YES [YE% ar MNO)
EZave equates . . . . YE% [¥E% or MNO)
Zave Harks o . . . . NO [YE% or MNO)
cursor character . . % [Token substitution character)

Enter the appropriate information in the fields.

17
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Fields

Alarm Controls the audible alarm on the terminal. If YES, the alarm sounds
when an error message displays. Some terminals do not support this
alarm control.

Save pseudo Specifies the default for saving pseudo code (pseudo code,

code Breakpoints, and When Conditions) when exiting from a program.
Save equates Specifies the default for saving equates when exiting from a program.
Cursor Sets the cursor token substitution character. The cursor substitution
Character character can be used in any primary command during a test session.

Any character can be specified as the token substitution character;
however, it should be a character that is rarely used in commands. The
default substitution character is the percent sign (%).

Log/List/Punch/Work File Allocations

18

Use the Options - Product Allocations pop-up to set and verify the DASD allocations for
the Log, List, Punch, and Work files. These options are initially set to default values
established during product installation by the Systems Programmer and probably only
need verifying.

To define the Log, List, Punch, and Work file allocations

1 Select Options » Product Allocations. The Options - Product Allocations pop-up,
shown in Figure 11, displays.

Figure 11 » Options - Product Allocations Pop-up with SMS

options - Product Allocations
CoHHand ===
Log file:
Generic unit . . . ERTOA [generic group name o unit address)
Valure serial . . ERTEOL [Blank for authorized default volure]
List file:
Generic unit . . . EYEDA [generic group nane o unit address)
Volure serial . . ERTEOL [blank for authorized default volude]
Punch file:z
Generic unit « « « EZRTDA [generic group nade o unit address)
Palune serial . « SRTEAL [blank for authorized default volumre]
Mork file:l
Generic unit . . . EVEDA [generic group naMe o unit address)
Volure serial o o ______ [blank for authorized default volude]
Zpace units . . . CYLE [BLKZ, TREZ or CYLE)
Frinary space . . 5 [space units)
Eecondary space 5 [space units]

2 Enter the appropriate information in the fields.
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Field Description

Log file Specifies the Management and Storage Class or the device type and
volume serial number for the Log file that is allocated upon entry into
SmartTest. Log files are used for internal messages.

List file Specifies the Management and Storage Class or the device type and
volume serial number for the List file that is allocated the first time a
request is made to print output using the LPRINT command.

Punch file Specifies the Management and Storage Class or the device type and
volume serial number for the Punch file that is allocated the first time
a request is made to punch output using the LPUNCH command.

Work file Specifies the Management, Storage, and Data Class or the device
type, volume serial number, and space requirements for the Work file
that is allocated upon entry into SmartTest. Approximately one
cylinder (on a 3380 device) is required for a 5,000 line program.

Log/List/Punch Processing Options

Use the Options - Log/List/Punch Definition pop-up to define and set processing values
for the SmartTest Log, List, and Punch files. These files are used for system message
logging, error handling, and holding the results of several SmartTest commands. It is not
necessary to exit SmartTest to process these files. Some options are initially set to default
values established during product installation by the Systems Programmer.
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To specify the Log/List/Punch Definition options

1

2

Select Options

» Log/List/Punch. The Options - Log/List/Punch Definition pop-up,

shown in Figure 12, displays.

Figure 12 « Options - Log/List/Punch Definition Pop-up

CoHHand ===

gptions - Log-List<Punch Definition

1 - Process log file 2 - Process list file I - Process punch file

options
Process option
Prinary tracks

secondary tracks

Lines per page
Fysout class

Process options: PE [(print<-keepl, PD [print<deletel, kK, or D.

Tob statedent

<eSERL TOE CACCTD, "USERL ', FRTW=E
o HEGCLAZE=N

“~tTOEPARH EYEAFF=CPUC

ok

Liig List Funch
...... K FE FE
-1 1 1
. 2 g 5
...... 56 56 56
....... * * *

4 - Custodized data set nane

infarHation.

Enter the appropriate information.

1 - Process log file

Verify or change the Options for the Log file, then select option 1 to
process the Log file. A new file is allocated to collect additional
data, if required. The Log file is processed when you press Enter.

2 - Process list file

Verify or change the Options for the List file, then select option 2 to
process the List file. By default, a new file is allocated to collect
additional data, if required. The file name is in this format:

useridyyyxxxxx.VIALIST

where:

yyy is the product ID.

xxxxx 1s a sequential number starting with 00001.

The List file is processed when you press Enter.

3 - Process punch

file

Verify or change the Options for the Punch file, then select option 3
to process the Punch file. This file is defined as fixed block with
80-byte records. The Punch file is processed when you press Enter.
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4 Customized data  Select option 4 to display the Options - Log/List/Punch Name

set name

Customization pop-up on which you can specify user-defined
dataset names for the Log, List, and Punch files. You can also
choose to be prompted for the DSN name during file processing.

Process option

Enter one of the listed processing options. The default is PD for the
Log and List files, and PK for the Punch file.

Primary tracks

Enter the number of primary tracks to allocate. A size change does
not take effect until the next allocation occurs. The default is 1 for
the Log, List, and Punch files.

Secondary tracks

Enter the number of secondary tracks to allocate. A size change
does not take effect until the next allocation occurs. The default is 2
for the Log file and 5 for the List and Punch files.

Lines per page

Enter the number of print lines per page. Typical maximum values
are 60 for six lines per inch and 80 for eight lines per inch. The
default is 56.

Sysout class

Enter the SYSOUT class value. The default is an asterisk (*), which
sends the SYSOUT to the destination specified in the MSGCLASS
parameter on the JOB statement.

Process options

Lists the available options for the Log, List, and Punch files. These
are the valid values:

. PK. Print and keep.
. PD. Print and Delete.
. K. Keep without printing.

. D. Delete without printing.

xxxxx FILE IS
ALLOCATED

Displays when the Log, List, or Punch file has been properly
allocated. If the message does not appear, check the assignments on
the Options - Product Allocations pop-up. xxxxx is LOG, LIST, or
PUNCH depending on the file that was allocated.

Job statement

Enter the appropriate JOB statement information for your

information installation. These JCL statements are required if the PK or PD
processing option has been specified for processing the Log, List, or
Punch files.

Note:

When the PK or PD option is specified, a valid job card must be specified in the JOB
STATEMENT INFORMATION field prior to processing any Log, List, or Punch files.
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If you specify K or PK process option, you can customize the data set where the log, list,
or punch file is allocated. By default, SmartTest allocates the Log, List, and Punch files,
for example:

userid.STTnnnnn.VIAXXXXX
where:

useridis your TSO user ID.

nnnnn is a sequential number from 00001 to 99999,

xxxxx 18 LOG for Log, LIST for List, and PUNCH for Punch files.

If you have specified a TSO Prefix, the prefix will be appended to the beginning of the
file name allocated for the Log, List, and Punch files.

To customize the Log, List, or Punch dataset name

1 From the Options - Log/List/Punch Definition pop-up, type 4 and press Enter to
display the Options - Log/List/Punch Name Customization pop-up shown in

Figure 13.

Figure 13 » Options - Log/List/Punch Name Customization Pop-up

gptions - LogesList<Punch Nane Custodization
CorAdand ===

You can define a custoHiZed nade when you choose option PE [print-keepl or
K [keep] by specifying Ulser). Specifwing ¥(es) on Pronpt later lets wou

define a custon nake as wou proces:z each log<list-punch file. Otherwise,

specify data set nane and file node. Then press Enter.

options Liog List Punch
File MaHing « « « « « « = u u E Ul=ser] o Z[ysted]
Prodpt later for DEMN . . ¥ T _ vles] o Nlol

The following are needed if Ulser] and Wlo) are specified abouve

Log Data set name [=eq]
File Hode . . O ofverwrite] or ALppend]

List Data set nade [5eq]
File Hode . . _ o{verwritel or ALppend]

Punch Data set naHe [5eq]
File Hode . . _ ofverwrite] or ALppend]
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Type U in the File Naming field for Log, List, and/or Punch to indicate a user-defined
dataset name. Enter the appropriate values in these fields:

File Naming Specifies whether the Log, List, and Punch files are named
by system default (S) or user-defined (U) dataset names.

Prompt later for DSN  Enables you to define a custom name during processing. If
you specify N, you must enter a dataset name in the
corresponding Data set name field, and specify Overwrite
or Append in the File Mode field.

If you specify Y in the Prompt later for DSN field,
SmartTest prompts you for the dataset name during file

processing.

Log Data set name Indicates the name of the dataset in which the Log, List, or

List Data set name Punch files will be allocated during processing.

Punch Data set name

File Mode Specifies whether additional Log, List, and Punch files
overwrite or are appended to the existing files during
processing.

If you specify Y in the Prompt later for DSN field, SmartTest prompts you for the
dataset name during file processing using the Log Name Customization pop-up,
shown in Figure 14.

Figure 14 » Log Name Customization Pop-up

Log Mame Custonization
CoMHand ===

The current 1og file's data set naWe is shown below. To have a custad
naMe, specify a new sequential data set naWe. IF it already adists, it
has to hawve LRECL=137 and RECFH=L; and specify the file Hode. Then press
Enter.

current Data set name @'
custoH Data set nawme
File Hode . . . _ ofverwritel or Alppendl

23



ASG-SmartTest PLI User’s Guide

Script File Allocations

Fields

24

Use the Options - Script File Allocations pop-up to display and/or modify the default
script file concatenation sequence for your session. Script files are sequential datasets or
members of partitioned datasets. Script files can be used to initialize a session, set default

values, set up a session, execute or re-execute a session, or execute a predefined
command sequence.

To specify your default script files

1 Select Options P Script file allocations to display the Options - Script File
Allocations pop-up, shown in Figure 15.

Figure 15 » Options - Script File Allocations Pop-up

gptions - EZcript File Allocations
CoHHand ===

R - Restore default icript allecations
Enter desired Zcript file concatenation.

FCript file data set nanes:

2 Enter or modify the dataset names to be used for the default script files for your

session. Type R to restore the default values for your installation.

Note:
When initializing for defaults, the lines are filled from the bottom to allow
concatenation.
R Restores the default Script library allocations set at install time.
Script file Enter the dataset names of the desired Script files in the order in which

dataset names  they should be concatenated.




PF Key Values

2 SmartTest-PLI Test Session

To display and/or redefine PF key values used with SmartTest

1 Select Options » PF Keys. The Options - PF Key Definition pop-up, shown in

Figure 16, displays.

Figure 16 « Options - PF Key Definition Pop-up

options — PF Eey [01-12) Definition
ConRand ===

Fress PF3-15 [EMD] to edit.

NuHber of PF kews: 24 TerHinal type: 3278
PFO1 HELP

PFO2 ZPLIT

PFO3 END

PFEd Rl

PFOS RFIND

PFOG STEF

PFOT UP

PFOS DOWN

PFO® ZUAP

PF18 ERANCH

PF11 BRANCH BRCKUP
PFi2 RECALL

Freszs Enter to process changes and-or to display alternate keys.

2 Enter the appropriate PF key values in the fields. PF keys 1 through 12 are displayed
initially. To display PF keys 13 through 24, press Enter.

The value in the Terminal type field indicates the type of terminal being used. SmartTest

supports these 3270 type terminals:

. 3270-2 (24 lines x 80 columns)
. 3270-3 (27 lines x 80 columns)
. 3270-4 (42 lines x 80 columns)
. 3270-5 (27 lines x 133 columns)
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Mode Options

To enable or disable the mode indicated by the specified option

» Select Options » Modes or type SET with no operands. The Options - Modes pop-up,
shown in Figure 17, displays.

Figure 17 « Options - Modes Pop-up

Options - Hodes

CoMHand === Forall ===> CER
AFE23431 USE THE DOWM COHAAND FOR ADDITIOMAL TEST SESSION OPTIONS.

Option Fet Description
AzH oM Dizplay Assembler code in status bod, and instruction STEP
AZHUIEN OFF  Display Assedbler code for prograns not on the AKR

AUT 0QUAL oM QUALIFY to the Active Prograd after a RUM or 3TEP
BACKTRACK ~ OFF  EBACKtrack Recording Wode is dizabled with a buffer of 1H

BERERKE oW The BREAKpoint facility is enabled

COLUHNE aFF The COLUHNE option is disabled

cUA 0N The CUA Henu facility is enabled

DATA AUT Munber of lines for Zood Data windows, o AUTO

DELAY 1 Nunber of seconds to delay between steps during STERP AUTO

FLOATING  OFF  Dizplay floating point reqisters in the status bod
GEMERATED oM DiSplay generared code With the Driginal Source Code

HE™ OFF  Display data in hedadecimWal fordat

KEEF AUTO  Humber of lines for KEEP window, or AUTO

LANGUAGE COE The current LANGUAGE for the test session is COBOL
LE OFF  MorHal Language Environdent error processing

LEARN OFF  Display internally generated Primary Coddands

LINE OFF  Honitor LINKed-to prograWs for the test session
HAIHN ON The pragran being tested i a AAINLINE

HONITOR aM The default for the RUN coWnand is HOMITOR

Each mode shown on this pop-up can be directly enabled or disabled using the SET
command with the corresponding operand. The current setting for each Test Session
option is saved between sessions with the exception of BREAK, PSEUDO, SCRIPT, and
WHENS. Defaults for these options are restored when a new session is initiated.

Scroll the screen forward to display modes that do not appear. The STOPEXEC and
STOPHAND modes only appear if the current environment is CICS.

For detailed descriptions of options, see the ASG-SmartTest Reference Guide.

Note:
For testing PL/I programs, the MAIN option must be ON.
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Application Knowledge Repository (AKR)

Before programs can be tested, your program must be analyzed. The results of the
analyze are stored in the AKR for use by SmartTest while testing. An AKR can be
defined to be shared by all users, or multiple AKRs can be defined for use by
departments, groups, or individuals.

Online and Batch utilities are provided for managing the AKR. These utilities allow you
to perform these tasks:

. Allocate or expand the AKR.
. Rename and delete programs.

. Work with the AKR directory.
To allocate an AKR

1 Select File » AKR utility or type UTTILITY. The File - AKR Utility pop-up, shown
in Figure 18, displays.

Figure 18  File- AKR Utility Pop-up

File - AKR Utility
CoHRand ===}

Elank - Display HeHnber list 0 - Delete HeHber
A - Allocate-~expand AER R - REnaHe HeHbar

Application Knowledge Repository [AKR]:

Data set naWe . . 'USER1Z.GEMERAL.AKR'

HeHbelr & & & & & o [if "R" or "D" selected]
Mew naMe o« w o 0 __________ [if "R" selected)
Volune serial o o ______ [if not cataloged)]
Password . . . . [if password protected]

2 Specify the member name of the AKR in the Data Set Name field.
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3

Type A in the command input area and press Enter. The File - AKR Allocate/Expand
pop-up, shown in Figure 19, displays.

Figure 19 « File - AKR Allocate/Expand Pop-up

File - AKR Allocate<Expand
CoHMand ===

% - BubHit JCL E - Edit JCL . - Zpecify Catalog
Expand edisting AKR . . . NO [ves ar Mol
AKR data =set naHe . . . . 'UEER1Z.GEMERAL.AKR®
POLUHE W w w0 o 0 om0
UNit o w w w e m o 12 [Generic unit nane]
Epace units . . . . . . RECORDE [Records, Tracks or Cylinders)
PriHAFY SPace . . . . dEIEE [Prinary aHount in above units)
fecondary space . . . . @ [#econdary anount in above unitsl

Job statedent information:
<<UZER1Z TOBCACCT O,
0 HEGCLAZE=A
s« INZERT '~ROUTE PRINT MODE.UZER' HERE IF MNEEDED.
sk

Enter the appropriate information in these required fields:
a Type NO in the Expand existing AKR field.
b  Select the AKR dataset name in the AKR dataset name field.

¢ Enter the appropriate SMS classes, if your site is using SMS, or the desired
space and volume information.

d Enter a valid Job card in the Job statement information field.

If you need to specify a catalog or password, type C in the command input area and
press Enter to display the AKR Catalog Information pop-up. After completing the
dataset name and/or password, press PF3 to return to the File - AKR
Allocate/Expand pop-up.

If you need to review or edit the JCL prior to submitting it, type E in the command
input area and press Enter.

a After making the desired modifications, issue the standard ISPF SUBMIT
command.

b  Return to the File - AKR Allocate/Expand by issuing the END primary
command or pressing PF3/PF15. The edited JCL is not saved.

If you do not need to edit the JCL, submit the JCL by typing S in the command input
area and pressing Enter.
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7  Verify the AKR allocation results by examining the job output. Sample job outputs
are presented in "Verifying AKR Allocation Results" on page 29.

Verifying AKR Allocation Results

After the AKR allocation batch job has completed, review the job output to verify
successful allocation and initialization. Figure 20, Figure 21, and Figure 22 show output

excerpts with messages that indicate successful AKR allocation and initialization.

Figure 20 -« IDCAMS Utility Condition Code Message Output

IDCAMS SYSTEM SERVICES

DEFINE CLUSTER -

(NAME (USER12 .GENERAL.AKR) -

CYLINDERS (5) -

CONTROLINTERVALSIZE (4096) -

NUMBERED -

RECORDSIZE (4089 4089) -

RECOVERY -

UNIQUE -

SHAREOPTIONS (3 3)) -

DATA -

(NAME (USER.TEST.AKR.DATA) )

IDC0508T DATA ALLOCATION STATUS FOR VOLUME SYSDA IS 0

TIME: HH:MM:SS

IDCO001I FUNCTION COMPLETED, HIGHEST CONDITION CODE WAS 0O
IDCO002I IDCAMS PROCESSING COMPLETE. MAXIMUM CONDITION CODE WAS 0

DDMMMYYYY PAGE 1

Figure 21 « AKR Initialization Message Output

ASG-CENTER-OS (ESA) AKR UTILITY LOG
INIT DSNAME (USER12.GENERAL.AKR)

ASG1316I AKR "USER12.GENERAL.AKR" INITIALIZED.

ASG1314I *** END OF VIASYSIN ***

DDMMMYYYY HH:MM:SS PAGE 1

Figure 22 « AKR Utility Log Summary Message Output

ASG-CENTER-0OS (ESA) AKR UTILITY LOG - SUMMARY

ASG1300I 1 AKR(S) INITIALIZED 0 FAILED.

ASG1315I *** END OF SUMMARY REPORT ***

DDMMMYYYY HH:MM:SS PAGE 2
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Program Analyze

The Program Analyze extracts knowledge about the program and populates the AKR
with this information. Programs can be analyzed if they compile with a return code less
than 8 and have only W or I level messages.

Program Analyze Requirements

These are the input to the Program Analyze:

The complete JCL to fetch, compile, and link the program.
Program Analyze parameters indicating the type of analysis to be performed.

An allocated Application Knowledge Repository to receive Program Analyze
information.

Analyzing a Program

You can submit the Program Analyze job using these methods:

il

From the File - Analyze Submit pop-up in SmartTest (see "Method 1 - Analyzing a
Program Using SmartTest" on page 31).

From a TSO/ISPF edit screen by executing the VIASUB edit macro (see "Method 2
- Analyzing a Program from an Edit Session" on page 32).

From any TSO/ISPF screen or user screen by executing the VIASUBDS CLIST
(see "Method 3 - Analyzing a Program from a User Screen" on page 34).

This table describes when to use each method:

Compile JCL is from Method for Executing Analyze Job

PDS or sequential dataset "Method 1 - Analyzing a Program Using

SmartTest" on page 31, "Method 2 -

Analyzing a Program from an Edit Session"

on page 32, or "Method 3 - Analyzing a
Program from a User Screen" on page 34

Librarian, Panvalet, or other user source "Method 2 - Analyzing a Program from an

manager when editing the JCL Edit Session" on page 32
Screen-driven submit facility that "Method 2 - Analyzing a Program from an
generates the JCL Edit Session" on page 32 or "Method 3 -

Analyzing a Program from a User Screen" on
page 34
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Method 1 - Analyzing a Program Using SmartTest

To analyze a program while in SmartTest

1 Select File » Compile/Analyze action. The File - Analyze Submit pop-up, shown in
Figure 23, displays.

Figure 23  File - Analyze Submit Pop-up

File — Analyze ZubHit
CoHHand ===

E - Edit JCL 2 - BUbHit JCL

Codpile and link JCL [PDE or sequential):
Data set nane 'WSER1Z.REL.CHNTLIHTEST]'

Analyze features [T-M]:
AEG-3HartTests ¥ Extended Analysi=sl N

AER data zet nade 'UZER1Z.GEMERAL.AKR'

AER prograd nade [if overriding PROGRAR-IO0)

Analyze options:

CoHpile? [¥<H] o« « o o o o« o i) [7¥ if needad bY features)
Link l1oad Hodule reusable® [Y-N] Y

Note:
If you started your SmartTest session using the ESW Primary screen, the product
names listed under the Analyze features (Y/N) field may differ from the names
shown in this example.

Additional Analyze Features are shown on this pop-up if additional ESW
components are installed at your site.

2 Enter the appropriate information in these required fields:

a  Specify the PDS member or sequential dataset containing the compile/link JCL
in the Data set name field.

b  Specify the analyze feature by typing Y for SmartTest in the Analyze Features
(Y/N) field. Extended Analysis is not used for PL/I programs.

c Specify the AKR dataset name in the AKR data set name field.
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3  Ifyou need to review or edit the JCL prior to submitting it, type E in the command
input area and press Enter.

a After making the desired modifications, type SUBMIT.

b  Return to the File - Analyze Submit pop-up by typing END or pressing
PF3/PF15. The edited JCL is not saved.

If you do not need to review the JCL, submit the compile/link JCL by typing S in the
command input area and pressing Enter.

4  Verify the analyze results by examining the job output. An excerpt from a sample
job output report is presented in "Verifying Analyze Results" on page 34.

Method 2 - Analyzing a Program from an Edit Session

32

You may submit an analyze job outside of SmartTest through your regular edit session
(ISPF, source manager) or user compile/linkedit dialog. Use the Analyze Submit
Parameters screen to specify SmartTest specific information.

To analyze a program while in an edit session

1 Initiate an edit session on your standard compile/link JCL. An Edit screen, similar to
the one shown in Figure 24, displays.

Figure 24 « Sample Edit Session Screen

EDIT ------ ASG.VIACENxx.CNTL (VIAMECII) - 01.03 —-—--——-————- COLUMNS 001 072
COMMAND ===> SCROLL ===> CSR
KA K KA Kh Ak A A A A A AR A A AR AN AN AN Kk hhhhkkk TOP OF DATA KA KA A AR AR AR A Ak Ak A Ak Ak Ak hkhkhkhkhk Kk
000100 //VIASOFTA JOB (ACCOUNT), 'NAME',

000200 // MSGCLASS=X

001820 //COMPLNK PROC ASG='ASG', HIGH LEVEL NODE OF ASG DATA SETS
001830 // CENTER='VIACENXX', MIDDLE NODE OF ASG DATA SETS
001840 // SYsouT='*", OUTPUT MESSAGE CLASS

001850 // SYSDA='SYSDA', WORK FILE UNIT NAME

001860 // COMPILR='VIAPLI', PL/I COMPILER

001870 // PLICOMP='0OSPLI.COMPILER',

001880 // PLILIB='OSPLI.PLILIB',

001890 // DYNAM="DYNAM', DYNAM OR NODYNAM

001891 // MEMBER="'", SOURCE/LOAD MODULE NAME
001892 // USERLIB='USER.TEST.LOADLIB'

001893 //*

001894 //PLI EXEC PGM=&COMPILR,

001895 // PARM='LIB,APOST, RES, &DYNAM'

001896 //STEPLIB DD DSN=&PLICOMP,DISP=SHR

001897 //SYSIN DD DSN=&ASG..&CENTER. .CNTL (&MEMBER) , DISP=SHR

001898 //SYSLIB DD DSN=&ASG..&CENTER..CNTL, DISP=SHR

001899 //SYSPRINT DD SYSOUT=&SYSOUT,

001900 // DCB= (RECFM=FBA, LRECL=121, BLKSIZE=1573)

001901 //SYSLIN DD DSN=&&SYSLIN,DISP=(MOD, PASS),

2 Make any changes necessary, such as job card information, program and/or load
module names, or copybook and/or load library names.
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3 Type VIASUB and press Enter. The Analyze Submit Parameters screen, shown in
Figure 25, displays.

Figure 25 » Analyze Submit Parameters Pop-up

File - Analuze ZubHit
ConHand ===k

E - Edit JCL & - EubHit JCL

CoHpile and link JCL [PDS oF sequentiall:
Data =set naWe ‘'USER1Z.REL.CNTLIHTEST)!

Analyze features [Y-M]:
AEG-EmartTests ¥ Extended Analvsis: N

AKR data zet naWe 'UZER1Z.GENERAL.AKR'

AKR prograd nade [if owverriding PROGRAA-IO0)

Analyze options:

CoHpile? [Y<H] o« v o« v & o o o T [ if needed by features)
Link l1oad Hodule reusable® [v«M] T

4 Enter the AKR dataset name in the AKR data set name field.

Note:
The Extended Analysis field is not used when analyzing PL/I programs.

Additional Analyze Features are shown on this pop-up if additional ESW
components are installed at your site. Enter the appropriate information in the
additional fields, as needed.

5  Ifyou need to review or edit the JCL prior to submitting it, type E in the command
input area and press Enter.

a  After making the desired modifications, type SUBMIT.

b  Return to the editor screen by typing END or pressing PF3/PF15. The edited
JCL is not saved.

If you do not need to review the JCL, submit the compile/link JCL by typing S in the
command input area and pressing Enter.

6  Verify the analyze results by examining the job output. An excerpt from a sample
job output report is presented in "Verifying Analyze Results" on page 34.
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Method 3 - Analyzing a Program from a User Screen

If you use compile/link dialogs to enter information and invoke job submission, an option
may be added to the user screens to specify that a SmartTest Analysis is to be performed.
Check with the SmartTest systems administrator at your site for these details.

If you use a CLIST to submit jobs, SmartTest is installed with a sample CLIST,
VIASUBDS, which submits an analyze job using the specified dataset name. This is the
format of the CLIST:

TSO EXEC 'ASG.VIACENXX.CLIST (VIASUBDS)' [dataset name]
Check with your systems administrator for the exact location of this CLIST.
If no SmartTest options have been added to your compile/link dialog screens, and there is

an opportunity to edit the JCL prior to job submission, see "Method 2 - Analyzing a
Program from an Edit Session" on page 32.

Verify the analyze results by examining the job output. An excerpt from a sample job
output report is presented in "Verifying Analyze Results" on page 34.

Verifying Analyze Results

34

After the Compile/Link - Analyze batch job has completed, review the job output to
verify results. Check for this output:

. Acceptable compiler results.
*  Acceptable linkage editor results.

. Messages indicating the program has been successfully analyzed and the program
information is stored on the AKR.

Storage on the AKR does not occur if the program does not compile and analyze
successfully.

Figure 26 shows an output excerpt indicating a successful analyze.

Figure 26 » Sample Analyze Output Report

ASG-SMARTTEST-0S (ESA) Rx.x LVL0O0O PL/I PROGRAM ANALYZER
PROGRAM NAME: VIAPPLI

DIAGNOSTICS LINES: 0 TOTAL - 0 WARNINGS, 0 ERRORS, 0 CATASTROPHES
PARAMETERS PASSED: FEATURES=(S,PLI,X),NOLIST, SOURCE

OPTIONS IN EFFECT: FEATURES=(SMARTTEST,PL/I), NOLIST

ENTRY POINTS:

PROGRAM 'VIAPPLI' WAS STORED IN AKR 'ASG.VIACENXX.AKR'.
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This screen contains these report areas:

Report Area Description

DIAGNOSTIC LINES Program Diagnostics.

PROGRAM 'VIAPPLT' Message indicating the program was stored on the AKR.

Setting Up the Test Session

This section provides instructions for setting up a test session for the TSO environment.
Setup information for other environments is in "Test Session: Additional Environments"

on page 51.

These are the steps generally involved in setting up a test for the first time in SmartTest:
. Compile/link and analyze programs to be tested.

. Prepare execution JCL for conversion to a TSO CLIST (if TSO foreground).

. Prepare input data for testing.

. Activate SmartTest.

. Provide program, module, and testing environment information.

. Initiate test session.

After the first time a program has been set up for testing, subsequent test sessions may no
longer require all of these steps.

For information on how to set up a CICS test session, see the ASG-SmartTest CICS
User’s Guide. For information on how to set up an IMS/DC test session, see the
ASG-SmartTest IMS User’s Guide.

Note:

The PF keys specified in this manual are set to the SmartTest default values. For more
information on the PF keys, see "PF Key Values" on page 25.

Selecting the Test Environment

If you have previously set up the desired environment and saved the profile, you can
restore the profile and skip the setup steps. (See "Restoring the Test Session
Environment" on page 49 for more information.)
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Use the Environment Selection pop-up to select the SmartTest test environment and to
specify the AKR, application load libraries, and procedure libraries for the test session.
To display the Environment Selection pop-up
1 Select the File P Setup test environment.

2 Select execution environment on the File - Setup Test Environment pop-up and press
Enter.

Or
Type ENV in the primary command area and press Enter on any SmartTest screen.

The Environment Selection pop-up, shown in Figure 27, displays.

Figure 27 « Environment Selection Pop-up

EnvironHent selection

ConMand ===

A - Specify additional AKRsS L — Specify additional LOADLIES:

F - Zpecify PROCLIES D - Display AKR Directory

EnvironHent selaction!  Current environHent is TS0

onlines 1 - 720 5 - IH:2-0E Batch Conmects @ — HUE Batch
2 - CICE & - BT 1a - IH: Batch
3 - I3PF Dialog 7 - DB2 11 - BT% Batch
4 - IHg<DC & - DEZ Procedure 12 - DBE2 Batch

Application Knowledge Repositories [AKR]: 1 Zpecified

'UZER1Z.GENERAL . RER’

Application Load Libraries: 2 Zpecified
*UZER12. GENERAL . LOAD
‘COBZ. 4B, COEZLIE!

3 Select the TSO environment by entering the corresponding environment number.
The environment options are defined in Options.

Options

A Displays the System AKR Libraries pop-up.
L Displays the System Load Libraries pop-up.
P Displays the Procedure Libraries pop-up used to specify the

procedure libraries to be used during the test session. If you do not
enter any procedure libraries on this screen, the libraries listed in the
PROCLIBS entry in VIASPRMS are used to search for procedures.
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Option Description

D Displays the Environment - AKR Directory pop-up showing
members in the concatenated AKRs.

1 Displays the TSO Session Setup screen. Test MVS programs in TSO
foreground (see "Specifying TSO Setup Information" on page 38).

2 Displays the CICS Session Setup screen. Test programs in the CICS
environment. For more information, see the ASG-SmartTest CICS
User’s Guide.

3 Displays the ISPF Session Setup screen. Test programs through ISPF
Dialog Manager (see "ISPF Dialog Manager" on page 52).

4 Displays the IMS/DC Session Setup screen. Test programs in the
IMS/DC environment. For more information, see the ASG-SmartTest
IMS User’s Guide.

5 Displays the IMS/DB Session Setup screen. Test IMS/DB programs
in TSO foreground (see "IMS/DB Programs in TSO Foreground" on
page 63).

6 Displays the BTS Session Setup screen. Test IMS/DC program with

BTS in TSO foreground (see "BTS in TSO Foreground" on page 79).

7 Displays the DB2 Session Setup screen. Test DB2 programs in TSO
foreground (see "DB2 Programs in TSO Foreground" on page 100).

8 If the DB2 Stored Procedure test option is installed at your site,
displays the DB2 Stored Procedure Setup screen to test DB2 stored
procedures (see "DB2 Stored Procedure Testing Option" on
page 102). If not, a message indicating that this option is not installed
at your site displays.

9 Displays the Batch Session Setup screen. Test MVS programs with
Batch Connect.(see "Testing Programs in a Batch Region" on
page 108).

10 Displays the IMS Batch Session Setup screen. Test IMS/DB

programs with Batch Connect (see "Testing Programs in a Batch
Region" on page 108).

11 Displays the BTS Batch Session Setup screen. Test IMS/DC
programs with BTS with Batch Connect (see "Testing BTS in the
Batch Environment" on page 117).
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12 Displays the DB2 Batch Session Setup screen. Test DB2 programs
with Batch Connect (see "Testing DB2 in the Batch Environment" on
page 118).
Application Specifies the AKR dataset name(s). The AKRs is concatenated in the
Knowledge order they are entered. Additional AKRs can be specified on the
Repository System AKR Libraries pop-up by typing A in the command area. A
(AKR): message indicates the total number of AKRs specified, including
those specified on the System AKR Libraries pop-up.
Applicationload Specifies the application load libraries to be used for the test session.
libraries: Application load libraries are searched in the order entered. A

message indicates the total number of load libraries specified,
including those specified on the System Load Libraries pop-up.

Note:

The Application load libraries field does not apply to CICS
programs.

Specifying TSO Setup Information
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To specify the TSO test session parameters for MVS programs and to initiate a

test session

1 Select TSO on the Environment Selection pop-up. The TSO Session Setup screen,
shown in Figure 28, displays.

Figure 28 « TSO Session Setup Screen

Connand ===

Executiaon: dptians:
Load Wodule  TESTCOBA Ereak on entry [Y-N] HO
Break CEECT-pgm id ________
Execution paraneters:  [quates are optional)

TE0 Zession Setup

R - Begin TE0 test session [(RUM)
¢ - Convert batch JCL to TE0 CLIET

File allocation CLIET:
Data set nane
HeHber

Deallocate after test HO




Options

Fields

N

a

b

Note:

2 SmartTest-PLI Test Session

Complete these fields:

In the Load module field, type the name of the load module.
In the Options group, enter any appropriate options.

In the Execution parameters field, enter any parameters to be passed into the
program at run time.

In the Data set name field, type the CLIST dataset name that contains the
CLIST member from the JCL conversion process.

In the Member name field, enter the CLIST member name that contains, or will
contain, the converted JCL.

il

If a CLIST has already been created for the program to be tested, see "Initiating the
Test Session" on page 45. If a CLIST does not exist for the program to be tested, see

"Converting Batch Execution JCL to a TSO CLIST" on page 40.

Option

R

Invokes the CLIST to initiate the TSO test session.

C

Displays the Convert Batch JCL pop-up.

Field

Description

Execution: Load module  Specifies the name of the load module to be executed.

Options

Break on entry (Y/N) Type YES (the default) to cause the test session to break or

pause at the start of the program. Additional break on entry
options are available on the Session Tailoring screen for
each program to be tested.

Break CSECT/pgm id  Enter a program or CSECT name to cause the test session to

stop on entry to the specified CSECT in a statically linked
module.
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File allocation CLIST

Data set name Enter the dataset containing the allocation CLIST for
allocating files to be used during testing. If the Convert
Batch JCL facility is used, the dataset specified there is
shown here.

Member Enter the name of the allocation CLIST. If the Convert Batch
JCL facility is used, the member name specified is shown
here.

Execution parameters Enter application execution parameters in this field.
Deallocate after test Type YES to cause the allocation CLIST to be automatically

executed to deallocate the test files at the end of the test
session, or after a CANCEL command is entered. Issuing
another RUN command causes the datasets to be reallocated
automatically. Type NO to cause the CLIST to be
automatically executed before exiting SmartTest-PLI to
deallocate the test files. The default value is NO.

Converting Batch Execution JCL to a TSO CLIST

Executing a program in TSO foreground requires that data files used during execution be
allocated to the TSO session. This is accomplished by a TSO file allocation CLIST.

A JCL to CLIST conversion facility is provided in SmartTest to automate CLIST
creation. Unless otherwise indicated, all DD statements in the JCL stream are converted
regardless of the number of steps. The conversion facility includes a comment statement
for each step.

Converting Batch Execution JCL
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To specify the dataset containing the batch execution JCL to be converted

Note:
If the TSO Session Setup screen is already displayed, bypass step 1 and step 2.

1 Select File P Setup test environment and press Enter. The File - Setup Test
Environment pop-up displays.

2 Choose Select current environment in the Setup Options field and press Enter. The
Session Setup screen displays.
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3 Type C in the primary command input area and press Enter. The Convert Batch JCL
pop-up, shown in Figure 29, displays.

Figure 29 » Convert Batch JCL Pop-up

Convert Batch JCL
CoHHand ===

¢ - Convert batch JCL into CLIET

% - Extract setup libraries
E - Edit file allocation CLIET F

T

o]

Edit CLIST using panels
Edit batch JEL
Execute deallocation CLIST

P - Specify procedure libraries
A - Execute allocation CLIET

Batch Edecution JCLI
Data set nare "UIASOFT  UIACENAX.CNTL'
HeWber . . . UIAHETCL

File allocation CLIET:
Data set naWe 'USER.CLIET'

Herber . o o ________ [Blank defaults to JCL Hedber]

options:
Delete [Y-M]  NO [Delete before create 'DISP=NEM' datasets)
step [YrM] NO [only convert step with prograd to be tested)
Zubsysted . . ____ [Zource Library Hanager subsSysted nade)
Etep MaWe . . ________ [Unique step naWe in JOE to convert]

4 Complete these required fields:

a Enter the Batch Execution JCL dataset name and member in the Data set name
and Member fields, respectively. This is the JCL to be converted.

b Enter the File allocation CLIST dataset name and member in the Data set name
and Member fields, respectively. This is where the converted CLIST is stored.

Options

C Converts the specified batch execution JCL. member into a file allocation
CLIST. The CLIST dataset name and member name must be entered in the
FILE ALLOCATION CLIST fields.

E Invokes the ISPF editor for the specified allocation CLIST member.

P Displays the Procedure Libraries pop-up used to specify procedure libraries.
If you do not enter any procedure libraries on this screen, the libraries listed
in the PROCLIBS entry in VIASPRMS are used to search for procedures.

A Invokes the CLIST processor with the generated CLIST as input and uses the
ALLOC (allocate) parameter. This allocates the datasets to the TSO session
and provides the files for testing.

S Converts the specified batch execution JCL member and extracts Library
information, such as STEPLIB, DFSRESLB, and so forth.
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Fields

)

Option Description

F Displays the Allocations from JCL screen, which enables you to edit the
SmartTest allocation CLIST using screens rather than directly editing the
CLIST.

J Displays the batch JCL for editing.

D Invokes the CLIST processor with the generated CLIST as input and uses the
DEALC (deallocate) parameter. This frees the datasets from the TSO
session.

Field Description

Data setname  Enter the partitioned dataset containing the JCL to be converted to a
TSO CLIST.

Member Enter the member to be converted to a TSO CLIST.

Data setname  The partitioned dataset where the generated CLIST will be placed.
Note that this dataset need not be defined by the TSO SYSPROC DD
statement.

Member The partitioned dataset member that contains the generated allocation
CLIST.

Delete (Y/N) For datasets that are created NEW,CATLG, type YES to cause a
DELETE to be issued each time the CLIST is executed, before the
dataset is allocated. The default is NO.

Step (Y/N) YES causes only the step with the load module specified on the
Session Setup screen to be converted. NO causes all DD statements in
the JCL stream to be converted regardless of the number of steps in
the procedure. The default value is NO.

Subsystem If the JCL to be converted references a PROC in a procedure library
(or libraries), specify the procedure library in this field. Specified
procedure libraries must be partitioned datasets.
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Editing Allocation CLIST
To edit the CLIST manually, follow this step:

» Select E on the Convert Batch JCL screen. The generated allocation CLIST, shown in
Figure 30, displays.

Figure 30 « Generated Allocation CLIST Example

EDIT ---- USER.CLIST(VIAMEJCL) - 01.00 —--=--=—-————————————————- COLUMNS 001 072
COMMAND ===> SCROLL ===> CSR
KKK IK KKK KK AA KKK KA KA K KA KK KA KKk * TOP OF DATA * % H Kk * & %k Kk k& &%k Kk k& &k Kkk x & %Kk x
000001 PROC 0 VIAPARM (ALLOC)

000002 /* ASG-SMARTTEST CLIST ALLOCATE PROCESSING *** k% %%k k% %%
000003 IF &VIAPARM = ALLOC THEN DO

000004 CONTROL NOMSG

000005 /* PROGRAM=VIAMERGE

000006 FREE FILE (INFILEl, INFILE2, INFILE3,OUTFILE, OUTRPT)

000007 FREE ATTRLIST (VATTR1,VATTR2)

000008 CONTROL MSG

000009 ATTRIB VATTR1 RECFM(F B) LRECL(230) BLKSIZE (460)

000010 ATTRIB VATTR2 RECFM(F B) LRECL(132) BLKSIZE (13200)

000011 ALLOC FI(INFILE1l) DA ('ASG.VIACENXX.CNTL (VIAMINOL1)") -
000012 SHR KEEP

000013 ALLOC FI(INFILE2) DA ('ASG.VIACENXX.CNTL (VIAMINO2)'") -
000014 SHR KEEP

000015 ALLOC FI(INFILE3) DA ('ASG.VIACENXX.CNTL (VIAMINO3)") -
000016 SHR KEEP

000017 ALLOC FI(OUTFILE) DUMMY USING (VATTR1)

000018 ALLOC FI (OUTRPT) UNIT (SYSDA) SPACE(1,1) CYLINDERS -
000019 USING (VATTR2) NEW DELETE

000020 /* PROGRAM=VIAMERGE

000021 END

Special considerations apply for Generation Data Group (GDG) datasets. The TSO
ALLOCATE statement created for Generation Data Groups specifies the absolute
generation number represented by the catalog at the time of CLIST generation.
Automatic incrementing of GDG entries does not occur. Each time the CLIST is executed
the same generation is used unless the CLIST is manually edited or regenerated prior to
execution. For example:

//FILE1 DD DSN=ASG.VIACENXX.IN1 (0),DISP=SHR
converts to:

ALLOC FI(FILE) DA (’'ASG.VIACENXX.INI1.GOOO6VOl’) SHR KEEP
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To provide a user interface for editing the CLIST, follow this step:

» Select F on the Convert Batch JCL screen. The Allocations from JCL screen, shown in
Figure 31, displays. The basic editor provides a list of DDNAME and dataset
information that corresponds to the CLIST allocations.

Figure 31 « Allocations from JCL Screen

Allocations froW JOL  -——-————-———— Row 1 to 5 of 5
===k _ ECROLL === PAGE
Long,2hort.ATTri b.CANCeL LEND
Dataset: "WIAUSE. TEST. DATACMIAMEICLY '

Delete [Y-N] HO [Delete before create 'DISP=NEM' datasets)

Options: Insert,Replace,belete,Edit,View,Browse, elect

OO Mane Data et Mawes in Order of Concatenation Disp

INFILEL 'UIAINET.CESOTOEL ,CNTL{UIARINGL )" EHR KEEF
INFILEZ 'UIAINET.CESOTOEL ,CNTLIVIARINGZ]" EHR KEEFP
INFILEZ 'UIAINET.CESOTOAL ,CNTLIVIAHINGZ]" EHR KEEF
QUTFILE OURHY

AUTRPT HNEW DELETE

Botton of data

Fields

Delete (Y|N) Use for datasets that are created NEW,CATLG, type YES to cause a
DELETE to be issued each time the CLIST is executed, before the
dataset is allocated. The default is NO.

DD Name Specifies the file name for the allocation entry. If this field is left
blank, the dataset is concatenated to the previous entry.

Data Set Names Specifies the name of the dataset to be allocated. If DISP=DATA, this

in Order of field is ignored.
Concatenation
Disp Specifies the disposition with which to allocate the dataset. The valid

values are SHR, OLD, NEW, MOD, DATA, and SYSOUT.
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Initiating the Test Session

2 SmartTest-PLI Test Session

Command Type Command  Description
Primary
END Writes a CLIST from the current information and end the
edit session.
CANcel Ends the edit session without saving changes.
Attrib Displays an additional line of information for each entry
showing the dataset attributes, if present.
Long Displays all additional information for each entry in the
list.
Short Resets the display to one line per entry.
Line
I Inserts a new blank line after the selected line.
R Adds a new line after and identical to the selected line.
D Deletes the selected line.
S Invokes the attribute editor for the selected line.
E Invokes the ISPF editor for the dataset on the current
line.
Vv Invokes the ISPF view for the dataset on the current line.
B {_nvokes the ISPF browse for the dataset on the current
ine.

After you have completed these tasks, you are ready to begin testing a program in TSO
foreground by performing these tasks.

Select the environment.
Specify the Load module, AKR, load libraries, and procedure libraries (if needed).
Generate the CLIST.
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To initiate a test session, follow this step:

» Type R in the primary command input area on the TSO Session Setup screen and press
Enter or type RUN or STEP on any SmartTest screen or pop-up.

With either method of initiating the test session, SmartTest executes the CLIST to
allocate the files for the program. When the CLIST has completed, the test session is
active with the program source displayed in Program View.

Setup Considerations

46

During setup for testing in TSO foreground, keep these input/output dataset and
execution JCL considerations in mind.

If a TSO file allocation CLIST does not exist at the time a test session is to be initiated,
one must be created. A JCL to CLIST conversion facility is provided to automate the
process.

These points may require you to modify the batch execution JCL prior to CLIST
conversion:

. The JCL to be converted must be valid and executable outside of SmartTest-PLI.

. JCL sysout designations of * (i.e., /SYSPRINT DD SYSOUT=¥*) are routed to the
terminal by the CLIST. Output routed to the terminal displays as it is written. It can
only be scrolled forward and is not available once the test session is terminated.
You may want to assign the SYSOUT destinations to sequential files or the held
output queue.

. Make temporary datasets permanent to insure their availability outside the TSO
session.

. When testing a multiple step job:

—  Specify YES in the STEP field of the Convert Batch JCL pop-up or edit the
multiple step JCL so it contains only the step to be tested.

—  Execute programs/utilities invoked in other steps separately (e.g., SORT,
IDCAMS). Those programs serving to allocate or delete files (e.g., IEFBR14)
may be skipped and the appropriate statements manually added to the CLIST
after conversion.



2 SmartTest-PLI Test Session

Saving the Test Session Setup

Frequently, there is a need to test several programs in an application at the same time.
These programs may run in multiple environments requiring many test session setup
changes. SmartTest provides the LIST PROFILE primary command to save a test session
setup and restore it when you need to test the same program again or a different program
using the same test session setup.

To save the test session setup information in a profile dataset

1 Type LIST PROFILE in the primary command area of any SmartTest screen to
display the Profile Data Set Member List screen. The LIST PROFILE command can
be abbreviated LI PR.

2 In the line command area beside any line that indicates AVAILABLE, type W. In the
User profile description field, enter any text that reminds you of the purpose of the
setup being saved. For example, you may include the name of the program being
tested, the application or project ID, and the date as shown in Figure 32.

Figure 32 » Profile Dataset Member List Screen Example

Profile Data Zet Hewber List
CorHand ===

The current environdent isi T30
Profile dataset naWe 'UZER1Z.IZPF.PROFILE
COPY TO dataselr nawe
% - Zelect HeWber ta prestore U - Write current enwirandent to Hedber

¢ - Copy selected Henber R - Replace Henber [Pending status)
O - Delete Henber # denotes TCA Profile
Profile  ERUiron User profile description [optionall

UIAPETELl  AVAILAELE
ULAPETE2  AVAILAELE
ULAPETEE  AVAILAELE

_ VIAPETEd  T20 testl

_ VIAPETAS T=20 test for autotester

_ VIAPETEE T=0 test wviapcob and keep window

_ VIARETEY T=0 tca test tso profile

_ VIAPETES T30 this is new stuff

_ VIAPETA® T30 Q<A transfer for TESTGOE RELEASE 3.3
_ VIAPET1® T30 test count for towW

_ VIAPET11 TE0 analz test wsbr

_ VIAPET12 CICE cics test

_ VIAPET1Z IEPF IZPF setup O%-21-00_
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Sharing Test Setups

If your site security allows file sharing in the TSO/ISPF environment, you can also copy
setup information from other profile datasets.

To copy setup information

1

In the Profile data set name field on the Profile Data Set Member List screen, enter
the fully qualified dataset name of the profile dataset containing the desired setup.
The saved profile list is refreshed to display the profiles from the specified profile
dataset.

In the line command area of the Profile Data Set Member List screen, select the
desired profile to copy to your profile dataset by typing C on the line containing the
profile. The profile is copied to your profile dataset and may be later modified.

Sharing an Alternate Profile Dataset

48

SmartTest allows you to create an alternate profile dataset, to enable team members to
share test profile setups. The alternate dataset must be an FB 80 (fixed block,
LRECL=80) dataset. Test profiles may be copied from the individual users' profile
datasets to the alternate dataset, and from the alternate dataset to the ISPF datasets. The
common dataset may replace the individual profile datasets as the default.

To copy test profiles to a common, alternate dataset

1

In the Profile dataset name field on the Profile Data Set Member List screen, enter
the name of the profile dataset containing the desired test setup profiles, for example:

'USER.ISPF.PROFILE'

In the COPY TO dataset name field, enter the name of the common, alternate dataset
to receive the profiles, for example:

'USER.TSO.CNTL'

Note:
The alternate must be an FB 80 dataset.

The profiles are now copied to the common alternate dataset.
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To copy test profiles from a common, alternate dataset to an individual, ISPF
dataset

1

In the Profile dataset name field on the Profile Data Set Member List screen, enter
the name of the common, alternate dataset containing the desired test setup profiles,
for example:

'USER.TSO.CNTL'

In the COPY TO dataset name field, enter the name of the individual ISPF dataset to
receive the profiles, for example:

'USER.ISPF.PROFILE'

The profiles are now copied to the individual, ISPF dataset.

Restoring the Test Session Environment

To restore a saved test session environment

1

Type LIST PROFILE in the primary command area of any SmartTest screen to
display the Profile Data Set Member List screen.

Select the desired profile by typing S in the line command area of the line containing
the profile.

The saved test session setup is restored. You can start the test session using the R
command.

Terminating a Test Session

To terminate a test session and exit from SmartTest

1

2

Select Test P Cancel to cancel the active test session.

Select File » Exit to end SmartTest. Any pseudo code, marks, or breaks are saved in
the AKR if SAVE is specified on the Options -Product Parameters pop-up. See
"Online Operation Parameters" on page 17 for more information on setting these
parameters.

As an alternative, exit SmartTest by pressing PF3 until you exit the product.
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Test Session: Additional Environments

This chapter describes setting up the SmartTest-PLI test sessions in additional
environments and contains these sections:

Topic Page

Setting Up the Test Session in Other Environments 51
ISPF Dialog Manager 52
IMS/DB Programs in TSO Foreground 63
BTS in TSO Foreground 79
DB2 Programs in TSO Foreground 100
DB2 Stored Procedure Testing Option 102
Testing Programs in a Batch Region 108
Testing DL/I in the Batch Environment 116

Testing BTS in the Batch Environment

—
—
N

Testing DB2 in the Batch Environment

—
—
o]

Testing DFHDRP in the Batch Region

—
—
\O

Setting Up the Test Session in Other Environments

DB2 Stored Procedure Option

SmartTest offers an option that supports testing a DB2 stored procedure (the DB2
Release 4.1 Stored Procedure feature). See “DB2 Stored Procedure Testing Option” on
page 102 for more information.
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CICS and IMS Environments

Two additional environments are also available as options for SmartTest. These are
discussed in the ASG-SmartTest CICS User’s Guide and the ASG-SmartTest IMS User’s
Guide.

ISPF Dialog Manager

Specifying ISPF Dialog Manager Information

To initiate a test session

1 From the Environment Selection pop-up, select ISPF Dialog Manager. The ISPF
Session Setup screen, shown in Figure 33, displays.

Figure 33 » ISPF Session Setup Screen

I:PF Zession Eetup
CoHHand ===

R - Beqin ISPF test session [RUN] I - Verify I3PF allocations
# - Eelect prograns to be tested

Execution: options:
Load Hodule Ereak on entry [¥<M] YE%
Ereak CEECT-pgm id  ________

IZPF Options:
Test Profile DEN
MEWAPFL « « & & & J—
Initial IEPF panel

Motel The Test Profile DEM cannot be the sane ISPF profile data set
that is in use by AZE-%MartTest [(ODOMAHE=IZFFROF]. Enter HELP
for Hore infordation on the IEPF

OPTIONE.

2 Complete these fields:
a Enter the initial load module to be tested in the Load module field.

b  Select an option by typing R, S, or V on the command line.

¢ Enter the appropriate information in the fields. See "Fields" on page 53 for a
description of the fields on this screen.
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3 Test Session: Additional Environments

Option Description

R Initiates the ISPF test session. This option is the same as issuing a RUN
primary command.

S Displays the Load Module Intercept List pop-up.

A% Displays the ISPF Allocation pop-up.

Field Description

Execution: Load module  Specifies the initial load module to be tested.

Break on entry (Y/N) Specifies whether the test session stops at the start of the
test session. Additional break on entry options are available
on the Session Tailoring screen for each program to be
tested. The default is YES.

Break CSECT/pgm id Specifies the program name that causes the test session to
stop on entry to the specified CSECT in a statically linked
module.

Test Profile DSN Specifies the dataset that contains your ISPF profiles for the

application to be tested (i.e., ISRPROF, VIASPROF, etc.).
This must not be the same dataset that is being used by ISPF
for the SmartTest test session. If none is entered, a
temporary dataset is allocated, so each application profile is
created when accessed. To access existing profiles, use
ISPF's 3.2 option to allocate a library similar to your
ISPPROF library, then use ISPF's 3.3 option to copy the
appropriate application profile from ISPPROF to the new
library. This dataset name is optional.

NEWAPPL Specifies the ISPF application ID to use for the test
(optional).
Initial ISPF panel Specifies the first ISPF screen to be displayed by the test

session. If none is entered, SmartTest's VPPISPFT screen
displays. If VPPISPFT cannot be located in ISPF's
ISPPLIB concatenation, then ISPF's Dialog Manager Test
screen displays. This screen ID is optional.
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Specifying Programs to be Tested

Use the Load Module Intercept List pop-up to list any load modules that may be
intercepted by SmartTest for testing. A load module that is linked, attached, or
dynamically loaded and called may be entered on the Load Module Intercept List screen.
This includes modules that are invoked by an ISPEXEC Select program. Entries must be

made before the start of the test.

To display the Load Module Intercept List pop-up

Type S in the primary command input area on the ISPF Session Setup screen and
press Enter. The Load Module Intercept List, shown in Figure 34, displays.

Figure 34 « Load Module Intercept List Pop-up

Load Hodule Intercept List

Load
Hodule

Type the nanes of the load Hodules to be dynadically intercepted.

Load
Hodule

1
CoHHand ===}
Then pres=s Enter.
1
3
15
T
?
11
13
15
17
i2
21
23
2
press Enter.
3
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Enter the load modules to be dynamically intercepted in the Load Module field and

Press PF3/PF15 to return to the ISPF Session Setup screen.
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Specifying ISPF File Allocation Information

Options

Use the ISPF Allocation pop-up to specify datasets and libraries to be used by the test
which are not already allocated to your TSO session. To obtain a list of files allocated to
your session, type TSO VIASALCL.

Note:

Typically, no entries are needed on this pop-up. If left blank, the existing ISPF defined
libraries are used. If data is entered on this pop-up, all libraries that are accessed during a
test session must be supplied. These entries override the existing definitions.

To display the ISPF Allocation pop-up

1 Type V in the primary command input area on the ISPF Session Setup screen and
press Enter. The ISPF Allocation pop-up, shown in Figure 35, displays.

Figure 35 « ISPF Allocation Pop-up

IZPF Allocation
ConMand ===k

1 - ISPF Prograd Load Library [required]

2 - ISPF Panel-Link Libraries [optionall

3 - ISPF TablerHessagesikeleton Libraries [optional)
d - IZPF LIST Data et [required)

5 - ISPF LOG Data et [required)

A - ALL (Display all of the abowe in SUCCEsSion]

R - Restore ISPF systed variables

2 Select the appropriate option(s) for items to be allocated to ISPF. Typically, the
information on the resulting pop-ups is entered once and retained by SmartTest-PLI.

3 Press PF3/PF15 to return to the ISPF Session Setup screen.

1-ISPF Program Load Displays the ISPF Program Load Library pop-up that is used to

Library specify the location of the load module ISPMAIN.

2-1SPF Panel/Link Displays the ISPF Panel/Link Library pop-up that is used to
Libraries specify panel and link libraries used by the ISPF test.

3-ISPF Table/ Displays the ISPF Table/Message/Skeleton Library pop-up that
Message/Skeleton is used to specify table, message, and skeleton libraries used by
Libraries the ISPF test.
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4-ISPF LIST Data Set

Displays the ISPF List Data Set Allocation pop-up that is used
to specify the ISPF list dataset that is used for the ISPF test.

5-ISPF LOG Data Set

Displays the ISPF Log Allocation pop-up that is used to specify
the ISPF log dataset that is used for the ISPF test.

A Displays the ISPF allocation pop-ups in succession.

R Executes the VIAPUSPF CLIST that restores the ISPF system
variables to the site defaults.

Note:

See the ASG-SmartTest Installation Guide for information on the VIAPUSPF CLIST.

Specifying the ISPF Program Load Library

Note:

This procedure is required.

To display the ISPF Program Load Library containing the ISPMAIN member

1 Type 1 in the primary command input area on the ISPF Allocation pop-up and press
Enter. The ISPF Program Load Library pop-up, shown in Figure 36, displays.

Figure 36 « ISPF Program Load Library Pop-up

CoHHand ===

ISPF Prograd Load Library

IZPF Prograd Load Libraryl  [required]
Data set nane "I3F.IFLOAD

This library HUSE contain the 1oad Hodule 'IEPHAIN'.

2 Enter the ISPF load library dataset name that contains the program ISPMAIN in the
ISPF Program Load Library field.

3 Press PF3/PF15 to return to the ISPF Allocation pop-up.
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Specifying the ISPF Panel/Link Libraries

Use the ISPF Panel/Link Libraries pop-up to specify panel and link libraries for the test.
ISPPLIB and ISPLLIB are the defaults.

Note:

Typically, no entries are needed on this pop-up. If left blank, the existing ISPF defined
libraries are used. If data is entered on this pop-up, all libraries that are accessed during a
test session must be supplied. These entries override the existing definitions.

To specify the ISPF panel and link libraries

1 Type 2 in the primary command input area on the ISPF Allocation pop-up and press
Enter. The ISPF Panel/Link Libraries pop-up, shown in Figure 37, displays.

Figure 37 « ISPF Panel/Link Libraries Pop-up

IZPF Panel-Link Libraries
CoHHand ===k

I%PF panel likraries: [corresponds to ISPPLIE]

IZPF link libraries: [corresponds to ISPLLIE)

2 Enter the ISPF panel library datasets that will be used for the ISPF test in the ISPF
panel libraries field.

3 Enter the ISPF link library datasets that will be used for the ISPF test in the ISPF link
libraries field.

4  Press PF3/PF15 to return to the ISPF Allocation pop-up.
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Specifying the ISPF Table/Message/Skeleton Libraries

58

Use the ISPF Table/Message/Skeleton Libraries pop-up to specify table, message, and
skeleton libraries for the test. ISPTLIB, ISPMLIB, and ISPSLIB are the defaults.

Note:

Typically, no entries are needed on this pop-up. If left blank, the existing ISPF defined
libraries are used. If data is entered on this pop-up, all libraries that are accessed during a
test session must be supplied. These entries override the existing definitions.

To specify the ISPF Table/Message/Skeleton Libraries pop-up

1 Type 3 in the primary command input area on the ISPF Allocation pop-up and press
Enter. The ISPF Table/Message/Skeleton Libraries pop-up, shown in Figure 38,
displays.

Figure 38  ISPF Table/Message/Skeleton Libraries Pop-up

IZPF TablesHessage-Skeleton Libraries
CoHHand ===k

IZPF Table libraries: [corresponds to IZPTLIE)

IZPF Hessage librariesi  [corresponds to ISPHLIE]

IZPF Ekeleton librariesi [corresponds to IEPSLIE]

2 Complete these fields:

a Enter the ISPF table library datasets that will be used for the test ISPF Table
libraries.

b  Enter the ISPF message library datasets that will be used for the test ISPF
Message libraries.

¢  Enter the ISPF skeleton library datasets that will be used for the test ISPF
Skeleton libraries.

3 Press PF3/PF15 to return to the ISPF Allocation pop-up.
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Allocating the ISPF List Dataset

Fields

To specify an ISPF list file for the test

1 Type 4 in the primary command input area on the ISPF Allocation pop-up and press
Enter. The ISPF List Data Set Allocation pop-up, shown in Figure 39, displays.

Figure 39 » ISPF List Data Set Allocation Pop-up

IZPF Li=st Data et Allocation
ConHand ===

Enter Data set nane, DURHY, TEHP, TERH o ZVE0UTI
Nare . . « ZVE0UT

EVEQUT . . X best _____
DEN DIEP [Mew, 014, or Zhr)
nit . . .

Volune . o ______
fpacel

Units o & _________ [Eylinder, Track, or BElock]
PriHary

Eecondary

DCE:

RECFH . . F
LRECL . . 133
ELEZIZE 133

2 Enter the appropriate information in the fields.

3 Press PF3/PF15 to return to the ISPF Allocation pop-up.

Name Specifies the name of the dataset. You can specify TEMP to allocate
a temporary dataset, TERM to allocate the dataset to a terminal, and
SYSOUT to allocate the dataset to JES.

SYSOUT Specifies a JES output class. An entry in this field is valid only if you
specified SYSOUT in the Name field.

DSN DISP Specifies the disposition of the dataset. The disposition can be NEW,
OLD, MOD, or SHR.

Dest Specifies a JES destination of the SYSOUT output. This can be a
remote ID or a NJE ID.

Unit Specifies the generic name used to allocate the dataset if the dataset

name specified in the Name field is not cataloged or if you specified
TEMP in the Name field.
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Volume Specifies the volume serial number containing the allocated dataset.

Units Specifies the type of space to be allocated for the dataset. You can
specify space as CYLINDER, TRACK, or BLOCK.

Primary Enter the number of primary cylinders, tracks, or blocks to be
allocated.

Secondary Specifies the number of secondary cylinders, tracks, or blocks to be
allocated.

RECFM Specifies the record format of the list dataset. Record format can be

specified as F (fixed) or V (variable).

LRECL Specifies the record length of the list dataset.

BLKSIZE Specifies the maximum length, in bytes, of a block for the list dataset.
Note:
The SYSOUT and DEST fields are available only when you specify SYSOUT in the
Name field.

Allocating the ISPF Log Dataset

To specify an ISPF log dataset for the test

1 Type 5 in the primary command input area on the ISPF Allocation pop-up and press
Enter. The ISPF Log Data Set Allocation pop-up, shown in Figure 40, displays.

Figure 40 » ISPF Log Data Set Allocation Pop-up

I3PF Log Data Set Allocation
CoHHand ===

Enter Data set naWe, DUHAY, TERP, TERH or EVE0UTE
Nare . . . SVE0UT

BYZ0OUT . .M Dest e
DEN DISP ___ [Mew, O1d, or Shr)
nit « .

Uolube « o ______
Zpace!

Units . « _________ [tylinder, Track, or BElock]
PriHary

Zecondary

DCER

RECFH . . F
LRECL . . 133
ELKZIZE 133
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2 Enter the appropriate information in the fields.

3 Press PF3/PF15 to return to the ISPF Allocation pop-up.

Name Specifies the name of the dataset. You can specify TEMP to allocate
a temporary dataset, TERM to allocate the dataset to a terminal, and
SYSOUT to allocate the dataset to JES.
SYSOUT Specifies a JES output class. An entry in this field is valid only if
SYSOUT is specified in the Name field.
DSN DISP Specifies the disposition of the dataset. The disposition can be NEW,
OLD, MOD, or SHR.
Dest Specifies a JES destination of the SYSOUT output. This can be a
remote ID or a NJE ID.
Unit Specifies the generic name used to allocate the dataset if the dataset
name specified in the Name field is not cataloged or if you specified
TEMP in the Name field.
Volume Specifies the volume serial number containing the allocated dataset.
Units Specifies the type of space to be allocated for the dataset. You can
specify space as CYLINDER, TRACK, or BLOCK.
Primary Specifies the number of primary cylinders, tracks, or blocks to be
allocated.
Secondary Specifies the number of secondary cylinders, tracks, or blocks to be
allocated.
RECFM Specifies the record format of the list dataset. You can specify record
format as F (fixed) or V (variable).
LRECL Specifies the record length of the list dataset.
BLKSIZE Specifies the maximum length, in bytes, of a block for the list dataset.
Note:

The SYSOUT and DEST entries are only allowed when the NAME entry is specified as

SYSOUT.
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Initiating an ISPF Test Session

62

To initiate a test session

1

Make sure you have completed these tasks before testing a program in ISPF:

a

b

(9

d

e

Select the ISPF Dialog Manager environment.
Specify all appropriate testing options.
Specify the Load module and AKR.

Specify programs to be tested.

Specify ISPF file allocation information.

Type RUN or R in the command input area on the ISPF Session Setup screen and
press Enter.

Or

Press PF4/PF16 (RUN) or PF6/PF18 (STEP).

The test session is active with the program source displayed in Program View.
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IMS/DB Programs in TSO Foreground

Specifying IMS/DB Setup Information

To specify the TSO test session parameters for IMS/DB programs and to initiate
a test session

1 Select IMS/DB on the Environment Selection pop-up. The IMS/DB Session Setup
screen, shown in Figure 41, displays.

Figure 41 « IMS/DB Session Setup Screen

IH:<DE Zession fetup

ConHand ===
R - Begin IH% test session [RUM] ¢ - Convert batch JCL to CLIET
= Derify IHE allocations
Execution: optionsi
Load Wodule  ________ Ereak on entry [¥<N] YE%
PEE Name . . ________ Break CEECT-pgm id  ________
Data baze region type:l DEZ parameters:
OLI~DEE-EHP OLI Plan nave . . . . .

SUbsysted nade o . .

File allocation CLISTI
Data set nane
Henber o . Deallocate after test HNO

2 Specify the load module, the CLIST dataset name and optional member, and any
appropriate options.

Options

R Initiates the IMS/DB test session. This is the equivalent of entering
the RUN command.
C Displays the Convert Batch JCL screen used to convert batch JCL to

an allocation CLIST. The converted allocation CLIST can be used to
establish the IMS/DB session.

A% Displays the IMS/DB Allocation Selection pop-up that is used to
select the datasets, libraries, and parameters to be defined for
IMS/DB.
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Load module

Specifies the initial load module to be tested. This should be the name
of the program that is executed by IMS.

PSB Name

Specifies the IMS Program Specification Block associated with the
program being tested.

Break on entry
(Y/N)

Specifies whether the test session stops on initial entry at the start of
the load module. Additional break on entry options are available on
the Session Tailoring screen for each program to be tested. The
default is YES.

Break CSECT/
pgm id

Causes the test session to stop on entry to the specified CSECT in a
statically linked module.

DLI/DBB/BMP

Specifies the mode of the IMS/DB test session.

DLI. Uses private databases with database access through the TSO
region; uses DBDLIB and PSBLIB.

DBB. Uses privates databases with database access through the TSO
region; uses ACBLIB.

BMP. Uses public databases with database access through the IMS
Control Region.

Plan name

Specifies the DB2 Plan that was generated for the program to be tested
when the BIND was performed. If the database region type of test
specified is BMP, this field is not needed.

Subsystem
name

Specifies the name assigned to DB2 when it was installed in the MVS
environment. If the database region type specified is BMP, this field
is not necessary.

Data set name

Specifies the dataset containing the allocation CLIST for allocating
files to be used during IMS/DB testing. If the Convert Batch JCL
facility is used, the dataset specified is shown in this field.

Member

Specifies the name of the allocation CLIST. If the Convert Batch JCL
facility is used, the member name specified is shown in this field.
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Deallocate after Specifies whether the CLIST processor will be invoked automatically

test to deallocate the test files at the end of the transaction test session or
after a CANCEL command is entered. Issuing another RUN
command causes the datasets to be reallocated. By default, the CLIST
is automatically invoked before exiting SmartTest. The default is NO.

Execution Specifies application parameter string. This field is for IMS/ESA
parameters user’s only.
(APARM)

Specifying IMS File Allocation Information

To specify the IMS datasets, libraries, and parameters to be defined to IMS

1 Type V in the primary command input area on the IMS/DB Session Setup screen and
press Enter. The IMS Allocation Selection pop-up, shown in Figure 42, displays.

Figure 42 « IMS Allocation Selection Pop-up

IHE Allocation Zelection
CoHHand ===

1 - DF$RESLE~DFSEIL

2 - PROCLIE-DFEVSAHP

3 - PEE-<DED Libraries

4 — ACE Libraries

5 — IHIHON

& - IEFRDER

E - IHE Pards [EBHP)

F - IH% Parns [DLI or DEE]

A - ALL [Display ALl Of The Abowe In Zuccession)

R - Restaore IHME systed variables and parHs.

2 Select the appropriate option(s) for items to be allocated to IMS/DB. Typically, the
information on these screens is entered once and need not be re-entered each time a
test is performed.

Note:
If you choose option A, pressing PF3/PF15 automatically displays the next
allocation screen.

3 Press PF3/PF15 to return to IMS/DB Session Setup screen.
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Options
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1 - DFSRESLB/DFSESL

Displays the IMS DFSRESLB/DFSESL Allocation
pop-up used to specify the IMS load library dataset.

2 - PROCLIB/DFSVSAMP

Displays the IMS DFSVSAMP/PROCLIB Allocation
pop-up that is used to specify the VSAM buffer pool
dataset and any datasets to be concatenated, and to
specify the IMS procedure library dataset.

3 - PSB/DBD Libraries

Displays the IMS PSB/DBD Allocation pop-up that is
used to specify the PSB and DBD libraries used by IMS.

4 - ACB Libraries

Displays the IMS ACB Allocation pop-up that is used to
specify the ACB libraries used by IMS.

5 - IMSMON

Displays the IMS IMSMON Allocation pop-up that is
used to specify the monitor dataset used by IMS to log
run-time activities.

6 - IEFRDER

Displays the IMS IEFRDER Allocation pop-up that is
used to specify the dataset that invokes the IMS logging
facility.

B - IMS Parms (BMP)

Displays the IMS BMP Parameters pop-up that is used to
specify IMS BMP execution parameters.

P - IMS Parms (DLI or DBB)

Displays the IMS DLI/DBB Parameters pop-up that is
used to specify the IMS execution parameters for DLI
and DBB programs.

A -ALL

Displays the pop-ups described above in succession.

R - Restore IMS system
variables and parms

Executes the VIAPUIMS CLIST that restores the IMS
system variables and parameters to their site defaults.
See the discussion on modifying installed CLIST
libraries in the ASG-SmartTest Installation Guide for
detailed information on the VIAPUIMS CLIST.
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IMS DFSRESLB/DFSESL Allocation

Fields

Use the IMS DFSRESLB/DFSESL Allocation pop-up to specify the IMS and DB2 load
library datasets. All IMS load modules, including DL/I, are expected to be accessed
through DFSRESLB.

This is an example of typical DFSRESLB and DFSESL DD statements from batch
execution JCL:

//DFSRESLB DD DSN=IMS.RESLIB,DISP=SHR

See your batch execution JCL and PROCs for the DFSRESLB and DFSESL dataset
names used at your site.

To specify the IMS and DB2 load library datasets

1 Type 1 on the IMS Allocation Selection pop-up and press Enter. The IMS
DFSRESLB/DFSESL Allocation pop-up, shown in Figure 43, displays.

Figure 43 « IMS DFSRESLB/DFSESL Allocation Pop-up

IHE DFEREZLE-DFEEEL ALLOCATION
CoHHand ===k

Enter IHE Load Library Data set nades:
'IHZ.REZLIE"

Enter DEZ2 Load Library Data set nades:
'DENLDENLOAD"

2 Enter the appropriate information in the fields.

3 Press PF3/PF15 to return to the IMS Allocation Selection pop-up.

Enter IMS Load Library Specifies the IMS load library datasets to be allocated to the
Data set names DFSRESLB DDNAME.

Enter DB2 Load Library Specifies the DB2 load library datasets to be allocated to the
Data set names DFSESL DDNAME.
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IMS PROCLIB/DFSVSAMP Allocation

68

Use the IMS PROCLIB/DFSVSAMP Allocation pop-up to specify the datasets for
VSAM buffer pools and IMS procedure libraries. The DFSVSAMP dataset must be
allocated if databases are allocated using VSAM. Cataloged procedures used by IMS are
contained in the PROCLIB dataset.

This is an example of typical DFSVSAMP and PROCLIB DD statements from Batch
execution JCL:

//PROCLIB DD DSN=IMS.PROCLIB,DISP=SHR

See your batch execution JCL and PROCs for the DFSVSAMP and PROCLIB dataset
names used at your site. The PROCLIB datasets may often be concatenated in a
STEPLIB DD statement.

To specify the datasets for VSAM buffer pools and IMS procedure libraries

1 Type 2 in the primary command input area on the IMS Allocation Selection pop-up
and press Enter. The IMS PROCLIB/DFSVSAMP Allocation pop-up, shown in

Figure 44, displays.

Figure 44 « IMS PROCLIB/DFSVSAMP Allocation Pop-up

IH: PROCLIE~DFEVEAAP Allocation
CoHRand ===}

Enter IHE PROCLIE Data set nanes:
'IHZ.PROCLIE"

Enter DFEVEAHP Data zet nanes:
'IHE.PROCLIE[DFEVEHDE] !

2 Enter the appropriate information in the fields.

3 When all necessary information is specified, press PF3/PF15 to return to the IMS

Allocation Selection pop-up.
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Fields
Enter IMS The procedure library datasets to be allocated to the PROCLIB
PROCLIB Data DDNAME.
set names
Enter The datasets to be allocated to the DFSVSAMP DDNAME. Datasets
DFSVSAMP to be concatenated to the DFSVSAMP dataset can be entered on the
Data set names  remaining lines.

IMS PSB/DBD Allocation

Use the IMS PSB/DBD Allocation pop-up to specify the PSB and DBD library datasets.
PSB and DBD libraries must be allocated when the Data base region type field on the
IMS Session Setup pop-up contains DLI.

This is an example of typical IMS DD statements from batch execution JCL:

//IMS DD DSN=USER.PSBLIB,DISP=SHR
// DD DSN=USER.DBDLIB, DISP=SHR

See your batch execution JCL and PROCs for the PSB and DBD dataset names used at
your site. These datasets may often be concatenated in an IMS DD statement.

To specify the PSB and DBD library datasets

1 Type 3 in the primary command input area on the IMS Allocation Selection pop-up
and press Enter. The IMS PSB/DBD Allocation pop-up, shown in Figure 45,
displays.

Figure 45 « IMS PSB/DBD Allocation Pop-up

IHE PEE-DED Allocation
CoHHand ===

Enter PZE-DED Library Data set nanes:
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2 Enter the PSB and DBD dataset names to be allocated for use by IMS. The PSB and
DBD datasets are concatenated to the IMS DDNAME.

3 Press PF3/PF15 to return to the IMS Allocation Selection pop-up.

IMS ACB Allocation

Use the IMS ACB Allocation pop-up to specify the ACB library datasets. ACB libraries
contain the combined PSB and DBD information about the program. ACB libraries

should be allocated when the Data base region type field on the IMS Session Setup screen
contains DBB.

This is an example of a typical IMSACB DD statement from batch execution JCL:
//IMSACB DD DSN=USER.ACBLIB, DISP=SHR

See your batch execution JCL and PROCs for the ACB dataset name used at your site.

To specify the ACB library datasets

1 Type 4 in the primary command input area on the IMS Allocation Selection pop-up
and press Enter. The IMS ACB Allocation pop-up, shown in Figure 46, displays.

Figure 46 « IMS ACB Allocation Pop-up

IHE ACE Allocatiaon
CoHHand ===

Enter ACE Library Data et NaWes:

2 Enter the ACB dataset names to be allocated to IMSACB for DBB testing.

3 Press PF3/PF15 to return to the IMS Allocation Selection pop-up.
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IMS IMSMON Allocation

Use the IMS IMSMON Allocation pop-up to specify the DB monitoring datasets for
output from the IMS monitor.

This is an example of a typical IMSMON DD statement from batch execution JCL:
/ / IMSMON DD  DUMMY

See your batch execution JCL and PROCs for the IMSMON dataset name and attributes
used at your site.

To specify the DB monitoring datasets

1 Type 5 in the primary command input area on the IMS Allocation Selection pop-up
and press Enter. The IMS IMSMON Allocation pop-up, shown in Figure 47,
displays.

Figure 47 « IMS IMSMON Allocation Pop-up

IHE IHZHOM Allocation
CoHHand ===

Enter Data =zet name, DUHHY, TEHF, or blank:
MNane . . .

DEN DIEP [Mew, 014, ar Ehre)

Unit « « « S7E0A

Volume - . ______

fpacel

Units . . C¥L [Culinder, Track, or Elock]
Prinary 1

zecondary 1

DCE:

RECFH . . UE
LRECL . . 2idd
ELEKZIZE 2843

2 Enter the appropriate information in the fields.

Note:

If you use the IMS monitor, allocate a temporary dataset or permanent dataset in the
Name field. Additionally if the IMS monitor is to be invoked, specify Y in the MON
field on the IMS DLI/DBB Parameters pop-up.

3 Press PF3/PF15 to return to the IMS Allocation Selection pop-up.
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Fields

Name Specifies the name of the dataset. You can specify TEMP to allocate
a temporary dataset. No allocation is performed if this field is left
blank.

DSN DISP Specifies the disposition of the dataset. The disposition can be NEW,
OLD, or SHR.

Unit Specifies the device type for the SYSOUT output, such as SYSDA. A
device type is only specified for new or temporary datasets.

Volume Specifies the volume serial number containing the IMSMON dataset.

Units Specifies the type of space to be allocated for the dataset. Specify
space as CYLINDER, TRACK, or BLOCK.

Primary Specifies the number of primary cylinders, tracks, or blocks to be
allocated.

Secondary Specifies the number of secondary cylinders, tracks, or blocks to be
allocated.

RECFM Specifies the record format of the IMSMON dataset. Specify record
format as F (fixed) or V (variable).

LRECL Specifies the record length of the IMSMON dataset.

BLKSIZE Specifies the maximum length, in bytes, of a block for the IMSMON
dataset.

IMS IEFRDER Allocation

72

Use the IMS IEFRDER Allocation pop-up to specify an IEFRDER dataset to provide
backout and recovery for your IMS databases. This is an example of a typical IEFRDER
DD statement from batch execution JCL:

//IEFRDER DD DSN=IMSLOG,DISP=(NEW,CATLG),
// UNIT=SYSDA, SPACE=(TRK, (3,2),RLSE),

See your batch execution JCL and PROCs for the IEFRDER dataset name and attributes
used at your site.



Fields

3 Test Session: Additional Environments

To specify an IEFRDER dataset

1 Type 6 in the primary command input area on the IMS Allocation Selection pop-up
and press Enter. The IMS IEFRDER Allocation pop-up, shown in Figure 48,

displays.

Figure 48 « IMS IEFRDER Allocation Pop-up

CoHHand ===k

Enter Data zet nawWe, DURHY, TEHF, or blank:
MarMe . . .

IH: IEFRDER Allocation

TEHP

DEH DIZP — [Mew, 014, ar Zhr]

Unit . . . EY=0A

Wolune « o ______

Zpacel

Units . . G¥L [Culinder, Track, or Elock]
Prinary 1

Fecondary 1

DCE:

. VB
. 1916

1928

2 Enter the appropriate information in the fields.
Note:
Entering DUMMY in the Name field causes the IMS backout process to fail, should
you need to back out updates to your application databases.

3 Press PF3/PF15 to return to the IMS Allocation Selection pop-up.

Name Specifies the name of the dataset. You can specify TEMP to allocate
a temporary dataset. No allocation is performed if this field is left
blank.

DSN DISP Specifies the disposition of the dataset. The disposition can be NEW,
OLD, or SHR.

Unit Specifies the device type for the SYSOUT output, such as SYSDA.

Volume Specifies the volume serial number containing the IEFRDER dataset.

Units Specifies the type of space to be allocated for the dataset. Specify

space as CYLINDER, TRACK, or BLOCK.
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Primary Specifies the number of primary cylinders, tracks, or blocks to be
allocated.

Secondary Specifies the number of secondary cylinders, tracks, or blocks to be
allocated.

RECFM Specifies the record format of the IEFRDER dataset. Specify record
format as F (fixed) or V (variable).

LRECL Specifies the record length of the IEFRDER dataset.

BLKSIZE Specifies the maximum length, in bytes, of a block for the IEFRDER
dataset.

IMS BMP Parameters

Use the IMS BMP Parameters pop-up to specify execution parameters for IMS BMP
programs. This is an example of typical parameters from batch execution JCL:

//STEPNAME EXEC PGM=DFSRRC00, PARM= (BMP, &MBR, &PSB, &IN,
// &OUT, OPT&SPIE&TEST&DIRCA, &§PRLD,

See your batch execution JCL and PROCs for the parms used at your site.
To specify execution parameters for IMS BMP programs

1 Type B in the primary command input area on the IMS Allocation Selection pop-up
and press Enter. The IMS BMP Parameters pop-up, shown in Figure 49, displays.

Figure 49 « IMS BMP Parameters Pop-up

IH: BHF Paraneters
CoHHand ===
Enter IHE EHP EXecution paraneters:
IN & & ________ [Input transaction code)
ouT .. [Transaction code or logical terHinal for output)
OPT . . [Operator option M, W. or C]
EPIE 1] [SPIE option & ar 1]
TEST ] [Ualidity check call list address & o 1)
DIRCA Qg [Region interreqion coHAunication area)l
FRLD __ [OFEHPLHY suffis or leave blank]
STIHER _ [TiHer to be set @ or 1)
CKPTID _____________ [Checkpoint ID for restart or leave blank]
PARDLI 1 [Parallel OL<I option @ o 1)
CPUTIHE & [CPU tine for IHEZ)
NEA . . ___ [MuHber Fast Path data buffers)
0BA « o ___ [Munber additional page—fited buffers]
IHZID I [Eubsysten identifier?
AGM « & ________ [Application Group Nade)
EEH . . ____ [DE2 =subsystens Herber]
PREINIT __ [OFFINTHM suffis oF leave blank]
AFARH [APARA walue or blank]
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Enter the appropriate information in the fields.

See the IBM IMS System Definition Reference Manual for additional information on
each of the IMS BMP execution parameters.

Press PF3/PF15 to return to the IMS Allocation Selection pop-up.

IN

Indicates that the application program is accessing the message
queues. The OUT parameter is ignored when this parameter is
specified.

OuUT

Indicates the transaction code or logical terminal name to which an
output message is to be sent. This parameter is needed when the
application program sends output without accessing the input queues.

OPT

Indicates the action to be performed when the IMS control region is
unavailable. The valid options are N (notify), W (wait), or C (cancel).
The default value is N.

SPIE

Indicates whether control is passed when a program exception
(0C1-0CF) occurs, thus allowing the program to correct the problem
without an abend occurring. The default value is 0 (zero), which
indicates control is passed.

TEST

Indicates whether the address in the user call list is checked for
validity. The address in the user call list must be greater than the high
address of the MVS nucleus and less than the highest virtual storage
address of the machine. 1 indicates the address is to be checked. The
default value is 0 (zero).

DIRCA

Specifies the interregion communication area of storage that is used
by IMS to communicate with the test. The default value is 000.

PRLD

Specifies a suffix for DFSMPL and can be two alphabetical
characters. The specified suffix is used to preload modules in the
region. This field can be left blank if a suffix is not needed.

STIMER

Specifies whether the timer is to be set. If you specify CPUTIME=n,
the STIMER value must be 1. STIMER=1 results in performance
degradation and should only be specified when gathering statistics.
Zero (0) specifies that the timer is not to be set.

CKPTID

Specifies the checkpoint/restart ID used to restart a program.
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PARDLI Indicates where DL/I processing is to be performed. Zero (0) specifies
that DL/I processing is to be performed within the BMP region. One
(1) specifies that all DL/I processing is to be performed in the IMS
control region.

Note:
PARDLI has been forced to 1 for IMS system integrity issues.

CPUTIME This parameter must be 0 (zero) for SmartTest-PLI.

NBA Specifies the number of Fast Path data buffers. This field can be left
blank if Fast Path databases are not used.

OBA Specifies the number of additional page-fixed buffers for Fast Path
applications when the standard buffers are all used.

IMSID Specifies the subsystem identifier for the operating system being
used. This identifier is used instead of the IMS identifier specified
when the system was defined.

AGN Specifies the application group name used for resource access
security.
SSM Specifies a site-specific value that is used to allow access to selected

DB?2 subsystems under IMS. You can enter 1 to 4 alphanumeric
characters, or leave this field blank.

PREINIT Specifies a suffix for DFSINT that can be two alphabetical characters.
DFSINT xx contains a list of preinitialization modules to which
control is to be given. This field can be left blank if a suffix is not
needed.

IMS DLI/DBB Parameters

Use the IMS DLI/DBB Parameters pop-up to specify execution parameters for IMS
DLI/DBB programs.

This is an example of typical parameters from batch execution JCL:

//STEPNAME EXEC PGM=DFSRRC00, PARM= (DLI, &MBR, &PSB, &BUF,
// &SPIE&TEST&EXCPVR&RST, & PRLD, &SRCH,

See your batch execution JCL and PROCs for the parms used at your site.
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3 Test Session: Additional Environments

To specify execution parameters for IMS DLI/DBB programs

1 Type P in the primary command input area on the IMS Allocation Selection pop-up
and press Enter. The IMS DLI/DBB Parameters pop-up, shown in Figure 50,

displays.

Figure 50 « IMS DLI/DBB Parameters Pop-up

ConRnand

ELF
EPIE
TEST
EXCPUR
RET
PRLD
ZRCH
CKPTID
HON
LOGA
FHTO
IHZID
=MAP
DERC
IRLH
IRLHHH
EKO
AFPARH

Enter IH: DLISDEE Execution Paraneters:

[N i ]

b= B B R s 3

IHE DLI<DEE ParaHneters

[I5AH-05AH bBuffer pool size)

[ZPIE option @ or 1)

[Ualidity check call list address @ ar 1)

[Long terH fid of buffer pool @ or 1)

[UCF restart @ or 1)

[DFSHPLHN prefid o leave blank)

[Hodule search @=standard, 1=JPA and LPA first)
[Checkpoint ID for restart o leave blank]

[DE Roni tor active ¥ or Nl

[BZAH or O%AH logging @ or 1]

[Fornatted dunp option T, P, or M

[Eubsysten identifiear]

[Address space swappable oF non-swappable ' or N
[Data Base Recovery Control]

[ or N to use IRLH]

[IRLH =subsysteW naWe or leave blank)]

[Ownanic backout ¥ or M)

[APARA walue o blank]

Enter the appropriate information in the fields.

See the IBM IMS System Definition Reference Manual for additional information on
each of the IMS DLI and DBB execution parameters.

3 When all necessary information is specified, press PF3/PF15 to return to the IMS
Allocation Selection pop-up.

BUF The ISAM/OSAM buffer pool size. The default value is 8.

SPIE Indicates whether control is passed when a program exception
(0C1-0CF) occurs, thus allowing the program to correct the problem
without an abend occurring. The default value is 0 (zero), which
indicates control is passed.

TEST Indicates whether the address in the user call list is checked for

validity. The address in the user call list must be greater than the high
address of the MV'S nucleus and less than the highest virtual storage
address of the machine. 1 indicates the address is to be checked. The
default value is 0 (zero).
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EXCPVR

Indicates if real storage is to be reserved for use by IMS ISAM/OSAM
buffers. The default value is 0 (zero), which indicates storage is not
reserved.

RST

Indicates if the Utility Control Facility (UCF) is to be used for restarts.
The default value is 0 (zero), which indicates UCF is not to be used.

PRLD

A suffix for DFSMPL that can be two alphabetical characters. The
specified suffix is used to pre-load modules in the region. This field
can be left blank if a suffix is not needed.

SRCH

Indicates where the system is to search for modules. 0 (zero) specifies
the search is first in the JOBLIB/STEPLIB, then LINKLST, and then
LPA. 1 specifies that the search begins first in JPA/LPA, then
JOBLIB/STEPLIB, and then LINKLST. LPA (Link Pack Area)
modules are loaded into a high storage area that is available for use by
all jobs on the machine. JPA (Job Pack Area) modules are loaded into
storage for a job. The default value is 0 (zero).

CKPTID

The checkpoint/restart ID used to restart a program.

MON

Indicates if the IMS monitoring option is active. The default is N.

LOGA

Specifies the logging access method. This parameter is no longer used
and is ignored if specified.

FMTO

Specifies whether formatted dump output is to be produced.

T indicates IMS data areas are formatted and other areas are
suppressed by the Formatted Dump Delete List (FDDL). P indicates
no areas are suppressed and IMS data areas are formatted.

N suppresses the formatted dump output.

IMSID

Indicates the subsystem identifier for the operating system being
used. This identifier is used instead of the IMS identifier specified
when the system was defined.

SWAP

Indicates if the address space can be swapped when the System
Resource Manager (SRM) determines that an overload exists. An
overload occurs when the CPU utilization or the paging rate is too
high. The defaultis Y (yes), which indicates the address space can be
swapped.

DBRC

Indicates if Database Recovery Control is to be used for this execution
of IMS. Y specifies that Database Recovery Control is to be used and
must be entered if Y is specified for the IRLM option. N specifies that
Database Recovery Control is not to be used for this execution of
IMS. C is used only for batch backout type runs of IMS.
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IRLM

Indicates if the IMS Resource Lock Manager (IRLM) is to be used. Y
specifies that the IRLM is to be used. The default is N, which specifies
that the IRLM is not to be used.

IRLMNM

The name of the IRLM subsystem if IMS is sharing the database with
other IMS systems. The IRLM subsystem name is first specified in
the IMSCTRL macro that controls the IMS system. This field can be
left blank if the IRLM option is not used.

BKO

Specifies whether database updates are backed out when an abend
occurs. The default is N, which indicates the dynamic backout option
is not active.

BTS in TSO Foreground

Specifying BTS Setup Information

To specify the TSO test session parameters for BTS for testing

1 Select BTS on the Environment Selection pop-up. The BTS Session Setup screen,
shown in Figure 51, displays.

Figure 51 « BTS Session Setup Screen

CoHAand =
R - Beqin BTS test session [RUN] ¢ - Convert batch JCL to CLIST
F - Prewiew ETZIN data set U= Uerify BTE-IHE allocations
Erecution: options:

Load Hodule

Data bage region type!
OLI-DEE<EHF  DLI

File allocation CLIZT:
Data set nane
HeHbet

ETZINZ
Data set nane
HeHber

ET% Zession Setup

________ Ereak on entry [¥oN] YVES
Break CIECT-pGH id

Deallocate after test MO
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2 Complete these fields:
a Enter the load module in the Load module field.

b  Enter the CLIST dataset name and optional member in the Data set name and
member fields, respectively.

¢ Enter the appropriate information in the options. A description of each option
is provided below.

3  Complete the remaining fields on the screen as necessary.

Option Description

R Invokes the CLIST to initiate the test session. For more information,
see “SmartTest-PLI Test Session” on page 13.

P Displays the Preview BTSIN Data Set pop-up that is used to select the
BTS transactions and programs to be tested. Before selecting this
option, specify the BTS dataset name and member. For more
information, see “SmartTest-PLI Test Session” on page 13.

C Displays the Convert Batch JCL screen used to convert batch JCL to
an allocation CLIST. The converted allocation CLIST can be used to
establish the BTS test session. For more information, see
“SmartTest-PLI Test Session” on page 13.

A% Displays the BTS Allocation Selection pop-up that is used to select
the datasets, libraries, and parameters to be defined for BTS and IMS.
For more information, see “Specifying BTS File Allocation
Information” on page 83.

Field Description

Execution: Load Specifies the initial load module to be tested. This should be the name

module of the program that is executed by IMS.

Break on entry  Indicates whether the test session stops on initial entry at the start of

(Y/N) the load module. Additional break on entry options are available on
the Session Tailoring screen for each program to be tested. The
default is YES.

Break CSECT/  Causes the test session to stop on entry to the specified CSECT in a
pgm id statically linked module.
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Databaseregion Specifies the mode of the IMS/DB test session.

type:

DLI/DBB/BMP DLI: Uses private databases with database access through the TSO

region; uses DBDLIB and PSBLIB.

DBB: Uses privates databases with database access through the TSO
region; uses ACBLIB.

BMP: Uses public databases with database access through the IMS
Control Region.

Data set name Specifies the dataset containing the allocation CLIST generated by
the Convert Batch JCL facility.

Member Specifies the name of the allocation CLIST generated by the Convert
Batch JCL facility.

Deallocate after Indicates that the CLIST processor will be automatically invoked to

test deallocate the test files at the end of the test session or after a
CANCEL command is entered. Issuing another RUN command
causes the datasets to be reallocated. By default, the CLIST is
automatically invoked to deallocate the test files before exiting
SmartTest. The default is NO.

Data setname  Specifies the BTS input control statement dataset that contains the
PSBs and transactions available during the test session.

Member Specifies the BTSIN dataset member.

Selecting BTS Transactions to Monitor

Use the Preview BTSIN Data Set screen to display ./T commands residing in the BTSIN
dataset. Select the transactions to be tested with SmartTest-PLI. These transactions are
saved from session to session.

The BTSIN data might need altering to reflect these items:

. Specify a PSB= parameter on the appropriate ./T statement, even if the PSB has the
same name as the program to be tested, for example:

./T TC=TRNX MBR=TEST1 PSB=TEST1 PLC=25 LANG=CBL TYPE=DLI

. Add the TSO=NO parameter on a ./O statement to prevent BTS from prompting at
the terminal for input during the test, for example:

./0O TSO=NO

The BTSIN dataset may not be altered from this screen.
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To display ./T commands residing in the BTSIN dataset

1 Type P in th
press Enter.

Figure 52+ P

e primary command input area on the BTS Session Setup screen and
The Preview BTSIN Data Set screen, shown in Figure 52, displays.

review BTSIN Data Set Screen

CoMnand ==

3

w

Trancod

Prewview BETEIN Data et
= FCroll ===} CER

elect the Tranzactions and Prograds to be tested.

e Prograd PEEMARHE  Lang Twpe PLC  EPA Edit rtn DEZ PLAN

AODI
ADDINL
ADDPART
ACDPN
ER1d
CLOZE
COBZDES
DIZEURE
DLETI
DLETINU
DLETPAR
OLETPN
DEPALLI
LINKRZH
LINKCOE
LINKIRE

TETZAHOd TETEAHEd CEL  HEG
TEZTEZAHOd  TETEAAOL  CEL  HEG
TEZTEZAHOd  TETEAAOL  CEL  HEG
TETEARGd  TETEAMED  CEL  HEG
IEFER14  DFIZAMOZ RER H2G
TETEAHGBS  TETEAAOS  CEL  HEG
COEZD&E  DFEEAMEOZ CEL  HEG
E TETEAHOE TETZAHEE CEL HEG
TETZAHOd TETEAHEd CEL  HEG
TEZTEZAHOd  TETEAAOL  CEL  HEG
T TETEAHO4  TETZAHE4 CEL HEG
TETEARGd  TETEAMED  CEL  HEG
TETEAHGBY TETEAAGEY CEL  HEG
4 LINKAZN4 DFEZAHEZ RAZH HEG
LIMKCOE  DFEEAMEZ  CEL  HEG
LINKIHE  DF2:AMEZ CEL  H2G

e

2 Select the transaction(s) to be tested by typing S in the line command area and
pressing PF3/PF15 to return to the BTS Session Setup screen.

S Selects transaction for testing.

Trancode Specifies the transaction code name of the primary or secondary
transaction.

Program Specifies the load module of the application program that processes the
transaction named by the TC= operand.

PSBNAME Specifies the alphanumeric PSB name to be used when processing the
transaction named by the TC= operand.

Lang Specifies the programming language of the module named by the
MBR= operand. The default is ASM.

Type Specifies the type of application program being defined or the alternate
logical terminal type. The default is MSG.

PLC Specifies the processing limit count for this transaction. The default is 1.
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SPA Defines the size of the scratch pad area, in bytes, for the transaction
named by the TC= operand.

EDIT rtn Specifies the member name of the user-written transaction code (input)
edit routine that is called to edit each input message segment.

DB2 PLAN Specifies the DB2 plan name for the corresponding transaction.

Note:

If the program uses DB2, the DB2 name should be specified on the
BTSIN transaction ./T cards. The subsystem name should be defined to
BTS or specified in the BTSIN patch ./P cards.

Specifying BTS File Allocation Information

To select the BTS datasets, libraries, and parameters to be defined to IMS

1 Type V in the primary command input area on the BTS Session Setup screen and
press Enter. The BTS Allocation Selection pop-up, shown in Figure 53, displays.

Figure 53 « BTS Allocation Selection Pop-up

ET% Allocation Eelection
CoHHand ===

- BT% Laad library
= FORHAT

= QIOPCE

= QALTPCE

- QALTRAN

- BTs0UT

= BETSPUNCH

- ETEDEEUG

- BT EEMAP

e R B R B S

-

= IH: allocations and parHs

==l

- ALL [Display ALl Of The Above In Succession)

R — Restore BTE and IHS swsten wariables and parns.

2 Select the appropriate option(s) for items to be allocated to BTS. Typically, the
information on these screens is entered once and need not be re-entered each time a
test is performed.

Note:

If you choose option A, pressing PF3/PF15 automatically displays the next
allocation screen.

3 Press PF3/PF15 to return to the BTS Session Setup screen.
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1-BTS LOAD Displays the BTS Load Library pop-up that is used to specify the BTS

LIBRARY load library dataset.

2 - FORMAT Displays the BTS Format Libraries pop-up that is used to specify the
IMS/ESA Message Format Services (MFS) datasets.

3 - QIOPCB Displays the BTS QIOPCB Allocation pop-up that is used to specify
the BTS work file dataset.

4 - QALTPCB  Displays the BTS QALTPCB Allocation pop-up that is used to
specify the BTS work file dataset for alternate PCBs.

5-QALTRAN Displays the BTS QALTRAN Allocation pop-up that is used to
allocate the dataset to be used for alternate PCB output.

6 - BTSOUT Displays the BTS BTSOUT Allocation pop-up that is used to specify
the pop-up and message output dataset.

7 - BTSPUNCH Displays the BTS BTSPUNCH Allocation pop-up that is used to
specify the dataset used to capture all BTS input.

8 - BTSDEBUG Displays the BTS BTSDEBUG Allocation pop-up that is used to
specify the dataset used to capture SNAP dumps of the Trace Table
and various control blocks taken by BTS.

9 - BTSSNAP  Displays the BTS BTSSNAP Allocation pop-up that is used to specify
the dataset used to capture all other SNAP dumps taken by BTS.

I-IMS Displays the IMS Allocation Information pop-up that is used to

allocations and
parms

specify the datasets, libraries, and parameters that are to be defined to
IMS. See “Specifying IMS/DB Setup Information” on page 63 for
more information.

A -ALL

Displays the pop-ups described above in succession.

R - Restore BTS
and IMS system
variables and
parms

Executes the VIAPUBTS CLIST that restores the BTS and IMS
system variables and parameters to their site defaults. See the
discussion on modifying installed CLIST libraries in the
ASG-SmartTest Installation Guide for detailed information on the
VIAPUBTS CLIST.
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Specifying the BTS Load Library
This is an example of a typical BTS load library DD statement from batch execution JCL:

//STEPLIB DD DSN=BTSLIB,DISP=SHR

See your batch execution JCL and PROCs for the BTS load library dataset used at your
site.

To specify the BTS load library and STAX indicator for BTS

1 Type 1 in the primary command input area on the BTS Allocation Selection pop-up
and press Enter. The BTS Load Library pop-up, shown in Figure 54, displays.

Figure 54 « BTS Load Library Pop-up

ETS Load Library
CoHHand ===

Enter ETE Load Library Data Zet Mawe:
'BTE.BTELIE"

Enter BETE £TAX indicatorl _  [Y,.N, oF blank]

2  Enter the load library dataset that contains the programs used by BTS.
3 Type Y, N, or leave a blank in the Enter BTS STAX indicator field.

Note:

Y specifies that BTS is to process the TSO terminal attention exit. When this field is
left blank, BTS does not allow the selection of the TSO terminal attention exit.

If the message BTSO015A INVALID KEYWORD ON PARM STRING, 'DLI'
ASSUMED displays when the BTS test session is initiated, the STAX indicator
contains the wrong value. If this message displays, change the value in this field to
Y, N, or blank.

4  Press PF3/PF15 to return to the BTS Allocation Selection pop-up.
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Specifying BTS Format Libraries

Use the BTS Format Libraries pop-up to specify the format datasets from the IMS/ESA
Message Format Service (MFS) library.

This is an example of a typical FORMAT DD statement from batch execution JCL:

//FORMAT DD DSN=USER.FORMAT, DISP=SHR
// DD DSN=IMS.FORMAT, DISP=SHR

See your batch execution JCL and PROCs for the format dataset name used at your site.
To specify the format datasets from the IMS/ESA MFS library

1 Type 2 in the primary command input area on the BTS Allocation Selection pop-up
and press Enter. The BTS Format Libraries pop-up, shown in Figure 55, displays.

Figure 55 « BTS FORMAT Libraries Pop-up

ETE FORHAT Libraries
ConMand ===k

Enter ETE FORHAT Data set nanes:
'IHZ.FORHAT®

2  Enter the MFS datasets that are used to format the screen message.

3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Allocating the BTS QIOPCB

86

Use the BTS QIOPCB Allocation pop-up to allocate the dataset containing the output
message queue for BTS.

This is an example of a typical QIOPCB DD statement from batch execution JCL:

//QIOPCB DD UNIT=SYSDA,SPCE=(CYL,1,1),RLSE),
// DCB= (RECFM=FB, LRECL=1024, BLKSIZE=3072)

See your batch execution JCL and PROCs for the QIOPCB dataset name and attributes
used at your site.
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To allocate the dataset containing the output message queue for BTS

1 Type 3 in the primary command input area on the BTS Allocation Selection pop-up
and press Enter. The BTS QIOPCB Allocation pop-up, shown in Figure 56, displays.

Figure 56 « BTS QIOPCB Allocation Pop-up

CoHHand ===k
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RECFH . .
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TEHP
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i

[Culinder, Track, or BElock]

UEE
512
1072

2 Enter the appropriate information in the fields.
3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Name Specifies the name of the dataset. TEMP indicates a temporary dataset
is to be allocated. No allocation is performed if this field is left blank.

DSN disp Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.

Unit Specifies a generic name used to allocate the dataset if the dataset
name specified in the Name field is not cataloged or if TEMP was
specified in the Name field.

Volume Specifies the volume serial number containing the allocated dataset.

Units Specifies the type of space to be allocated for the dataset. Space can
be specified as CYLINDER, TRACK, or BLOCK. The default value
is CYLINDER.

Primary Specifies the number of primary cylinders, tracks, or blocks allocated.

The default is 1.
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Secondary Specifies the number of secondary cylinders, tracks, or blocks
allocated. The default is 1.

RECFM Specifies the record format of the allocated dataset. Record format
can be specified as F (fixed) or V (variable).

LRECL Specifies the record length of the allocated dataset. The default is
1024.
BLKSIZE Specifies the maximum length, in bytes, of a block for the allocated

dataset. The default is 3072.

Allocating the BTS QALTPCB

Use the BTS QALTPCB Allocation pop-up to allocate the alternate message queue
dataset used by BTS.

This is an example of a typical QALTPCB DD statement from batch execution JCL:

//QALTPCB DD UNIT=SYSDA,SPACE=(CYL, (1,1),RLSE),
// DCB= (RECFM=FB, LRECL=1024, BLKSIZE=3072)

See your batch execution JCL and PROCs for the QALTPCB dataset name and attributes
used at your site.

To allocate the alternate message queue dataset used by BTS

1 Type 4 in the primary command input area on the BTS Allocation Selection pop-up
and press Enter. The BTS QALTPCB Allocation pop-up, shown in Figure 57,
displays.

Figure 57 « BTS QALTPCB Allocation Pop-up

ETE QALTPCE Allocation
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2 Enter the appropriate information in the fields.

3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Field Description

Name Specifies the name of the dataset. TEMP indicates a temporary dataset
is to be allocated. No allocation is performed if this field is left blank.

Fields

DSN DISP Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.
Unit Specifies a generic name used to allocate the dataset if the dataset

name specified in the Name field is not cataloged or if TEMP was
specified in the Name field.

Volume Specifies the volume serial number containing the allocated dataset.

Units Specifies the type of space to be allocated for the dataset. Space can
be specified as CYLINDER, TRACK, or BLOCK. The default value
is CYLINDER.

Primary Specifies the number of primary cylinders, tracks, or blocks allocated.

The default is 1.

Secondary Specifies the number of secondary cylinders, tracks, or blocks
allocated. The default is 1.

RECFM Specifies the record format of the allocated dataset. Record format
can be specified as F (fixed) or V (variable).

LRECL Specifies the record length of the allocated dataset. The default is
1024.
BLKSIZE Specifies the maximum length, in bytes, of a block for the allocated

dataset. The default is 3072.
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Allocating the BTS QALTRAN

Use the BTS QALTRAN Allocation pop-up to allocate the dataset used for alternate PCB
output.

This is an example of a typical QALTRAN DD statement from batch execution JCL:

//QALTRAN DD UNIT=SYSDA,SPACE=(CYL, (1,1),RLSE),
// DBC= (RECFM=U, LRECL=1024, BLKSIZE=3072)

See your batch execution JCL and PROCs for the QALTRAN dataset name and attributes
used at your site.

To allocate the dataset used for alternate PCB output

1 Type 5 in the primary command input area on the BTS Allocation Selection pop-up
and press Enter. The BTS QALTRAN Allocation pop-up, shown in Figure 58,
displays.

Figure 58 « BTS QALTRAN Allocation Pop-up
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2 Enter the appropriate information in the fields.

3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Fields

Name Specifies the name of the dataset. TEMP indicates a temporary
dataset is to be allocated. No allocation is performed if this field is
left blank.

DSN DISP Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.
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Field Description

Unit Specifies a generic name used to allocate the dataset if the dataset
name specified in the Name field is not cataloged or if TEMP was
specified in the Name field.

Volume Specifies the volume serial number containing the allocated dataset.

Units Specifies the type of space to be allocated for the dataset. Space can
be specified as CYLINDER, TRACK, or BLOCK. The default
value is CYLINDER.

Primary Specifies the number of primary cylinders, tracks, or blocks
allocated. The default is 1.

Secondary Specifies the number of secondary cylinders, tracks, or blocks
allocated. The default is 1.

RECFM Specifies the record format of the allocated dataset. Record format
can be specified as F (fixed) or V (variable).

LRECL Specifies the record length of the allocated dataset. The default is
1024.
BLKSIZE Specifies the maximum length, in bytes, of a block for the allocated

dataset. The default is 3072.

Allocating the BTS BTSOUT

Use the BTS BTSOUT Allocation pop-up to allocate the dataset used for BTS program
output. Output includes input verification and formatted IMS call information.

This is an example of a typical BTSOUT DD statement from batch execution JCL:

//BTSOUT DD SYSOUT=*
// DCB= (RECFM=FBA, LRECL=133.B; LSOZE=133)

See your batch execution JCL and PROCs for the BTSOUT dataset name and attributes
used at your site.
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To allocate the dataset used for BTS program output

1 Type 6 in the primary command input area on the BTS Allocation Selection pop-up
and press Enter. The BTS BTSOUT Allocation pop-up, shown in Figure 59,
displays.

Figure 59 « BTS BTSOUT Allocation Pop-up

ETE ETE0UT Allocation
CoHHand ===

Enter Data zet nane, DURHY, TEHP, TERH OR ZVE0UTI
Nane . . . TERH

EVEQUT . . best _____
DEN DIEP [Mew, 014, or Zhr)
nit . . .

Uolune . .

fpacel
Units o & _________ [Eylinder, Track, or BElock]
PriHary

Eecondary

DCE:

RECFH . . FBER
LRECL . . 133
ELEZIZE 133

2 Enter the appropriate information in the fields.

3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Name Specifies the name of the dataset. TEMP can be specified to allocate
a temporary dataset; TERM can be specified to allocate the dataset to
aterminal; and SYSOUT can be specified to allocate the dataset to the
output spool.

SYSOUT Specifies a SYSOUT class value such as A. An entry in this field is
valid only if SYSOUT is specified in the Name field.

DEST Specifies the destination of the SYSOUT output such as R1 or
RSCS.ID. An entry in this field is valid only if SYSOUT is entered in
the Name field.

DSN DISP Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.
Unit Specifies a generic name used to allocate the dataset if the dataset

name specified in the Name field is not cataloged or if TEMP was
specified in the Name field.




3 Test Session: Additional Environments

Field Description

Volume Specifies the volume serial number containing the allocated dataset.

Units Specifies the type of space to be allocated for the dataset. Space can
be specified as CYLINDER, TRACK, or BLOCK. The default is
CYLINDER.

Primary Specifies the number of primary cylinders, tracks, or blocks allocated.

The default is 1.

Secondary Specifies the number of secondary cylinders, tracks, or blocks
allocated. The default is 1.

RECFM Specifies the record format of the allocated dataset. Record format
can be specified as F (fixed) or V (variable).

LRECL Specifies the record length of the allocated dataset. The default is 133.

BLKSIZE Specifies the maximum length, in bytes, of a block for the allocated

dataset. If BTSOUT is allocated to SYSOUT, a block size must be
specified. A fixed record format (RECFM=F) and a block size of 133
(BLKSIZE=133) outputs an unblocked file to the spool. A BLKSIZE
must be specified if the allocation is specified as anything other than
TERM.

Allocating the BTS BTSPUNCH

Use the BTS BTSPUNCH Allocation pop-up to allocate the dataset containing all input
received by BTS. This is an example of a typical BTSPUNCH DD statement from batch
execution JCL:

//BTSPUNCH DD DSN=USER.BTSPUNCH,DISP=(,CATLG),

// UNIT=SYSDA, SPACE=(CYL, (10,2),RLSE),
// DCB= (RECFM=FB, LRECL=80, BLKSIZE=6800)

See your batch execution JCL and PROCs for the BTSPUNCH dataset name and
attributes used at your site.
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To allocate the dataset containing all input received by BTS

1 Type 7 in the primary command input area on the BTS Allocation Selection pop-up
and press Enter. The BTS BTSPUNCH Allocation pop-up, shown in Figure 60,
displays.

Figure

60 « BTS BTSPUNCH Allocation Pop-up

CaoHMand ===

Enter Data zet nane, DUHKHY, TEHP, TERH, 2VE0UT, o blank:

ET: ETEPUNCH Allocation

MaHe + «

EVEQUT . . De=st
DEN DIEP [New, 01d, or Zhr)
nit « o o

Volune . o ______
fpacel

Units o & _________ [Culinder, Track, or Elock]
PriRary

Eecondary

DCE:

RECFH . - ___
LRECL o o oo
ELEZIZE

2  Enter appropriate information in the fields.
3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Name Specifies the name of the dataset. TEMP can be specified to allocate
a temporary dataset; TERM can be specified to allocate the dataset to
the terminal; and SYSOUT can be specified to allocate the dataset to
the output spool.

SYSOUT Specifies a SYSOUT class value such as B. An entry in this field is
valid only if SYSOUT is entered in the Name field.

Dest Specifies the destination of the SYSOUT output such as R1 or
RSCS.ID. An entry in this field is valid only if SYSOUT is entered in
the Name field.

DSN DISP Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.

Unit Specifies a generic name used to allocate the dataset if the dataset

name specified in the Name field is not cataloged or if TEMP was
specified in the Name field.




3 Test Session: Additional Environments

Field Description

Volume Specifies the volume serial number containing the allocated dataset.

Units Specifies the type of space to be allocated for the dataset. Space can
be specified as CYLINDER, TRACK, or BLOCK. The default value
is CYLINDER.

Primary Specifies the number of primary cylinders, tracks, or blocks allocated.

The default is 1.

Secondary Specifies the number of secondary cylinders, tracks, or blocks
allocated. The default is 1.

RECFM Specifies the record format of the allocated dataset. Record format
can be specified as F (fixed) or V (variable).

LRECL Specifies the record length of the allocated dataset.
BLKSIZE Specifies the maximum length, in bytes, of a block for the allocated
dataset.

Allocating the BTS BTSDEBUG

Use the BTS BTSDEBUG Allocation pop-up to allocate the dataset used for SNAP
dumps of the Trace Table and various control blocks taken during BTS execution.

This is an example of a typical BTSDEBUG DD statement from batch execution JCL:
//BTSDEBUG DD DUMMY

See your batch execution JCL and PROCs for the BTSDEBUG dataset name and
attributes used at your site.

95



ASG-SmartTest PLI User’s Guide

To allocate the dataset used for SNAP dumps

1 Type 8 in the primary command input area on the BTS Allocation Selection pop-up
and press Enter. The BTS BTSDEBUG Allocation pop-up, shown in Figure 61,
displays.

Figure 61 « BTS BTSDEBUG Allocation Pop-up

ET% ETEZDEEUG Allacation
CoHHand ===

Enter- Data set nane, DUHHY, TEHF, TERH, SYS0UT, or blank:
MaHE + . &

EVEQUT . . Dest _________________
DEN DIEP ___ [New, 014, or Zhr)
nit . . .

Uolume . .

Epace:
Units « & o [Culinder, Track, or Elock]
Pri Hary
Secondary

DCE:

RECFH . . __
LRECL - « _____
ELKZIZE

2 Enter the appropriate information in the fields.

3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Fields

Name Specifies the name of the dataset. TEMP can be specified to
allocate a temporary dataset; TERM can be specified to allocate the
dataset to the terminal; and SYSOUT can be specified to allocate
the dataset to the output spool.

SYSOUT Specifies a SYSOUT class value such as A. An entry in this field is
valid only if SYSOUT is entered in the Name field.

Dest Specifies the destination of the SYSOUT output such as R1 or
RSCS.ID. An entry in this field is valid only if SYSOUT is entered
in the Name field.

DSN DISP Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.

Unit Specifies a generic name used to allocate the dataset if the dataset

name specified in the Name field is not cataloged or if TEMP was
specified in the Name field.
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Field Description

Volume Specifies the volume serial number containing the allocated
dataset.

Units Specifies the type of space to be allocated for the dataset. Space can
be specified as CYLINDER, TRACK, or BLOCK. The default
value is CYLINDER.

Primary Specifies the number of primary cylinders, tracks, or blocks

allocated. The default is 1.

Secondary Specifies the number of secondary cylinders, tracks, or blocks
allocated. The default is 1.

RECFM Specifies the record format of the allocated dataset. Record format
can be specified as F (fixed) or V (variable).

LRECL Specifies the record length of the allocated dataset.
BLKSIZE Specifies the maximum length, in bytes, of a block for the allocated
dataset.

Allocating the BTS BTSSNAP

Use the BTS BTSSNAP Allocation pop-up to allocate the dataset containing SNAP
dumps taken by BTS during execution.

This is an example of a typical BTSSNAP DD statement from batch execution JCL:
//BTSSNAP DD SYSOUT=*

See your batch execution JCL and PROCs for the BTSSNAP dataset name and attributes
used at your site.
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To allocate the dataset containing SNAP dumps taken by BTS during execution

1 Type 9 in the primary command input area on the BTS Allocation Selection pop-up
and press Enter. The BTS BTSSNAP Allocation pop-up, shown in Figure 62,
displays.

Figure 62 « BTS BTSSNAP Allocation Pop-up

ET: ETEENAP Allocation
CoHHand ===k

Enter Data set nane, DURHY, TEHP, TERH, #VE0UT, or blank:
MaHe . . &

EVEQUT .. Dest

DEW DIEP ___ [Mew, 01d, or Zhr)
nit . . .

Uolune . .

Zpacel
Units « « _________ [Culinder, Track, or Elock]
PFi Haty
Zecondary

DCE:

RECFH . . ___
LRECL . .
ELEZIZE

2 Enter the appropriate information in the fields.

3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Fields

Name Specifies the name of the dataset. TEMP can be specified to
allocate a temporary dataset; TERM can be specified to allocate the
dataset to the terminal; and SYSOUT can be specified to allocate
the dataset to the output spool.

SYSOUT Specifies a SYSOUT class value such as A. An entry in this field
is valid only if SYSOUT is entered in the Name field.

Dest Specifies the destination of the SYSOUT output such as R1 or
RSCS.ID. An entry in this field is valid only if SYSOUT is entered
in the Name field.

DSN DISP Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.
Unit Specifies a generic name used to allocate the dataset if the dataset

name specified in the Name field is not cataloged or if TEMP was
specified in the Name field.

98



3 Test Session: Additional Environments

Field Description

Volume Specifies the volume serial number containing the allocated
dataset.

Units Specifies the type of space to be allocated for the dataset. Space can
be specified as CYLINDER, TRACK, or BLOCK. The default
value is CYLINDER.

Primary Specifies the number of primary cylinders, tracks, or blocks

allocated. The default is 1.

Secondary Specifies the number of secondary cylinders, tracks, or blocks
allocated. The default is 1.

RECFM Specifies the record format of the allocated dataset. Record format
can be specified as F (fixed) or V (variable).

LRECL Specifies the record length of the allocated dataset.
BLKSIZE Specifies the maximum length, in bytes, of a block for the allocated
dataset.

Specifying IMS File Allocation Information from BTS Allocation Selection

Use the IMS Allocation Selection pop-up to select the IMS datasets, libraries, and
parameters to be defined to IMS.

Select option I on the BTS Allocation Selection pop-up to display the IMS Allocation
Selection pop-up.

See the Batch Terminal Simulator: Program Reference/Operations Manual (SH20-5523)
for more information about BTS.

Note:

If your IMS file allocations were not entered previously or you need to change them, see
“Specifying IMS File Allocation Information” on page 65.
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DB2 Programs in TSO Foreground

Specifying DB2 Setup Information

To specify the TSO test session parameters for DB2 programs

1 Select DB2 on the Environment Selection pop-up. The DB2 Session Setup screen,
shown in Figure 63, displays.

Figure 63 « DB2 Session Setup Screen

DE2 Zession Setup

CoHHand ===
R - Begin DE2 test session [RUM] - Conuert batch JOL to CLIET
Executiaon: dptions:
Load wodule  ________ Ereak on entry [v<H] YES
DEZ2 Plan name ________ Break CEECT-pgn id .

DB2 Zubsysted

Execution paradeters:  [quotes are optionall

File allocation CLIET:
Data set nane
HEHbEr o o o Deallocate after test NO

2  Complete these fields:
a Enter the load module in the Load module field.

b Enter the CLIST dataset name and member in the Data set name and member
fields, respectively.

¢ Enter the appropriate information in the options.

Option Description

R Initiates the DB2 test session. This is the equivalent of entering the
RUN command. For more information, see “SmartTest-PLI Test
Session” on page 13.

Options

C Displays the Convert Batch JCL pop-up used to convert batch JCL to
an allocation CLIST. The converted allocation CLIST can be used to
establish the DB2 test session.
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3 Test Session: Additional Environments

Field Description

Load module Specifies the initial load module to be tested. This should be the name
from the TSO RUN PROGRAM command.

DB2 Plan name Specifies the DB2 Plan that was generated for the program to be tested
when the BIND was performed.

DB2 Subsystem Specifies the name assigned to DB2 when it was installed in the MVS
environment.

Break on entry  Indicates whether the test session will stop on initial entry at the start

(Y/N) of the load module. Additional break on entry options are available on
the Session Tailoring screen for each program to be tested. The
default is YES.

Break Causes the test session to stop on entry to the specified CSECT in a

CSECT/pgmid statically linked module.

Execution Specifies required application parameters.
parameters

Data set name Specifies the dataset containing the allocation CLIST generated by
the Convert Batch JCL facility.

Member Specifies the name of the allocation CLIST generated by the Convert
Batch JCL facility.

Deallocate after Determines whether the CLIST processor will be automatically

test invoked to deallocate the test files at the end of the test session, or
after a CANCEL command is entered. Issuing another RUN
command causes the datasets to be reallocated. By default, the CLIST
is automatically invoked to deallocate the test files before exiting
SmartTest. The default is NO.
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DB2 Stored Procedure Testing Option

SmartTest has an optional feature that enables a programmer/analyst to interactively test
and debug a DB2 Stored Procedure.

A stored procedure is a user-written program that resides on a DB2 server. An SQL
CALL interface allows an SQL requester to invoke the stored procedure at a DB2 server.
The stored procedure is a Language Environment compliant program, written in PL/I,
COBOL, C/370, or Assembler. The procedure name is defined to DB2 in a table,
SYSIBM.SYSPROCEDURES. When the client executes an SQL CALL, DB2 searches
this table for the procedure name contained in the SQL CALL.

Normally, a stored procedure executes in a special DB2 address space. However,
SmartTest tests the stored procedure in TSO foreground.

Requirements
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Before setting up a DB2 Stored Procedure test, make sure these preliminary operations
have been performed:

. The SmartTest DB2 option is installed at your site.

. The stored procedure name is defined to DB2 in the SYSIBM.SYSPROCEDURES
table.

. The stored procedure is bound as a plan or a package. (If the stored procedure is
bound as a package, the package must be bound within a plan.)

. The stored procedure program is Analyzed and stored in an AKR.

Note:

If you are unsure of the completion of any of the above tasks, check with your DB2
database administrator.
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Setting Up the DB2 Stored Procedure Test

To specify the test session parameters for a DB2 Stored Procedure program

1 Select DB2 Procedure on the Environment Selection pop-up.The DB2 Stored
Procedures Setup screen, shown in Figure 64, displays.

Figure 64 « DB2 Stored Procedures Setup Screen

DE2 &tored Procedures Setup
CoHHand ===}

R - Begin DE2 Ztored Procedure session [RUN)
¢ = Conuert batch JCL to CLIET
O - Display Paradeters

Execution: options:
Load Hodule . & . ________ Break on entry (YoM YES
DEZ Plan nawe . .« ________ Ereak CEECT-pgn id o « ________
OEZ2 Subsysted . . Use RRESAF [¥<H] . . « NO

DEZ Scheda name . DIAL2S
DEZ Procedure nawe __________________
File allocation CLIET:
Data set name
HEHEEF o &+ « Deallocate affer Test MO

2 Under Execution, complete these steps:

a

Enter the initial Load module to be tested; the entry must be the name of the
DB?2 stored procedure to be tested.

Enter the DB2 Plan name that was generated for the stored procedure program
to be tested.

Enter the DB2 Subsystem where the stored procedure program is to run.
Enter the DB2 Schema name, which is the name of the DB2 entry in the
SYSIBM.SYSROUTINES table that contains the information about the store
procedure program. This field defaults to your TSO user ID.

Enter the DB2 Procedure name—that is, the DB2 entry in the

SYSIBM.SYSPROCEDURES table that contains the information about the
stored procedure program.
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3

Under Options, complete these steps:

a In the Break on entry (Y/N) field:

— Type YES to stop the test session at the start of the test execution (such
as, to change test data values). The default is YES.

—  Type NO to run the test execution to completion (end or abend).

Additional break options are available. See “Tailoring a Test Session by
Program” on page 155 for more information.

b  To stop the test session on entry to a specified CSECT in a statically linked
module, enter the program name in the Break on CSECT/pgm ID field.

If non-DB2 resources are used by the Stored Procedure, convert that JCL to a CLIST
and make the CLIST available to the test. To allocate a CLIST:
a Make these entries under File allocation CLIST:

—  Enter the dataset and member name for the CLIST.

—  Todeallocate the test files at the end of this test session or aftera CANCEL
command, type YES in the Deallocate after test field. To deallocate the
test files at the end of the SmartTest session, type NO. (The defaultis NO.)

b  Type C to display the Covert Batch JCL pop-up. Follow the instructions in
“Converting Batch Execution JCL to a TSO CLIST” on page 40.

If you are expecting input parameters from the stored procedure, type D to display
parameters

Or

If you want to review output, see “‘Reviewing DB2 Stored Procedure Parameters”
on page 105.

Type R to begin the test session. See “Initiating the DB2 Stored Procedure Test” on
page 107 for more information.
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Reviewing DB2 Stored Procedure Parameters

To review input and output parameters

1

Review the parameters on the DB2 Stored Procedures Parameters screen, shown in
Figure 65). Each parameter specified in the PARMLIST column on the
SYSIBM.SYSPROCEDURES table displays.

Figure 65 « DB2 Stored Procedures Parameters Screen

DB2 Stored Procedures Parameters
Command ===> Scroll ===> CSR
Name Type Address Structure Value Hex Value
_ CUSTNO IN 000D5148 CHARACTER(8) Al234 ClF1F2F3 F4404040
_ CUSTNM ouT 000D5198 CHARACTER (20) JONES D1D6D5C2 C2C9D3
_ CUSTBAL OUT 000E0000 SMALLINT 50000 1388
_ ERROR ouT 000E1000 CHARACTER(255)  ........ 00000000 00000000
LR R R RS RS R SRS EEEEEEEEEEEEEEEEEEES BOTTOM OF DATA ERE R R RS S S SRR EEEEEEEEEEEEEEEE]

This table describes the fields on the DB2 Stored Procedures Parameters screen:

Name Specifies the optional parameter name that can be used by DB2 for
diagnostic messages.

Type Defines the parameter as IN (input), OUT (output), or INOUT
1/0).

Address Specifies the main storage location acquired by SmartTest for the
data.

Structure Provides information on the parameter's data attributes: character,
integer, floating point, decimal, or variable character data.

Value Specifies the character format of the data at that storage location.
The maximum is 8 characters.

Hex Value Specifies the hexadecimal representation of the data at that

storage location.

Type S in the line command area to the left of the parameter Name and press Enter.

. If the data is defined as numeric, the DB2 Stored Procedures Numeric Display
screen displays.

. If the data is not defined as numeric, the Memory Display screen displays.
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Changing Test Data Values

If the parameter you selected on the DB2 Stored Procedures Parameters screen is defined
as numeric, the DB2 Stored Procedures Numeric Display screen displays. If the
parameter you selected is non-numeric, the Memory Display screen displays.

To review/change numeric values

1 Review the selected parameter on the DB2 Stored Procedures Numeric Display
screen (see Figure 66).

Figure 66 « DB2 Stored Procedures Numeric Display Screen

DB2 Stored Procedures Numeric Display
Command ===>
Numeric Data Address Type Length
+0 000E0O000 SMALLINT

This table describes the fields on the DB2 Stored Procedures Numeric Display
screen:

Numeric Data  Displays the current numeric value for the parameter. You can
change the value in this field.

Address Specifies the hexadecimal address of this parameter.

Type Provides the parameter's data definition to DB2 (i.e., integer,
decimal, float).

Length Specifies the data length defined to DB2 (used only if the Type is
decimal).

2 If desired, change the numeric value for the parameter in the Numeric Data field.
3 Press Enter to save your changes.
4  Press PF3 twice to return to the DB2 Stored Procedures Setup screen.

5 Proceed to “Initiating the DB2 Stored Procedure Test” on page 107.
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To review/change non-numeric values

1 Review the selected parameter on the Memory Display screen (see Figure 67).

Figure 67 « Memory Display Screen

Memory Display

Command ===> Scroll ===> CSR
Area 000D5148 Offset 000000 Length 000050
MEMBER DATA NAME=

000D5148 C1FIFCFS F4404040 00000000 00000000 00000000
000D5158 00000000 00000000 00000000 00000000 00000000
000D5168 00000000 00000000 00000000 00000000 00000000
000D5178 00000000 00000000 00000000 00000000 00000000 * ......veeunnn....
000D5188 00000000 00000000 00000000 00000000 00000000 * ......vveennn....

R R
* Ok %k

This table describes the fields on the Memory Display screen:

Field Description

Area Displays the hexadecimal address of this parameter.
Offset Displays the relative address of this parameter.
Length Displays the data length as defined to DB2.

2  To make a change, type over the values displayed.
3 Press Enter to save your changes.
4  Press PF3 twice to return to the DB2 Stored Procedures Setup screen.

5 Proceed to “Initiating the DB2 Stored Procedure Test” on page 107

Initiating the DB2 Stored Procedure Test

You have set up your DB2 Stored Procedures test and are ready to initiate the test session.
The Break on entry option stops the session for interactive data entry. All SmartTest
functions (e.g., breakpoints, session tailoring, pseudo code, searching) may be used
during your DB2 test session.
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To initiate the test session

1

2

Type R on the DB2 Stored Procedures Setup screen and press Enter.

Watch the test session execute the stored procedure in Program View. If you did not
set breaks during set up, the program executes until one of these conditions occurs:
. An abend error condition

. An address stop

. Completion of the stored procedure

If you set Break on entry, the test session stops at the beginning of PROC (and at
other breakpoints, as specified).

At the breakpoint at the end of the test, press PF4 (RUN) to return to the DB2 Stored
Procedures Setup screen (see “Setting Up the DB2 Stored Procedure Test” on

page 103).

On the DB2 Stored Procedures Setup screen, type D to review output parameters on
the DB2 Stored Procedures Parameters screen (see “Reviewing DB2 Stored
Procedure Parameters” on page 105).

To use additional SmartTest functions, see “Testing Techniques” on page 121 and “The
Intelligent Search Function” on page 163.

Testing Programs in a Batch Region
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The Batch Connect facility in SmartTest allows your original JCL to be executed in a
batch region. Use of this facility provides significant reductions in setup requirements
and TSO resource consumption. The tradeoff is the job remains active in the batch region
for the entire test session.

Consider using the SmartTest Batch Connect in these circumstances:

Programy(s) to be tested requires too much region for execution in TSO foreground.
Test requires media not accessible through TSO foreground (i.e., tape datasets).
Test must consist of multiple interdependent steps.

Test requires the use of special output forms.

There is a limit of one program to test for each SmartTest batch execution.
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. When running a DB2 test under Batch where there is a PROC in the JCL, the
SYSTSIN DD statement must be in the PROC and may not be overridden after the
execute of the Procedure. The DD for SYSTSIN in the Procedure may use the
DDNAME Parameter to allow the DD statement to be placed after the execute.

The Batch Session Setup screens establish a test session in a batch region. Once the test
session is established, an online session can be connected to it. Batch program testing can
be performed interactively. Symbolic support may be unavailable for programs loaded
from read protected libraries.

Specifying Batch Connect Setup Information

The MVS, IMS, BTS, and DB2 Batch Session Setup screens are identical except for the
screen title. MVS Batch is used as the example for this section, but the discussion pertains
to setup in all Batch environments.

To establish a batch test session in an MV'S batch region

1

2

Select MVS Batch on the Environment Selection pop-up. The Batch Session Setup

screen, shown in Figure 68, displays.

Figure 68 » Batch Session Setup Screen

Batch Zession Setup

CoMAand ===}
5 - SubHit eHecution JoL G - Generate froW edecution JOL
¢ — Connect to subWitted job EG - Edit generated JCL
P - Epecify procedure libraries G - EubHit generated JCL
E - Edit edecution JCL

Executian:
Load module ________
Procedure Mame ________
Step Nane

options:
Ereak on entry [¥<N] YE%
Break CEECT-pgH id
Region SiZe o« « « »
Library Hanager

EBatch edecution JOL:
Data set nade
Hernber . . .

Generated JOLI
Data =&t nane
Henber « o o &

Eesgion naWe for batch CoWAuni cations:
TZ0 Userid . . USERLZ

Complete these fields:

a Enter the load module in the Load module field.

b Enter the batch execution JCL dataset name and member in the Batch

Execution JCL Data set name and Member fields, respectively.

¢  Enter the appropriate information in the options. A description of each option

is provided below.
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Options

Fields
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Option Description

S Submits the specified execution JCL. The JCL dataset name and
member name must be entered in the BATCH EXECUTION JCL
fields.

C Displays the Connect to Job pop-up used to connect the online test

session with a batch test session.

P Display the Procedure Libraries pop-up used to specify procedure
libraries. If you do not enter any procedure libraries on this screen, the
libraries listed in the PROCLIBS entry in VIASPRMS are used to
search for procedures.

E Invokes the TSO/ISPF editor with the batch execution JCL prior to
SmartTest-PLI changes.

G Generates the batch JCL and saves the output in the specified
GENERATED JCL member without executing it. The SG (Submit
Generated JCL) option can be used to pass the generated output
directly to the operating system for execution. Job submission does
not occur.

EG Generates batch connect JCL and invoke the TSO/ISPF editor with
the generated JCL. Job submission does not occur.

SG Submits the specified generated JCL. The generated JCL dataset
name and member name must be entered in the GENERATED JCL
fields.

Field Description

Load module Specifies the initial load module to be tested.

Procedure Name Specifies PROC name of the procedure containing the execute
statement for the load module to be tested.

Step Name Specifies step name in the batch job that executes the load module to
be tested.

Break on entry  Indicates whether the test session will break on entry at the start of the

(Y/N) load module. Additional break on entry options are available on the
Session Tailoring screen for each program to be tested. The default is
YES.
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BREAK Causes the test session to stop on entry at the start of the specified
CSECT/pgmid CSECT in a statically linked module.

Region size Modifies the region size in the execution JCL. The region size of the
step containing the program to be tested is changed to the value
specified in this field. The default is 4 megabytes.

Library Specifies the name of the subsystem. If the JCL to be converted is

Manager stored in a source library that is installed with a subsystem option,
enter the name of that subsystem. Also, the dataset and member name
used by the source library management system must be specified in
the Batch execution JCL field.

Data setname  Specifies the partitioned dataset containing the member to be
submitted or edited, or from which JCL is to be generated. If the
subsystem option is used, specify the subsystem library dataset name.

Member Specifies the member to be submitted or edited, or from which JCL is
to be generated.

Data set name Specifies the partitioned dataset that contains the generated JCL.

Member Specifies the member that contains the generated JCL.
Session name Contains the ID with which the batch session communicates, and
for batch typically is the user ID of the person submitting the job. Another user

communications ID can be specified if desired. If another user ID is specified, note that
TSO Userid the AKR and the test load libraries are those specified by the user
submitting the batch job(s). The AKR and load libraries for another
user ID could be different from those being used by the person
submitting the job.

When you select option S or G on the Batch Session Setup screen, these changes are
made to the specified batch execution JCL:

A STEPLIB DD statement for the step to be tested is added or updated to
concatenate the ESW load library to the user load library.

. The REGION size is changed to the value specified on this screen.

. A VIAQUEUE DD statement is added for the SmartTest-PLI queue dataset used
during communication between the TSO and Batch test sessions.

. The EXEC PGM is altered for the step to be tested to allow SmartTest-PLI to gain
control at the appropriate step.
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ASG recommends that the JOBNAME for the JCL you submit be unique. If you use the
EG (edit generated JCL) option to generate the JCL to the specified dataset, the JCL can
then be edited and the job name can be changed in the generated JCL.

The REGION from the EXEC JCL card is changed to the specified REGION size on the
screen. A DD card is added to the STEPLIB for the dataset containing the ESW library. A
DD card is also added for the SmartTest VIAQUEUE dataset. This dataset is used to
transfer data to and from the TSO address space when the test job is executing. PROCs
are automatically expanded. Enter the required user PROCLIBs on the Procedure
Libraries pop-up (ENV.P).

ASG also recommends that you verify that the work file allocation information entered
on the Options - Product Allocations pop-up is valid for the batch test session. The
GENERIC UNIT and VOLUME SERIAL fields should contain the appropriate values
for your installation. Inappropriate work file allocations can cause unpredictable results
during the batch test session. See “SmartTest-PLI Test Session” on page 13 for detailed
information on the Options - Product Allocations pop-up.

When submitting execution JCL or submitting generated execution JCL, the TSO
SUBMIT command is issued from a CLIST so the system standard TSO SUBMIT exit
receives control and can process the JCL. The submitted JCL must have a JOB card with
a job name that will not be changed by the exit.

Submitting and Connecting to a Batch Job

To establish a test session in a batch region, submit a batch job and connect to it. After
submitting the job, use the Connect to Job pop-up to establish the TSO interface to the
job.

Submitting a Job
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To submit the batch job for execution

1 Type S or SG on the primary command input area on the Batch Session Setup screen
and press Enter.

Note:

For future reference, note the job name and assigned job number shown in the TSO
message that displays (see Figure 69).

Figure 69 « Connect to Job Message Screen

+ASG2076I Batch JOB JOBNAME is waiting for connection by ASG-SmartTest
* kK

2 Press Enter to return to the Batch Session Setup screen.
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Connecting to a Job

To connect the online TSO test session with a batch test session

1 Type C in the primary command input area on the Batch Session Setup screen and
press Enter. The Connect to Job pop-up, shown in Figure 70, displays.

Figure 70 « Connect to Job Pop-up

Connect to Job
ConMand ===k ECroll ===k CIR

T50 Userid USERLZ [Required for TE0-IEPF HORi Tor]

Enter 'S' to select a job to be tested.

Enter 'P' to purge a job frod the ASG-SHartTest queus
file.

select JobnuH Jobnane Etatus

N

Select a job by typing S in a Select field that has a status of WATTING FOR
CONNECTION and pressing Enter.

Option Description

S Connects to an available batch session. The selected job becomes active
in SmartTest (see “Initiating the Batch Test” on page 114).

Options

P Purges (delete) a batch session or submitted job.

Status Descriptions

CONNECTED, TEST Indicates that the job is currently connected to the online
ACTIVE test session by the specified TSO user ID.

BEGINNING EXECUTION  Indicates that the job has a batch initiator, but is not
ready for connection.

JOB SUBMITTED TO Indicates that the job is waiting for a batch initiator.
BATCH

113



ASG-SmartTest PLI User’s Guide

Status Meaning

TEMPORARILY Indicates that the job was previously connected to the

SUSPENDED online test session by the specified TSO user ID but was
suspended using the PA1 or ATTN key.

WAITING FOR Indicates that the job has a batch initiator and is ready to

CONNECTION be connected to the online test session.

Initiating the Batch Test

After specifying all information for testing in the batch environment on the appropriate
Batch Session Setup screens, you can initiate the test by submitting the JCL and
connecting to the batch job.

When the batch connection is complete, the program source or disassembled object code
displays in Program View (shown in Figure 71) and the test session is active.

Figure 71 « Batch Connect Program View Screen

File View Test Search List Options Help

Program View (A) VIAPPLI.VIAPPLI1 -A
Command ===> Scroll ===> CSR
(B) 296
>>>>>>  CALL PROGRAM INIT;
000298
000314 CALL PARM EDIT; /* INITIAL PARM_EDIT */
000315
000316 IF PARM TEXT = 'EXIT' THEN
000317  RETURN;
000318 ELSE
000319 IF PARM TEXT = 'INVALID' THEN
000320 DO;
000321 CALL INVALID PARM;
000322 RETURN; B
000323 END;
000324

000325 TIF CURRENT_PARM NUMBER = +0 THEN
000326 CALL INVALID PARM;

000327

+(C) —mm +
|STATUS: BREAK AT START OF TEST SESSION PROGRAM: VIAPPLI1 DATE: DDMMMYYYY |
| STMT: 000297 OFF: 00029E AMODE: 31 MODULE: VIAPPLI TIME: HH:MM:SS \
| SOURCE: CALL PROGRAM INIT; \
o +

Screen Description

Screen Area Description

(A) VIAPPLL.VIAPPLII1 -A  Reflects the module and program (module.program)
being viewed and indicates the program is in an active
(-A) test session.

(B) >>>>>> Indicates the next statement to be executed. The statement
is highlighted and chevrons appear in the number column.
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(C) STATUS: BREAK Displays the status information when a test session is

active:

STATUS Indicates the current status of the test.

STMT Specifies the statement number of the next
statement to be executed.

OFF Specifies the offset into the CSECT/load
module where the next statement to be
executed is located.

AMODE Specifies the addressing mode for the load
module.

SOURCE Specifies the source for the next statement
to be executed.

PROGRAM Specifies the name of the program/CSECT
currently active in the test.

MODULE  Specifies the name of the load module
currently active in the test.

DATE Specifies the current date.

TIME Specifies the time the last program
statement was executed.

Batch Region Considerations

When submitting JCL through SmartTest-PLI for testing in a batch region, you may need
to modify your JCL before processing. Keep these considerations in mind:

The TSO SUBMIT command is issued internally within SmartTest so the system
standard exit receives control and can process the JCL for job submission. The JCL
must have a JOB card with a job name that will not be changed by the TSO
SUBMIT exit.

When testing DL/I in the batch environment, if the program to be tested does not
access DB2 databases or use BMP to access the DB2 database:

—  Select the IMS Batch environment on the Environment Selection pop-up.
—  Submit the JCL from the IMS Batch Session Setup screen.

There is a limit of one program to test for each SmartTest batch execution.
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Testing DL/l in the Batch Environment

To use the IMS Batch environment

1 Select the IMS Batch environment on the Environment Setup Menu to display the
IMS Batch Session Setup screen shown in Figure 72.

Figure 72 « IMS Batch Session Setup Screen

IHE Batch Zession Zetup

CoWHand ===
% - 2ubdit ekecution JCGL 5 - Generate froW edecution JCL
C - Connect to subHitted job EG - Edit generated JCL
P - Epecify procedure libraries EE - EubHit generated JCL
E - Edit eHecution JCL
Execution: aptions:
Load Wodule  ________ Ereak on entry [Y<H] YE%
Procedure Made ________ Break CEECT-pgH id  ________
Etep Mame . . ________ Region Sige o & « & _____

Library Hanager . .
Eatch execution JCL:
Data set name
HeHber « o o &

Generated JCL:
Data set nane
Henber o o o &

F@s5=ion nane for batch coWHunications:
TE0 Userid . « UEER1Z_

2 Submit the JCL from the Batch Submit screen.

3 Connect to the batch session using the batch Connect to Job screen.
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Testing BTS in the Batch Environment

To use the BTS Batch environment

1 Select the BTS Batch environment on the Environment Setup Menu. The BTS Batch

Session Setup screen, shown in Figure 73, displays.

Figure 73 « BTS Batch Session Setup Screen

ET%® Batch Zession Setup

Procedure MaHe
Ztep Hane . .

Break CEECT-pgH id
Region SiZe . - .« &
Library Hanager

Batch ewecution JCLI
Data set nane
Henber « o o

Generated JCLI
Data et nade
Herber . . . &

F@SSi0n naWe for batch conMunications:
TE0 Userid . o USERLZ_

CoHHand ===
% - ZubMit enecution JCL G - Generate froM edecution JOL
¢ - Connect to SubHitted job EG - Edit generated JoL
P - Zpecify procedure libraries 3G - ZubKit generated JoL
E - Edit execution JCL
Executiond options:
Load Hodule Ereak on entry [Y-H] YES

2 Submit the JCL from the Batch Submit screen.

3 Connect to the batch session using the Connect to Job screen.
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Testing DB2 in the Batch Environment
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To test DB2 using the Batch Submit screen

1 Select DB2 Batch as the environment on the Environment Setup Menu. The DB2
Batch Session Setup screen, shown in Figure 74, displays.

Figure 74 « DB2 Batch Session Setup Screen

DE2 Batch Zession Setup
CoHHand ===

% - ZubHit eMecution JCL G - Generate froM emecution JoL
¢ - Connect to subHitted job EG — Edit generated JCL
F - pecify procedure libraries 3@ - SubMit generated JCL
E - Edit eHecution JCL
Executian: options:
Load Hodule  ________ Ereak on entry [YoN] YEE
Procedure Mame ________ Ereak CEECT-pgW id  ________
Etep Mame . . ________ Reqion Size . . . & _____

Library Hanager
Eatch execution JCLI

Data set nawe

Herber . . . .

Generated JOLI
Data set nane
HeHber o o .

Fesgion nane for batch CoWAunications:
TE0 Userid . « USER1Z_

2 Submit the JCL from the Batch Submit screen.
3 Connect to the batch session using the Connect to Job pop-up.
There is a limit of one program to test for each SmartTest batch execution.

When running a DB2 test under Batch, the JCL that is submitted is automatically
changed. If there is a PROC in the JCL, the SYSTSIN DD statement must be in the
PROC and may not be overridden after the execute of the procedure. The DD for
SYSTSIN in the procedure may use the DDNAME Parameter to allow the DD statement
to be after the execute.

Note:

SmartTest does not recognize the LIB() field of the SYSTSIN dataset. Load libraries
specified in the LIB() field must be specified in the STEPLIB DD concatenation.




Support for Changed DB2 Interface
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DB2 Version 4.1 provides an alternative method in which IMS/DB can set up the DB2
environment. The execution parameter specifies the application program name and must

specify the SSM field, for example:

EXEC PGM=DFSRRCO00, PARM="DLI, pgm,PSb, yrrrrrrrrrrrrsrr,SsSm"

SmartTest supports this new interface, but requires that the JCL specify the DDITV01DD
card. See the IBM DB?2 for MVS Application Programming and SQL Guide for more

information on this alternative method.

Testing DFHDRP in the Batch Region

To test DFHDRP in the batch environment

1 Select the MVS Batch environment on the Environment Selection pop-up.

2 Edit the JCL from the Batch Session Setup screen and change the program to be
tested to VIAPDLI. This is done by changing the PGM=pgmname parameter in the

PARM statement to PGM=VIAPDLI.

3 Submit the JCL by typing S or SG on the setup screen.

4 Connect to the batch session using the batch Connect to Job screen.

DFHDRP Batch JCL

Figure 75 shows the DFHDRP batch JCL before being modified by SmartTest.

Figure 75 « DFHDRP Batch JCL Before Modifications

//ASG JOB (ASG), 'ASG-SMARTTEST DFHDRP'
/*ROUTE PRINT DEST

//*

//DFHDRPB PROC SYSOUT=A

//*

//STEPO1 EXEC PGM=DFHDRP,REGION=1M,

//STEPLIB DD DSN=USER.PGMLIB, DISP=SHR

// DD DSN=IMS.RESLIB, DISP=SHR
// DD DSN=CICS.RESLIB,DISP=SHR
//IMS DD DSN=USER.PSBLIB,DISP=SHR
// DD DSN=USER.DBDLIB, DISP=SHR

//DFHLIB DD DSN=CICS.LOADLIB, DISP=SHR
//SYSUDUMP DD SYSOUT=&SYSOUT

// PEND

//DRPTEST EXEC DFHDRPB

//SYSOUT DD SYSOUT=&SYSOUT

//REPORT DD SYSOUT=&SYSOUT

//D121PART DD DSN=PART.DB10V09, DISP=SHR

// PARM='SSA=254,PGM=TPGM22, PSB=TPGM22,CICS=CICS1,CMPAT=Y, LANG=C'
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Figure 76 shows the DFHDRP batch JCL after being automatically modified by
SmartTest.

Figure 76 - DFHDRP Batch JCL After Modifications

//ASG JOB (ASG), 'ASG-SMARTTEST DFHDRP'

/*ROUTE PRINT DEST

/*

//DFHDRPB PROC SYSOUT=A

/*

//STEPO1 EXEC PGM=DFHDRP,REGION=2M,

// PARM='SSA=254,PGM=VIAPDLI, PSB=TPGM22, CICS=CICS1,CMPAT=Y, LANG=C'
//STEPLIB DD DSN=ASG.VIACENxx.LOADLIB,DISP=SHR,

// DCB=BLKSIZE=32760

// DD DSN=USER.PGMLIB, DISP=SHR
// DD DSN=IMS.RESLIB, DISP=SHR
// DD DSN=CICS.RESLIB, DISP=SHR
//IMS DD DSN=USER.PSBLIB, DISP=SHR
// DD DSN=USER.DBDLIB, DISP=SHR

//DFHLIB DD DSN=CICS.LOADLIB,DISP=SHR
//SYSUDUMP DD SYSOUT=&SYSOUT

// PEND

//DRPTEST EXEC DFHDRPB

//SYSOUT DD SYSOUT=&SYSOUT

//REPORT DD SYSOUT=&SYSOUT

//D121PART DD DSN=PART.DB10V09,DISP=SHR
//VIAQUEUE DD DSN=ASG.VIACENxx.QUEUE,DISP=SHR




Testing Techniques

This chapter describes testing techniques for SmartTest-PLI and contains these sections.

Topic Page

Learning the Commands 122
Testing with SmartTest 122
Controlling Program Execution 124
Viewing and Changing Test Session Data 135
Program Execution History (Backtrack) 140
Using Pseudo Code 149
Making Proposed Changes Permanent 154
Using Multiple Programs 154
Tailoring a Test Session by Program 155
Capturing and Replaying Test Sessions 155
Position the Display at the Next Executable Statement 157
Saving Keystrokes 158
Linking to Alliance 160

Note:

This chapter assumes that you have completed the appropriate setup and analyze
procedures.
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Learning the Commands

SmartTest provides both a Common User Access (CUA) and a command interface to
accomplish your testing activities. CUA presents an intuitive way of performing tasks. As
you gain experience with SmartTest, you may find that using commands is faster than
CUA pull-downs for frequently used functions. To assist you in making the transition
from CUA to commands, SmartTest includes a Learn Mode. When Learn Mode is on,
SmartTest inserts a pop-up, before executing a request, that shows the primary command
equivalent to the selections made on the CUA pull-downs and pop-ups. This pop-up helps
you learn the command syntax for frequently used functions. The full CUA functionality
remains available also.

To turn the learn mode on, type SET LEARN ON in the primary command input area
and press Enter. The short message area displays the message LEARN ON.

To turn the learn mode off, type SET LEARN OFF in the primary command input area
and press Enter. The short message area displays the message LEARN OFF.

Testing with SmartTest

At the start of a test session, SmartTest attaches the application program as a subtask to
SmartTest's user interface code. Execution of the application program is controlled by
commands entered to SmartTest, which in turn controls the application code.

SmartTest has two distinct methods for controlling the application program—MONITOR
and NOMONITOR. Each method has a strength and a weakness and each is designed to
help get the most out of debugging sessions. SmartTest allows mixed methods during a
single test session to offer benefits of each technique for individual test situations.

Both MONITOR and NOMONITOR are specified by an operand in the RUN function.
The SET MONITOR command determines the default. Guidelines for choosing either
MONITOR or NOMONITOR are included in this manual.

Testing Using the MONITOR Method
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The MONITOR method is designed specifically to help during the detailed debugging
stage, when a problem has been isolated to a specific program, or a specific subroutine
within a program.

Using the MONITOR method, SmartTest executes the application program code one
instruction at a time. Executing instructions individually gives SmartTest the ability to
create an execution history (LIST TRACKING), count each statement as it executes
(LIST COUNTS), and monitor instructions that modify memory. Monitoring memory
modifications gives SmartTest-PLI the unique ability to provide storage protection for a
user-specified location (LIST ADSTOP).
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Using the MONITOR method also allows temporary modification of the program using
COBOL-compatible pseudo code. Additional advantages to the MONITOR method
include minimal test setup requirements, detection of INVALID BRANCH situations,
etc.

Since the monitoring method requires execution of several instructions by SmartTest to
execute one application instruction, the CPU overhead of monitoring a large test is
significant. If performance becomes an issue, use the NOMONITOR method (RUN
NOMON).

Testing Using the NOMONITOR Method

The NOMONITOR method is designed to execute the application at native speed with
negligible CPU overhead added by SmartTest. In the NOMONITOR method, SmartTest
gives control to the application program and waits for an application abend, a breakpoint,
or completion of the test.

In the NOMONITOR method, certain facilities are not available (LIST TRACK, LIST
COUNTS, etc.). However, abends are intercepted and COBOL-compatible pseudo code
can be inserted to control the flow of the test program.

The NOMONITOR method places intentional abend instructions (breakpoints) at various
points in the object code, then gains control when the code abends (SOC1) during
execution. This technique requires that each program analyzed must be linked with the
REUS parameter. This parameter is automatically supplied by the Analyze process, but
can be overridden on the SmartTest List - Analyze Submit pop-up.

Guideline for Using the MONITOR/NOMONITOR Methods

In general, use the MONITOR method for most testing and debugging. The CPU
overhead in relation to the value of the debugging information is acceptable.

For example, the Execution Tracking screen shows all of the statements that executed, in

execution sequence. This screen can be used to follow the execution path backward to see
the execution path to the current statement.
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To reduce the overhead of a test session, place a breakpoint at a label where a suspected
problem exists and then execute the program using NOMONITOR to execute the test at
native speed until it reaches the breakpoint set. Then, use the STEP primary command or
RUN MONITOR primary command to find the problem. After finding the problem,
either CANCEL the test, or RUN NOMONITOR to completion. This technique uses the
strengths of both methods, while reducing the overall CPU utilization.

Note:

The NOMONITOR method makes problem determination difficult when the application
program issues its own SPIE/ESTAE. This intercepts the intentional internal program
checks set by SmartTest before it can examine them, yielding unpredictable results.

To test such programs, disable the SPIE and restart the test using NOMONITOR. If there
is no way to disable the SPIE, it is necessary to run through the SPIE/ESPIE using
MONITOR. Then, you can run through the rest of the code using NOMONITOR.

Testing Dynamically Called Load Modules

Prior to executing a CALL verb, many application programs use the FETCH verb to
locate or dynamically load the module to be CALLed. When using the MONITOR
method of testing, SmartTest can detect whether a module that is FETCHed has been
statically linked.

When using the NOMONITOR method, SmartTest cannot determine when control is
transferred from one load module to another. If you want to make SmartTest debugging
facilities available in the CALLed module, it is necessary to define to SmartTest the
names of the FETCHed load modules. This specification allows SmartTest to intercept a
CALL to those modules.

To test dynamically CALLed load modules, use the QUALIFY command to activate the
CALLed module. Then, you can either set breakpoints in the module, or set the Break on
Entry column to YES on the Test Session Tailoring screen.

Controlling Program Execution
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SmartTest gives you the opportunity to step through a program statement by statement or
execute the program to a specified breakpoint where you can verify the program's
behavior. You may interrupt or end a test session at any time without waiting for
end-of-job.
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Program execution is controlled using actions on the Test pull-down, primary commands,
or line commands. Figure 77 shows the Test pull-down.

Figure 77 » Test Pull-down Menu

File Uiew Test Search List O0ptions Help

__ 1. setup Vizards...
CoHHand === Za RUMus
3. Etep...
d. Cancel
5. Break...
E. &top... Hetededok
Te Glaus Hetetobok
* &. Houe,.. ok ktetskck shetedetobobek
Heke . Adda .. ok ebeick Hetstobobotstok
e 18. Zubtracta.. * etk Hetek
Hetedek 11. Where... Aetetdok Aotk
Hetstokok 12. Testpoints... etstobototststobottstolotottotok
Hetettoh 13. AEE-ALLliance Interface... Hetsteboteiststobotsttototototck
1d. CICE HNewcopy...
15. DuHp
Cop unpublished work.

A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Meb Site at wuW.asg.cod

Selecting Test Environment Using the Setup Wizards

Use the Setup Wizards option to save time in setting up common types of test
environments. Setup wizards are available for IMS, CICS, and programs in TSO
foreground or using batch connect. These wizards are self-explanatory and walk you
through the process of setting up the appropriate environment.

Executing the Program Continuously Using RUN

To begin test execution or to resume execution after an interrupt occurs, follow this step:

P Select Test » Run or type RUN. The Test - Run Request pop-up, shown in Figure 78,
displays.

Figure 78 * Test - Run Request Pop-up with BackTrack Off

Test - Run Reguest

Enter "Run To" line nudber and Honitor option,
as needed. Then press Enter.

Run to Line Munber ______
Zelect Honitor option

1. Honitor

2. Mo Honi tor

125



ASG-SmartTest PLI User’s Guide

An interrupt can result from any of these conditions:
. Abend error condition
. Breakpoint or Stop Address

. Completion of program

You can use the RUN command any time program execution is suspended. This
command is usually assigned to a PF key for convenience.

These are examples of the RUN command:

Command Description

RUN MON Allows all execution features to be available.

RUN TO 1432  Establishes line number 1432 as the stopping point. Execution
continues to line 1432 unless other interrupts occur before the line is
reached.

See the ASG-SmartTest Reference Guide for more information about using the RUN
command.

Executing a Specified Number of Statements Using STEP

To execute a specific number of statements any time program execution is suspended,
follow this step:

P Select Test P Step or type STEP. The Test - Step Request pop-up, shown in Figure 79,
displays.

Figure 79 » Test - Step Request Pop-up

Test - &tep Request

felect £tep type, Step Options, oF Honitor Option, as neaded.
Then press ERtar.

tep ...
o 1. fto nedt STATEHENT [Default)

2. to nedt PARAGRAPH-LABEL

I. OUER [COBOL PERFORH, Asserbler Linkage, or

PL-I CALL)
#tep Options:

Etep Count _____ Enter 1 to 65535 [to @99 for
Auto]
step Auto Enter non-blank to select

Honitor Option: [If OUER specified)
1. Honitor
2. No Honi tor
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An interrupt can result from any of these conditions:
. Abend error condition
. Breakpoint or Stop Address

. Completion of program

When there are no abends or breakpoints, the program executes the specified number of
statements or runs until the program completes.

You may use the STEP command any time program execution is suspended. This
command is usually assigned to a PF key for convenience.

These are examples of the STEP command:

STEP Executes the next statement and stops.
STEP 5 Executes the next 5 statements before stopping.
STEP AUTO Executes one statement and pauses for the time period specified using

the SET DELAY command.

See the ASG-SmartTest Reference Guide for more information about using the STEP
command.

Changing Program Execution Sequence Using GO

SmartTest-PLI provides the capability of changing the program execution sequence. This
may be useful to bypass certain code or to test only certain code.

Select Test » Go, the GO line command, or the GO primary command to change the next
statement to be executed. The RUN or STEP command causes execution to resume at the
selected statement.

The Test - Go Request pop-up is used to transfer control to the statement containing the
specified PL/I label name, pseudo code label, or line.

Note:
You must be in an active test session to use the GO command. You can only enter a GO
command for executable source lines. It is recommended you use the GO command only
to transfer control to a statement within the PROCEDURE or BEGIN block currently
being executed.

Altering execution flow may cause some statements to be re-executed or by-pass
statements that initialize data fields resulting in abend conditions or unpredictable results.
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Interrupting Test Execution Using Keystroke

Use the PA1/ATTN Key to interrupt program execution during a test session.

In TSO foreground, when you press PA1/ATTN after a RUN MONITOR primary
command is issued, the RUN command is changed to a STEP command and the program
is suspended at the next PL/I statement. When you press PA1/ATTN after a STEP n
command is issued, the remaining steps are not executed and the program is suspended at
the next PL/I statement.

Note:
The interrupt keys do not apply to CICS when executing with NOMONITOR.

In a Batch Connect test session, when you press PA1/ATTN when a program is running,
the connection to the batch region is suspended. The batch version of SmartTest
continues to run until an abend or break, or the completion of the test. When the batch
region is ready for command input, SmartTest sets the job state to Waiting for
Connection. The SmartTest job waits for the tester to reconnect to the job and resume
testing, or times out if waiting too long.

Inserting Breakpoints to Interrupt Execution

SmartTest provides the capability of inserting breakpoints into a program at desired
locations. Program execution is suspended each time a breakpoint is encountered during
test execution. While the program is suspended, you can view data values, insert pseudo
code, trace execution paths, or perform other SmartTest tasks.

SmartTest provides three methods of inserting breakpoints into your program:

. Manually, at specific lines

. Automatically, based on program knowledge

. Automatically, with an impact dataset

After inserting breakpoints, they remain active until deactivated or deleted. You may save

breakpoints in the AKR for any program when you conclude a test session. In that way,
the breakpoints are in the program if the test needs to be resumed later.

Manually Inserting Breakpoints in the Program

Use the BR line command to manually insert a breakpoint before the source line where
the command is entered. When you type BR on a non-executable or continuation line, the
BREAK is inserted before the next executable statement in the program.
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Automatically Inserting Breakpoints in the Program

To automatically insert a breakpoint, follow this step:
» Select Test P Break or type BREAK.

The Break facility uses the Intelligent Search Function to insert multiple breakpoints with
a single command.

You can insert breakpoints before or after the specified target. For example, typing
BREAK 1000 INITIALIZE inserts a breakpoint before the label 1000_INITIALIZE.

For more information about the search function and available operands, see "The

Intelligent Search Function" on page 163 and "Searching for PL/I Program Information"
on page 167.

Inserting Breakpoints with Impact Datasets
SmartTest provides facilities for automatically setting breakpoints with lists of data
items. The lists are called impact datasets. You can create impact datasets yourself or
import them from AutoChange, Alliance, or Estimate.

Impact Datasets from Other Programs

Execution JCL supplied with these ESW products is used to run batch jobs for creating
impact datasets:

. AutoChange — VIAMEXPJ
. Alliance — VIAMEXP]J
. Estimate — VIAMEXP]J

See the ASG-AutoChange User’s Guide, the ASG-Alliance User’s Guide, or the
ASG-Estimate User’s Guide for information on creating impact datasets.

User-supplied Impact Datasets

The name of an impact dataset must match the name of the program to which it will be
applied. When creating an impact dataset, create it as a member of a PDS and name it
appropriately.
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The member contains a list of fully qualified datanames, one fully qualified dataname per
line. Each dataname must begin in column ten. Lines beginning with an asterisk are
comment lines. All lines that are not comment lines must contain an X in each of the first
four columns, as shown in Figure 80.

Figure 80 ¢ User-supplied Impact Dataset

XXXX
XXXX
XXXX
XXXX

TEST-DATE 00020000
NUMBER1 OF TEST-NUM1 00030001
00040000
00050000

To set breakpoints with impact datasets

1

Type TESTPOINT on the command line, or choose Testpoints from the Test
pull-down. The Test - ASG-SmartTest Testpoint Generation pop-up, shown in

Figure 81, displays.

Figure 81 » Test - SmartTest Testpoint Generation Pop-up

CoHHand ===

Test - ASG-3HartTest Testpoint Generation

Enter PrograH, Attribute, IWpact type and POS, then ENTER to generate point
Press END to return.

Generate Testpoints:

PrOGradls ) eeeeennnns IGZEEET

Data nade ATtribute. HOD [HOD<REF]

IHpact TYpE.weeaaun. AUTO [AUT O<ALL-EST ~USER ]
PDEweeennnns e

LT IGZEBST

Complete the fields using the information this table:

Program(s) Selects programs listed in the impact dataset. Enter the name of
a single program or use an asterisk to select all of them. The
names you select must match the names of the programs to
which you apply the breakpoints.

Data Name Specifies where to set breakpoints. One of two entries is

Attribute allowed, either MOD or REF. MOD sets a breakpoint in the

code wherever an impacted data item is modified. REF sets a
breakpoint in the code wherever the impacted data item is
referenced.
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Field Description

Impact Type Indicates the source of the imported impact dataset. These are
the allowable entries:

AUTO. AutoChange
ALL. Alliance

EST. Estimate
USER. User-supplied

PDS Specifies the PDS containing the impact dataset to be imported.

Member Lists the PDS member name containing the impact dataset for
ALL, EST, or USR impact types.

Press Enter to display the Test - Testpoint Qualified Program List pop-up shown in
Figure 82.

Figure 82 » Test - Testpoint Qualified Program List Pop-up

Test - Testpoint Qualified Program List
Command ===> Scroll ===> CSR

Select program(s) from the list, then Press ENTER to generate points. Press
END to return.

PDS......... '"ASG.VIACENXX.TESTPNT'
Program Specification: *

Selected Program Status

_ TESTPLIA READY
_ TESTPLIB READY
TESTPLIC READY
T KKK KK KKK KKK KKK KKK KKK KKK KX Kk * BOTTOM OF DATA * % K %k ok k ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok k%
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Type an S next to the names of those programs you wish to select and press Enter.
The Breakpoints List screen, shown in Figure 83, displays for the first program you
selected.

Figure 83  Breakpoints List Screen

Breakpoints List TESTPLI.TESTPLI1
Command ===> Scroll ===> CSR
Set pseudo . . ON Pseudo active: 13 Inactive: 0
Set breaks . . ON Breaks active: 13 Inactive: 0
Set whens . . . ON Whens active: 0 Inactive: 0
S Line Pseudo Code (breakpoints highlighted) A Count
_ 000046 *
ol BREAK Y 000000
_ 000047 TESTNUM1=1;
_ 000048
ol BREAK Y 000000
_ 000049 TESTNUM2=2;
_ 000050
el BREAK Y 000000
_ 000051 TESTDATE=1;
_ 000051 TESTDATE=1;
ol BREAK Y 000000
_ 000052 TESTDATE=1;

The Breakpoints List screen allows you to make these adjustments:
. Change the status of SET PSEUDO, SET BREAKS, or SET WHENS.
. Deactivate individual breakpoints.

. Remove individual breakpoints.

Exit the Breakpoints List screen. The Program View screen, shown in Figure 84,
displays breakpoints and the source code or disassembled object code and data.

Figure 84 « Program View Screen

File View Test Search List Options Help
Program View TESTPLI.TESTPLI
Command ===> Scroll ===> CSR
rrrvrl BREAK
000047 TESTNUM1=1;
000048
rrerry BREAK
000049 TESTNUM1=1;
000050
rrrvrl BREAK
000051 TESTDATE=1;
rrerry BREAK
000052 TESTDATE=1;
rrrvrl BREAK
000053 TESTDATE=1;
rrrvrl BREAK
000054 TESTDATE=2;
rrerry BREAK
000055 TESTDATE=2;
rrrvrl BREAK
000056 TESTDATE=2;
000057 *




4 Testing Techniques

6  Inspect the breakpoint settings in the Program View screen and exit the Program
View screen. The Test - Testpoint Qualified Program List pop-up redisplays.

After successfully applying an impact dataset to a program, you see an IMPACT
APPLIED message in the Test - Testpoint Qualified Program List pop-up,
indicating that breakpoints have been saved into the program's source code in the
AKR. You have these options:

. If you selected multiple programs in step 3, those programs are still selected.
Press Enter and repeat step 4 and step 5 for the next selected program.

. Select one or more program, press Enter, and proceed.

. Exit.

Inserting Breakpoints at Date-related Data ltems
To set breakpoints at date-related data items, use the EXECUTE command to run the
STFINDAT script while in a test. The STFINDAT script sets breakpoints wherever it
finds date identifiers and special keywords unique to date processing across IMS (PCB
date fields), CICS (EXEC CICS asktime), and COBOL (CURRENT DATE, etc.).
When executed, the STFINDAT script performs these tasks:
. Finds all data items listed in the script
. Highlights the data items
. Issues a BREAK HI ALL command
Use the STFINDAT script to interrupt processing at key points so that you can examine
or change date information. The STFINDAT script can be tailored to locate these items:
. Calls to user-written date routines

. Date-related comments

. Changes having a common pattern that are also date sensitive, such as in CALL
routines and copybook areas

Locating the Next Executable Statement

When a test is suspended, you may want to scroll through the program examining other
statements or data values. To reposition the screen to the next statement to be executed,
type LOCATE * in the primary command input area and press Enter.
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Displaying Breakpoints

To display breakpoints, follow this step:

» Select List » Breakpoints or type LIST BREAK. The Breakpoints List screen displays
listing all breakpoints for the program currently in Program View.

You can activate and deactivate individual breakpoints or all breakpoints in a program
using the Breakpoints List screen.

Removing Breakpoints Individually

Use the D line command on the Breakpoints List screen to delete individual breakpoints
from the program. This command operates in the same manner as the D (delete) line
command in TSO/ISPF.

Removing All Breakpoints

Use the View - Reset Request pop-up or the RESET BREAKS primary command to
remove all breakpoints from the program. The Breakpoint included in blocks of pseudo
code is only deleted if the BREAK statement is the first statement in the block. You can
also use the RESET PSEUDO command to delete the breakpoints along with the rest of
the pseudo code statements.

Generating a Dump

To generate a dump, follow this step:

» Select Test » Dump or type DUMP to generate a symptom and a snap dump of the
program being tested, along with its control blocks.

The symptom dump includes general program information and REGISTER information.
The REGISTER information contained in the snap dump is limited to the current values
at the time you issue the dump and might not include the user’s register values. The snap
dump consists of all PDATA and some SDATA SNAPX options and is appended to the
symptom dump data. All dump data is copied to the log file. See "Log/List/Punch
Processing Options" on page 19 for information about processing the log file.

Canceling a Test Session

To cancel the current test session, follow this step:
» Select Test P Cancel or type CANCEL.

The CANCEL command closes open test files and frees allocated storage. The program
remains displayed in Program View. Use the RUN or STEP commands to restart the test
if desired.
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The short message reflects the cancellation of the test session, and the data window and
status box are removed from the Program View screen.

Exiting a SmartTest-PLI Test Session
To terminate a test session and exit from SmartTest, follow this step:
P Select File P Exit.
Any pseudo code, marks, or breaks are saved in the AKR if the online operation

parameters have Save as the default. See "SmartTest User Options" on page 16 for more
information on setting these parameters.

You can also exit SmartTest by continually pressing PF3 or by typing =x on the
command line.

Viewing and Changing Test Session Data

SmartTest provides the ability to interactively view and change data, allowing you to test
all program conditions, including conditions not exercised by the data in test files. You
can view and change data by opening data windows within the program and typing over
the values presented in the data window. You may open windows to view and change the
data any time program execution is suspended.

Data windows may be displayed inline with the statement where the data is used, at any
DECLARE statement, or at the top of the Program View screen. You may open windows
on individual or group level data items. The values shown in data windows are always
current and change as the program executes.

SmartTest determines the size of the data windows based on the amount of data to be
displayed. You may override the default size for each data window on the Options -
Modes screen. If a data window cannot contain all the data to be displayed, it becomes
scrollable.

The message UNABLE TO ACCESS DATA in the value field indicates that storage for
the data item has not been allocated.

Viewing Test Session Data Items Inline

Use the ZD, ZH, ZG, ZGH, ZOOMDATA, K, and KEEP commands to perform these
functions.

Use the ZD line command to open display format data windows to show the value and
address of data items.
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Use the ZH line command to open hexadecimal format data windows to show the value
and address of data items.

The result of a ZD or ZH line command is a data window showing the data items
referenced on the line where the command is entered. The data window is positioned after
the statement where the command was entered. When the screen is scrolled, the data
window moves with the display. If the data window cannot accommodate all the data
items specified for it, you can scroll through the data window.

The data window contains the definition and value of the data item. Alphanumeric values
are shown in character format and numeric values are shown in decimal format with
leading zeroes suppressed. If the length of the data item is greater than fifty bytes,
additional lines are displayed with +50, +100, +150 and so on preceding them as shown

in Figure 85.

Figure 85 « Sample Inline Data Screen

File Uiew Test 3Zearch List oOptions Help
Progran Uiey TEZTCOEALTESTCOER
CoHnand === Ecroll === GER
Oaeael  TDEMTIFICATION DIUIEION.
Qaeaaz  PROGRAA-I0O. TEZTCOEA.
000083  ENUIRONHENT DIUIZION.
ga00ad  CONFIGURATION ZECTION.
000085  DATA DIVIZION.
DE900E  WORKING-STORAGE ZECTION.
ggeaay o1 TEZTER.
+
) 01 TEZTER FIC R[] ADDR E@anyaon
VALUE  auaususmssmsnssmsnnusannnsnnnnansnnansnnnnnnnnnnns <
L <
+

DA0A8S A5 MEI-CHEP-COUNTER PIC 2999,
Qa0A03 05 WE-CHEP-INTERUAL PIC ®(5]. DEADDAT
Egala 05 TESTZ PIC (7?1
aaga1l 85 UAR-FIELD REDEFIME: TEZT3.
aagal 2 18 NUHEER1 FIC 5%(5] COHP-3.
aaeaLz 18 FILLER PIC W[7E].
aaeald SKIP2

When you enter the ZD or ZH line command on an array data item, the dimensions are
shown to allow you to change the data item being displayed.

You may use the n (number) operand of the ZD command to display one data item in a
statement containing multiple data items. Data items are assigned relative numbers from
left to right on the line. The number entered represents the relative number of the data
item to be displayed. For example, the line command ZD 2 opens a data window
containing the second data item on the line.

When you enter a second ZD or ZH line command on the same statement, the existing
data window is replaced.

Data windows may be removed, individually or globally, from the program being viewed
(see "Removing Zoom Data Windows" on page 138).
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Viewing Group Data Items Inline

Use the ZG line command to open a data window in display format showing the levels,
value, and address of group data items and all of their subordinate data items.

Use the ZGH line command to open data windows in hexadecimal format showing the
levels, value, and address of group data items and all of their subordinate data items.

The result of a ZG or ZGH line command is a data window positioned where the
command was entered. When the screen is scrolled, the data window moves with the
display. If the data window cannot accommodate all the data items specified for it, you
can scroll through the data window.

When you enter the ZG or ZGH line command on a subscripted or indexed data item, the
occurrence number is shown to allow you to change the entry being displayed (see

Figure 86).

Figure 86  Relative Data Item in ZG

File View Test Search List Options Help

Program View VIAPPLI.VIAPPLI1 -A
Command ===> Scroll ===> CSR
000240 05 SOC7_DATA,
Bttt ettt +
triver |02 SOCT DATA DATA (16) ADDR 00142870 \
''rrrto| 03 DATA PACKED DEC DEC FIX (15,0)  ADDR 00142870 \
""" | VALUE > +123 < ‘
""" | 03 DATA DISPLAY DEC CHAR (8) ADDR 00142878 ‘
""" | VALUE > +0000000 < \
Trrin |03 50C4 SUB CHAR(8) ADDR 00142880 \
trrrer | VALUE > 40000000 < \
Trrrrto |03 S0C4 SUB MAX CHAR (8) ADDR 00142888 \
""" | VALUE > +0000000 < \
""" | 03 S0C4_CORE CHAR (80) ADDR 00142890 |
""" | DIMENSTION ( 1 ) \
trannr VALUE > ittt ittt ettt e e ettt et e e e e e e < |

As with ZD and ZH, you may use the n (number) operand to display one data item on a
line containing multiple data items. Data items are assigned relative numbers from left to
right on the line, and the number entered represents the relative number of the data item
to be displayed.

The data window contains the definition and value of the data item. Alphanumeric values
are shown in character format and numeric values are shown in decimal format with
leading zeroes suppressed. If the length of the data item is greater than fifty bytes,
additional lines are displayed with +50, +100, +150 and so on preceding them.

When you enter another ZG or ZGH line command on the same statement, the existing
data window is replaced.

A ZD or ZH command is executed when a ZG or ZGH line command is entered for a data
item with no subordinate data items.
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Viewing Data Values Where Declared

Use the ZOOMDATA, ZD, ZG, ZH, and ZHG primary commands to position the
Program View screen at the definition of a specified data item and open an inline data
window to display the data item. The ZD, ZG, ZH, and ZHG primary commands have the
same meaning as the corresponding line commands.

The result of any of these primary commands is a data window positioned at the DCL.
When the screen is scrolled, the data window moves with the display. If the data window
cannot accommodate all the data items specified for it, the data window becomes
scrollable.

The data window contains the definition and value of the data item. Alphanumeric values
are shown in character format and numeric values are shown in decimal format with
leading zeroes suppressed. If the length of the data item is greater than fifty bytes,
additional lines are displayed with +50, +100, +150 and so on preceding them.

Removing Zoom Data Windows

You may remove inline data windows from a program individually or globally.

Removing Individual Zoom Data Windows

Use the ZO or D line command to close a data window opened as a result of a ZOOM line
or primary command.

Removing All Zoom Data Windows

Use the RESET ZOOM primary command to close all data windows opened as a result of
a ZOOM line or primary command.

Viewing Data Values at the Top of the Screen
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To view data values at the top of the screen, follow this step:

P Select View P Keep, type KEEP, or use the K line command to open a data window
containing the value and address of data items in display format at the top of the screen.

Use the KH line or primary command to open a data window containing the value and
address of data items in hexadecimal format at the top of the screen.

Use the KG line or primary command to open a data window containing the levels, value,
and address of group data items in display format at the top of the screen. Use the KGH
line or primary command to open a data window containing the levels, value, and address
of group data items and all their subordinate data items in hexadecimal at the top of the
screen.
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The result of the Keep option; the Keep primary command; or K, KH, KG, or KGH line
command is a data window positioned at the top of Program View. When the screen is
scrolled, the data window remains at the top of the screen. If the data window cannot
accommodate all the data items specified for it, the data window becomes scrollable.

When you enter the K, KH, KG, or KGH command for an array data item, the dimensions
are shown to allow you to change the entry being displayed.

When entering the line commands, you may use the n (number) operand to display one
data item in a statement containing multiple data items. Data items are assigned relative
numbers from left to right on the line, and the number entered represents the relative
number of the data item to be displayed. For example, the line command K 2 opens a data
window containing the second data item on the line.

When you enter another keep command, the new data items are added at the end of the
existing data window. When you enter another K, KH, KG, or KGH line command for
the same statement, the information for those data items is added at the end of the data
window.

The data window contains the definition and value of the data item. Alphanumeric values
are shown in character format and numeric values are shown in decimal format with
leading zeroes suppressed. If the length of the data item is greater than fifty bytes,
additional lines are displayed with +50, +100, +150 and so on preceding them.

For example, the primary command KG COMPARISON_KEYS displays the levels,
values, and addresses of the data item COMPARISON KEYS and its subordinate data
items.

When no longer needed, the data window may be removed or individual data items may
be removed from the data window.

Removing Individual Data Items From a Data Window

Use the D line command to remove data items from the data window.

Removing the Data Window

Use View - Reset Request pop-up or the RESET KEEP primary command to close the
data window.
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Changing Test Session Data Values

SmartTest allows you to change data values during a test session to perform these
functions:

. Modify the results of calculations.

. Alter the execution path by changing the value of counters and/or switches.

. Test error handling code by forcing bad data.

. Correct the data exceptions that are encountered.

You may alter data values by typing over the value displayed in any data window. The

new values take effect immediately. The value(s) shown in the data window is always
current and changes as the program executes.

Program Execution History (Backtrack)

SmartTest provides the Backtrack Facility to allow you to step backward and forward
through the executed code and view data values as they existed when each statement was
executed. You may view the execution history using the Backtrack Facility any time
execution of the program is suspended.

The Backtrack Facility has two distinct modes—recording and reviewing.

Recording Execution History
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Enter the SET BACKTRACK primary command (abbreviated SET BA) to toggle the
Backtrack Recording mode ON or OFF.

The Backtrack Facility recording mode can be turned on or off whenever an active test
session is suspended—at entry to the program, a breakpoint, an address stop, or an ATTN
key. Toggling the Backtrack Recording mode OFF causes the recorded history to be
discarded.

When a test is canceled using the CANCEL command or reaches END OF TEST,
Backtrack Recording mode is automatically turned OFF and the Backtrack recorded
history is discarded. The Backtrack Recording facility is OFF by default when
SmartTest-PLI is entered.

The SET BACKTRACK primary command may also include the desired size of the
Backtrack Recording memory buffer where data is collected (e.g., SET BACKTRACK
2M for a 2 MB buffer). This buffer is in memory with a default size of 1 MB (100 KB for
CICS). The buffer size affects how much statement execution history is available to the
Backtrack Review facility.
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After setting Backtrack mode on, continue the active test using the normal RUN or STEP
primary commands. When the test execution is suspended by an error condition, a
breakpoint, an address stop, an ATTN key, or the end of the program, you can review the
Backtrack history as desired.

Note:
You cannot run NOMONITOR when the Backtrack mode is ON.

Reviewing Execution History

After turning Backtrack Recording Mode ON and executing the program until a
breakpoint is encountered, you can review Backtrack history using either of these two
methods:

. Enter the Backtrack Review mode using the Run or Step function. See "Example
Backtrack Review Session" on page 141 for more information.

. Use the LIST BACKTRACK primary command (abbreviated LI BA) to display
statements that modified a selected variable. See "Using the BackTrack Variable
History Function" on page 147 for more information.

In Backtrack Review mode, the Program View status box shows the direction—forward or
backward—of program execution history review. While in Backtrack Review mode, you
can open data windows (Zoom or Keep) to view the contents of data fields at the time of
execution of any statement.

Example Backtrack Review Session

Note:

Before executing this example, type RESET PSEUDO to ensure all breakpoints and
pseudo code statements are deleted.

In this example from the VIAPPLI program provided with SmartTest-PLI, assume that
the program being tested abends with a data exception (0C7) on the field

DATA PACKED DEC. Backtrack Recording mode is ON. As the starting point of your
investigation, you need to locate statements that have modified the value of

DATA PACKED DEC.
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To locate the most recent statement that modified DATA_PACKED DEC using
Backtrack execution history

1 Select Test » Run and press Enter. The Test - Run Request (Backtrack Recording
Mode Active) pop-up, shown in Figure 87, displays.

Figure 87 » Test - Run Request (Backtrack Recording Mode Active) Pop-up

Test - Run Request [Backtrack Reuview Hode Active)

Enter & Direction, if neaded, and fill in the appropriate "Run Ta"
aption. Then press Enter.

Direction [Default is current direction)
1. Forwvard
2. Backward

Run To ...
T, Bor#® . o . . _ Top, Bottod o current stHt-edit review
Lime Munber o . o ______
Hodified Data MaHe

The Test - Run Request pop-up has changed because Backtrack Recording mode is
active.

2 Enter BackTrack Review mode and initiate a search backward through BackTrack
execution history for the last statement that modified DATA PACKED DEC using
these steps:

a Select Backward in the Direction field.
b  Type DATA PACKED DEC in the Run to Data Name field and press Enter.

The BackTrack execution history on the Program View screen, shown in
Figure 88 on page 143, displays.
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The Program View screen is positioned to the most recent statement in this test
session that modified the field DATA_PACKED_ DEC, indicated by the tag
BKTR=>. This is also the statement that caused the 0C7 abend.

Figure 88 « Reviewing Backtrack History of a Modified Data Item

File View Test Search List Options Help
Program View VIAPPLI.VIAPPLI1 -A
Command ===> Scroll ===> CSR
(A) 481
BKTR=> DATA_PACKED DEC = DATA_ PACKED DEC + 1;
000483
000505  SOCTFIXI:
000506 RETURN;
000507
000508 END SOC7_DEMO;
000509
000510
000511 /* PAUSE HERE */
000512
000513 NOSOURCE_DEMO: PROC;
oo (B) —mmm (C)--+
| STATUS: * REVIEWING BACKTRACK HISTORY * PROGRAM: VIAPPLI1 DIRECTION: BWD |
| STMT: 000482 OFF: 000C10 AMODE: 24 MODULE: VIAPPLI SEQ# -2682 |
| SOURCE: DATA PACKED DEC = DATA PACKED DEC + 1; 101
e
Screen Section Description
(A) BKTR=> Points to the most recent statement that modified the data

field DATA PACKED DEC.

(B) * REVIEWING Indicates the test session is in Backtrack review mode.
BACKTRACK
HISTORY *

(C)BWD Indicates the direction of the Backtrack History review and
-2682 indicates the program review is 2682 statements
from the bottom of the Backtrack history.

Repeat step 1 and step 2 to find the next most recent statement that modified
DATA PACKED_DEC, a BASED variable.

As an option, you can type RUN BACK TO DATA PACKED DEC MOD in the
primary command area.
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4  To continue your investigation into the 0C7 abend, open a Zoom data window to
display the value of the data field before it was modified by typing ZD over the tag
BKTR=> in the line command area and pressing Enter. The Program View screen,
shown in Figure 89, displays.

Figure 89 « Data Value Before Execution of the Statement

File View Test Search List Options Help
Program View VIAPPLI.VIAPPLI1 -A

Command ===> Scroll ===> CSR
000479
BKTR=> SOC7 CHAR = ' ';

I R o "
trrrrr | s0C7_CHAR BASED CHAR(8) |
rrrrer VALUE > ........ < |
tvrrrr | 03 DATA_PACKED _DEC DEC FIX (15,0) |
rrrrer VALUE > +0 < |
LI +
000481
000482 DATA PACKED DEC = DATA PACKED DEC + 1;

[ RS o S, S e +
"'rUrto |03 DATA_PACKED_DEC DEC FIX (15,0) I
"rrrvro | VALUE > 40 < I
LI +
o +
ISTATUS: * REVIEWING BACKTRACK HISTORY * PROGRAM: VIAPPLI1 DIRECTION: BWD |
| STMT: 000480 OFF: 000C06 AMODE: 31 MODULE: VIAPPLI SEQ# -2 I
|SOURCE: SOC7_CHAR = ' '; 0]
o

Figure 89 shows an opened Zoom data window displaying the value of the data field
before it was modified by the assignment statement containing the BASED variable.

To view the results of the execution of the assignment statement

1 Select Test » Step and press Enter. The Test - Step Request (Backtrack Review
Mode) pop-up, shown in Figure 90, displays.

Figure 90 » Test - Step Request (Backtrack Review Mode Active) Pop-up

Test - Step Request [Backtrack Rewiew Hode]

gelect &tep type, Direction, or Step Options, as needed.
Then press Entar.

Ftep ...
1. to nedt STATEHENT [(Default]
2. to nedt Paragraph-<Label

—_

Direction [Default is current direction]
1. Forward
2. Backward

Step Options:
Etep Count _____ Enter 1 to 65535 [99% if AUto)
step AUto Enter non-blank to select

144



4 Testing Techniques

On the Test - Step Request (Backtrack Review Mode) pop-up, select Forward in the

Direction field and press Enter. The Program View screen, shown in Figure 91,

displays.
As an option, you can type STEP FORWARD in the primary command area.

Figure 91 « Data Value after Execution of the Statement

File View Test Search List Options Help

Program View VIAPPLI.VIAPPLI1 -A
Command ===> Scroll ===> CSR
000479
000480 SO0C7 CHAR = ' ';
Ve o S +
Trrvero | S0C7_CHAR BASED CHAR(8) I
vrrvrro | VALUE > < I
'''rrto| 03 DATA_PACKED_DEC DEC FIX (15,0) I
'rretvo | VALUE > < * INVALID NUMERIC * I
LT +
000481
BKTR=> DATA PACKED DEC = DATA PACKED DEC + 1;
LI R, o e S e +
'''rrro| 03 DATA_PACKED_DEC DEC FIX (15,0) I
trretvo | VALUE > < * INVALID NUMERIC * I
L +
R et it L e e +
|STATUS: * REVIEWING BACKTRACK HISTORY * PROGRAM: VIAPPLI1 DIRECTION: FWD I
| STMT: 000482 OFF: 000C10 AMODE: 31 MODULE: VIAPPLI SEQ# -1 I
| SOURCE: DATA_PACKED DEC = DATA_ PACKED DEC + 1; 101
o +

145



ASG-SmartTest PLI User’s Guide
Figure 92 displays the value of the data field in the Zoom data window after the
assignment statement containing the BASED variable was executed.
To end the Backtrack review mode and resume program execution
1 Select Test » Run to display the Test - Run Request pop-up.

2 Select Forward in the Direction field and specify * in the Run To field. As an option,
you can enter the command RUN TO *.

Figure 92 « Resuming Program Execution

File View Test Search List Options Help

Program View VIAPPLI.VIAPPLI1
Command ===> Scroll ===> CSR
ASG2429W BOTTOM OF BACKTRACK HISTORY. BACKTRACK REVIEW EXITED. (A)
001228
001229 FIND_NEXT_PARAMETER: PROC;
001230

001231 SUBl = SUB1 + 1;
001232 IF SUB1 > VALID PARMS COUNT THEN

001233 DO;

001234 IF VALID PARM TEXT (SUBl) = ' ' THEN

001235 DO;

<<<<<< CURRENT PARM NUMBER = VALID PARM NUMB (SUBI);

001237 DAT1 = ' DEMONSTRATION OF: '; N

001238 DAT2 = VALID PARM TEXT (SUBL);

001239 DISPLAY AREA LENGTH = 80;

001240 PUT SKIP EDIT (DAT1,DAT2) (A);

001246 SUB1 = VALID PARMS COUNT;

001247 END;

001248 END;

001249 END FIND NEXT PARAMETER;

e +
|STATUS: BREAK ON ENTRY TO A PROGRAM PROGRAM: IEFBR14 BACKTRACK: |
| STMT: N/A  OFF: 000000 AMODE: 24 MODULE: IEFBR14 (B) RECORDING |
|SOURCE: SR R15,R15 HEX: 1BFF

Screen Section Description

(A) ASG2429 BOTTOM OF The long message indicates Backtrack history

BACKTRACK review mode has ended.

(B) RECORDING Indicates the Backtrack facility is in recording
mode.

(C) Program View Positioned at the last statement executed before

Backtrack history was reviewed.
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3  To continue your test session, use the RUN or STEP command. A Program View
screen similar to the one shown in Figure 93 displays.

Figure 93 « Recording Backtrack History to End of Test Session

File View Test Search List Options Help

Program View TEST ENDED, RC=0
Command ===> Scroll ===> CSR
000344
>>>>>> RETURN; /* GOBACK TO OPERATING SYSTEM */
000346
000364 PROGRAM_ INIT: PROC;
000365

000366 /* DEFAULT TO EXECUTION FAILURE */

000367 /* BUG */

000368 /* CALL GET TIME OF DAY; */

000369 /* MOVE TIME OF DAY WORK TO TIME OF DAY START; */

000370

000371 RETURN_CODE = -1;

000372

000373 /* INITIALIZE WORKING STORAGE VALUES */
000374

000375 DATA PACKED_DEC = 0;
000376 DATA_DISPLAY DEC = 0;

o +
| STATUS: BREAK AT END OF TEST SESSION PROGRAM: VIAPPLI1 BACKTRACK: |
| STMT: 000345 OFF: 000386 AMODE: 31 MODULE: VIAPPLI RECORDING |
| SOURCE: RETURN; /* GOBACK TO OPERATING SYSTEM */ |

The program executes to completion and is suspended at the end of the test session.
At this point in the program, you can either review the Backtrack history or end the
test session.

4  Endthe test session and discard the Backtrack history by typing RUN in the command
input area and pressing Enter.

Using the BackTrack Variable History Function

To review BackTrack execution history using the LIST BACKTRACK primary
command

1 Type LIST BACKTRACK to display the List - BackTrack Variable History pop-up
shown in Figure 94.

Figure 94 « List - BackTrack Variable History Pop-up

List - BackTrack Uariable Histary
Tupe a fullw qualified data naWe with any applicable subscripts
in the Target area. For & list of data naWes, type a “pattern”
in the Target area. Then press Enter.

Target
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2  Enter a dataname to search the BackTrack execution history for statements that
modified the specified data item. You can enter a pattern to select from a list of

datanames.

3 Press Enter to display the List - BackTrack Variable History pop-up, shown in
Figure 95, displays showing the statements that modified the selected data item.

Figure 95 « List - Backtrack Variable History Screen

Li=t - BackTrack Lariable History UIAZUEIT.VIAZUEIT —-A

+

EOTTOH OF DATA

CoMHand === _ ECroll ===} CER
Uariablel COHPARIZON-CODE Desct PIC @
Index:
% RELHOD VALUE LINE  ETATEHENT COMTENTE
TOF OF DATA
UIAHRGIT.VIAHRGET
- -3 . BaaLs? HOUE ZEROE TO  COMPARISON-KEY-1, COHE
UIAZUEIT.VIASUEI?
- -2 8 BA0AIS HOUE 1 Td COHPARIZON-CODE
-11 DA0AIS HOUE 1 TQ COHPARIZON-CODE
L S <CURREMT VALUE OF VARIABLEX

ETATUED ETOPPED AFTER EREAK
ETHT. Dea@z3 OFFD 000254 AHODED 31

+

PROGRAH: VIAZUEI? EACKTRACK:
HODULE: UIAZUEIT RECORDING

S0URCESD IF INFILEA-COHPARIEON-KEY WOT EQUAL EOF-KEY

The List - BackTrack Variable History screen lists the statements that modified the
selected data item. You may view a statement in the program source by selecting the

statement and pressing Enter.

You can review other statements in BackTrack execution history by typing LIST

BACKTRACK and repeating step 1 on page 147 through step 3.

After completing your review of the selected statements, you may continue the test by
pressing PF3/PF15 on the List - BackTrack Variable History screen or by entering the

RUN TO * primary command on the Program View screen.
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Using Pseudo Code

SmartTest provides pseudo code to allow you to interactively modify a program during a
test session to test proposed changes without recompiling the program.

Pseudo Code Concepts

SmartTest-PLI provides COBOL-compatible statements called pseudo code. You can
enter these statements inline with existing PL/I source code. Inserted code can change the
execution sequence of the program or temporarily fix a data problem.

Enter pseudo code statements directly into the source code of a program displayed in
Program View. Each pseudo code statement is associated with the executable source
statement following it. Multiple pseudo code statements associated with an executable
source statement form a pseudo code block. Pseudo code statements follow standard
COBOL syntax rules.

The Pseudo Code List screen displays all pseudo code for the program currently in
Program View. Pseudo code remains active until deactivated or deleted (see “Viewing
Pseudo Code in a Test Session” on page 153 and “Removing Pseudo Code from a
Program” on page 153).

You can save pseudo code with any program stored on the AKR.

Note:
For setup options on automatically saving pseudo code, see "SmartTest User Options" on
page 16.
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Pseudo Code Statements Available
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These are the available pseudo code statements and operands:

ADD

Adds the value contained in or represented by the first operand to the
value contained in or represented by the second operand. The value is
converted to the proper format for the specified data item.

BREAK

Forces a breakpoint before a specific statement. A pseudo code
BREAK statement causes an unconditional interrupt in the program
execution.

GO TO

Transfers control to the statement containing the specified PL/I
procedure name, pseudo code label, or line number.

IF/THEN/ELSE

Tests conditional expressions. Nested IF statements are supported.
Supported condition tests include Relation, Class, and Sign.

MOVE

Assigns the value contained in or represented by the first operand to
the area represented by the second operand. The value is converted to
the proper format for the specified data item, if possible. If the value
cannot be converted to the proper format, program execution stops
and an error message displays.

SUBTRACT

Subtracts the value contained in or represented by the first operand
from the value contained in or represented by the second operand. The
value is converted to the proper format for the specified data item.

WHEN

Tests conditional expressions in the same manner as COBOL
conditional expressions. Use of the WHEN statement causes the test
to be performed after the execution of every instruction that modifies
data.

Note:
Processing WHEN statements is resource intensive. Use sparingly.

pslabel

Defines a pseudo code paragraph name. These names are entered in
Area A and are used by GO TO pseudo code statements. A pseudo
code label can consist of one to thirty alphanumeric characters, the
first being alphabetic. The specified name cannot be an existing label
name. Pseudo code labels cannot be defined in WHEN statements.
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77

Defines a pseudo code data item. These data items are entered in Area
A. Each 77 level dataname must be unique and cannot be qualified. 77
level data definitions can be entered anywhere within the code.
Pseudo code data items must be defined before being referenced and
cannot be defined in WHEN commands.

&COUNT

Indicates the number of times each pseudo code statement has been
executed. &COUNT is useful in tests for specifying alternative logic
based on its value. The value of &COUNT is automatically initialized
to zero and incremented before the corresponding verb is executed.
&COUNT can be referenced as required in any pseudo code
statement, but cannot be modified (e.g., MOVE 2 TO &COUNT is
invalid).

COBOL Reserved Words in Pseudo Code

Many standard COBOL reserved words can be used in pseudo code. These reserved
words are used in pseudo code statements in the same manner they are used in standard
COBOL programs. SmartTest supports these COBOL reserved words in pseudo code:

ALL ELSE PIC
ALPHABETIC EQUAL PICTURE
COMP FROM POSITIVE
COMP-1 GREATER SPACE
COMP-2 IS SPACES
COMP-3 LESS THAN
COMP-4 LOW-VALUE THEN
COMPUTATIONAL LOW-VALUES TO
COMPUTATIONAL-1 NEGATIVE USAGE
COMPUTATIONAL-2 NEXT SENTENCE ZERO
COMPUTATIONAL-3 NOT ZEROS
COMPUTATIONAL-4 NUMERIC ZEROES

These symbols can be used in conditional pseudo code statements:

equals
< less than
>

greater than
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Using PL/I Datanames in Pseudo Code

These statements apply when using PL/I datanames in pseudo code:

*  New datanames must be defined using a COBOL 77 statement using COBOL
syntax.

. PL/I datanames defined in the program can be used in pseudo code statements.

*  Non-unique elements of a PL/I structure can be coded using COBOL or PL/I
syntax. For example:

DCL 1 REC 1,

05 A CHAR (1) INIT ('A' );
DCL 1 REC 2,

05 A CHAR (1) INIT (" ');
MOVE A OF REC 1 TO A OF REC 2.
Or

MOVE REC_1.A to REC_2.A.

Using Constants in Pseudo Code

Pseudo code statements can contain numeric and non-numeric literals. If the data element
being tested is a character field (non-numeric), the second operand in the pseudo code
statement must be in quotes. For example:

IF OUT CNT 4 = '001' THEN BREAK.

If the data element being tested is a decimal field (numeric), then the second operand in a
pseudo code statement does not need to be in quotes or zero padded. For example:

IF OUT CNT 3 = 1 THEN BREAK.

Entering and Editing Pseudo Code
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You can enter pseudo code statements with existing PL/I source code on the Program
View screen. During a test session, pseudo code statements can be entered whenever
program execution is suspended. Pseudo code statements are written in standard COBOL
format.

The C (copy), D (delete), I (insert), M (move), and R (repeat) line commands are
available for entering and editing pseudo code statements in a program. These commands
operate in the same manner as in TSO/ISPF, including block format.
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Executing Pseudo Code in a Test Session

Pseudo code is executed as if it is part of the program logic when a RUN or STEP
command is issued.

Each pseudo code statement is associated with the source statement following it and is
executed before that statement. For example, at a breakpoint, execution is suspended and
the chevrons are positioned in the line number area of the next logic statement to be
executed. If a block of pseudo code is inserted immediately prior to this statement, the
RUN or STEP action starts executing with the first pseudo code statement in the inserted
block.

SmartTest checks syntax of pseudo code statements when a command is entered
referencing a pseudo code statement or variable and when saving the pseudo code to the
AKR. The SmartTest-PLI commands that reference pseudo code are RUN, STEP,
Z0OOM commands, LIST BREAKS, LIST PSEUDO, LIST WHENS, LPRINT PSEUDO,
and QUALIFY.

Pseudo code statements with correct syntax are executed as part of the program logic.
When a pseudo code statement causing a program execution error is encountered, the

current test is interrupted and an error message displays. Correct the pseudo code and
resume the test session.

Viewing Pseudo Code in a Test Session

To display the Pseudo Code List screen showing all pseudo code for the program
currently in Program View, follow this step:

» Select List » Pseudo code or type LIST PSEUDO.

You can activate and deactivate pseudo code statements individually or globally using the
Pseudo Code List screen.

Removing Pseudo Code from a Program

You can remove pseudo code from a program individually or globally.

Removing Individual Lines of Pseudo Code

Use the D line command to delete individual lines of pseudo code from a program. This
command operates in the same manner as the D (delete) line command in TSO/ISPF,
including block format.

Removing All Pseudo Code

To delete all pseudo code (including breakpoints) from a program, follow this step:
P Select View P Reset or type RESET PSEUDO.
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Making Proposed Changes Permanent

Pseudo code provides a means of testing proposed changes to the program without
recompiling. Permanent changes to the source code must be completed using the source
code editor at your site. SmartTest does allow split screen sessions under ISPF so you can
view pseudo code statements at the same time you are editing.

Note:

If you edit your program, you need to reanalyze the updated program so SmartTest-PLI
includes the changes in the next test session.

Using Multiple Programs
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SmartTest-PLI provides the ability to view programs other than the one being tested
without cancelling the active test. This process is called qualification.

To display a program (other than the program being tested) in Program View, follow this
step:

» Select File » Open or type QUALIFY.

Programs residing in the AKR are displayed in source code format. Programs not stored
on the AKR are displayed in disassembled object code. Several programs may be
qualified for viewing simultaneously.

The program currently being tested remains the active program. If a STEP, RUN, GO, or
CANCEL primary command is issued, it is executed for the active program being tested,
not the program being viewed; and the status box changes to indicate the status of the
active program being tested. All other commands are performed on the displayed
program.

The QUALIFY * primary command is used to redisplay the active program.

The CANCEL operand is used to remove the program being viewed from qualification
for viewing.

These are some examples of the QUALIFY primary command:

QUALIFY loadmod.program Brings a program from a different load module
into Program View.

QUALIFY CANCEL ALL Removes all programs from qualification and
exits Program View.
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Tailoring a Test Session by Program

The Test Session Tailoring screen is used to turn SmartTest features selectively ON or
OFF for a set of modules and/or programs. This screen displays using one of these
methods:

. Selecting TAILOR on the Test Facilities List screen

. Entering the LIST TAILOR command on any SmartTest screen

. Selecting List P Test session tailoring

Session tailoring can reduce the execution time for a test by specifying options at the

individual program level. For example, you can set Break on Entry as NO for programs
that have already been verified, to avoid stopping at the entry point.

An example input line is provided on the first data line displayed, to indicate how to
specify information for a program. The I (insert), R (repeat), and D (delete) line
commands can be used when editing the list of programs. Block forms of these
commands are not supported.

For details of the Test Session Tailoring screen shown in Figure 96, see the
ASG-SmartTest Reference Guide.

Figure 96 = Example Test Session Tailoring Screen

Test Zession Tailoring VIAPPLI.UIAPPLI1 -A
CoHHand ===k Ecroll ===} CIR
Honi tor Track Count Break Break Break Pseudo 3ingle
Hodule.Prograd id ACt ACt ACt Act Entry Rtn ACt Etep
etk TOF OF DATA
' UIAPPLI.VIAPPLIL YES ¥YEE YEE YEE YEE MO YES YES
' VIAPPLZ.VIAPPLZL YEZ TES HO YEF YE: HO YEZ TES
ettt EOTTOH OF DATH

Note:

For PL/I programs, the program name specified on the Test Session Tailoring screen
must be the PL/I compiler generated name.

Capturing and Replaying Test Sessions

SmartTest provides a Script facility for the capture and replay of primary command
sequences. The captured commands are saved in a file that may be replayed to execute
the recorded primary commands multiple times. Script files can be used to initialize a
session, set default data values, insert breakpoints, open data windows, or perform other
tasks that can be accomplished using primary commands.
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SmartTest assigns a dataname for the script dataset and displays it in the long message
area when the SET SCRIPT ON primary command is issued. The Script facility allocates
and opens a dataset to record all SmartTest primary commands as they are entered. To
stop recording the primary commands and close the script file, issue the SET SCRIPT
OFF primary command. Record the generated dataset name for specification when the
script file playback is requested.

Script files are sequential datasets or members of partitioned datasets. Script files can be
used to initialize a session, set default values, set up a session, execute or re-execute a
session, or execute a predefined command sequence. The name of the dataset displays
when the dataset is opened or closed. The script file name is in this format:

USERID.STTnnnnn . VIASCRIP

where nnnnn is a number beginning with 00001 that is incremented by 1 for each new
script file. Once the dataset is closed, it can be used as an input dataset name with the
EXECUTE command.

Note:

If a TSO prefix is not set to the user ID, the prefix is added to the beginning of the dataset
name.

You can include comments in script files by typing an asterisk (*) in the first column of
the command by the comment text.

Note:
Actions executed using CUA and line commands are not recorded in the script file.

For information on the Script related primary commands, see the ASG-SmartTest
Reference Guide.

Replaying a Script File
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Use the Execute facility to replay a primary command sequence stored in a script file.

The Execute facility reads and executes a script file. Each script file can contain
EXECUTE commands that execute nested script files. Script files creating loops are
recognized and an error message displays.
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To execute a script file

1 Select File » Execute and press Enter. The File - Execute Script pop-up, shown in
Figure 97, displays.

Figure 97  File - Execute Script Pop-up

File - EWecute script
To edecute & script file, type a Data 2ot MaWe, 3 Data set Mawe with a
HeHnbet nade, or just a nedber nane in parentheses. Hedt specify any
desired Options. Then press Enter.

Data Zet MNane

options
_ 1. ETEP
2. REZUHE

2 Enter the name of the script file in the Data Set Name field and press Enter.

Note:

Select the STEP option to invoke the debug option that allows stepping through each
primary command in the script file. Each primary command in the script file displays in
the primary command input area. The displayed primary command can be changed or
erased from the primary command input area. Press Enter to execute the displayed
primary command. Processing of the script file continues in this manner until all primary
commands have been displayed and/or executed.

While stepping through the script file, select the RESUME option to execute the
remaining script file primary commands without stepping through each primary
command.

For more information on the Execute facility or the EXECUTE primary command, see
the ASG-SmartTest Reference Guide.

Position the Display at the Next Executable Statement

Use the LOCATE * primary command during a test session to position the display at the
next statement to be executed. The next executable statement is denoted by the chevrons
(>>>>>>),

During a test session, chevrons are placed in the line number area of the Program View
screen to indicate the next statement to be executed. If the display has been scrolled and
the chevrons are not visible, the LOCATE * command positions the display to the
statement containing the chevrons.
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This command may only be used from the Program View screen during an active test
session.

This command can be abbreviated as L *.

Saving Keystrokes

SmartTest provides several ways to reduce the number of keystrokes needed to enter
commands.

Token/Cursor Substitution

When entering commands, use the Cursor Substitution character while in the Program
View screen to bypass typing datanames and label names as command targets.

Search commands allow you to type the Cursor Substitution character (default %) in
place of a dataname or label name. After entering the command with the Cursor
Substitution character, place the cursor on the name in the source to be used as the target.
When the command is processed, the substitution character is replaced with the name
from the cursor location.

For example, the primary command FX % finds the statements that contain the text
located at the current cursor position. Place the cursor on the item before pressing Enter.

You may substitute multiple tokens (e.g., qualified datanames such as MYDATA OR
MYSTRUCTURE) by specifying multiple cursor substitution characters, each separated
by a blank. When substituting multiple tokens, the tokens must be contiguous in the
source code.

Substituting Short Names for Character Strings
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Use the EQUATE primary command to define a substitute name for any character string.

Equated names are used in the same manner any dataname is used. They can be saved in
the AKR and may be viewed on the Equates List by issuing the LIST EQUATES primary
command.

To delete an equate, type EQUATE using the equate name without any other operands.
This command may be abbreviated as EQ.

For example, the primary command EQUATE FILES HOW_MANY FILES READ
assigns a substitution short name (FILES) to a long field name
(HOW_MANY_FILES READ). The primary command FX FILES searches for
occurrences of HOW_MANY FILES READ.
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Retain Commands in the Command Input Area

Use the & (Retain) primary command in conjunction with any other primary command to
reuse the command specified.

The & command is useful when the same primary command is to be executed repeatedly,
or if minor changes to a command are desired. It removes the necessity of re-entering the
entire command.

For example, the primary command & FX END FILE COUNT executes a FINDXTND
command targeting field references and leaves the command displayed in the command
input area. You can type over the dataname field name to execute the FINDXTND
command for another field.

Recall Commands, Messages, and Pop-ups

Use the RECALL primary command to display previous primary commands, long
messages, or pop-ups. The PF12/PF24 keys are assigned by default for the RECALL
command.

The last 20 primary commands and the last 20 long messages are stacked in a recall
buffer and may be displayed using the RECALL primary command. When the command
or pop-up displays, it may be executed again with or without modification.

Use the MESSAGE operand to display previous messages. The NEXT operand can be
used to move forward rather than backward through the stack.

Once the RECALL command has been entered with operands, subsequent RECALL
commands with no operand use the last operand entered until a different operand is
specified or another command is executed.

When the RECALL function has processed the entire command or message stack, further
RECALL commands process the stack again.

For example, the primary command RECALL MSG displays the last message in the long

message area. The primary command RECALL POPUP displays the last pop-up
displayed.
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These commands are not stacked for use by the RECALL command:

ANALYZE RIGHT
RECALL PLOG
PLIST KEYS
UPDATE RETURN
REDO REPEAT
PRODLVL DOWN
RSCROLL RFIND
RHIGH RESET
LEFT END
HELP UP

View Release and Level Numbers

Use the PRODLVL primary command to display the current SmartTest product level.

The PRODLVL command displays the product name, operating system, product release
number, and release level on the message line, in this format:

ASG1554T ASG-SMARTTEST-0S(390) Rn.n AT Lnnn, ASG-CENTER Rn.n AT Lnnn
where:

Rn . nis the release number.

Lnnn is the release level.

This information is requested if you need to contact the ASG Service Desk for assistance.

Linking to Alliance
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If Alliance is installed, SmartTest provides a dynamic link to it that can be used to display
program analysis information. SmartTest automatically runs script queries appropriate for
the current execution environment upon entry to Alliance.
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Prior to establishing the link, a complete Alliance application analyze must be done for
the program you wish to process in Alliance. The Alliance application analyze must
include the load module libraries and execution JCL. Also, you must copy the
VIAPALSC and VIAPQ* members from the ESW CNTL library into a user-defined PDS
and appropriately customize them for your needs.

To link with Alliance

1 Select Script file allocations from the Options menu on the SmartTest primary
screen, as shown in Figure 98.

Figure 98 » Selecting the Script File Allocation Menu Item

File Uiew Test =earch Logic List Options Help

ASE-3Hart « Product paraneters...

. Product allecations...

. Log-list-punch...

. BCRipt file allocations...
. PF kewsz...

. Hodes...

. fcratchpada..

CoHHand ===

i A I

etttk etttk Eas s LD Ak
Aottt Aottt Hebetebbt bbbk Hebek

Copuright Allen Systens Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Vizit the AE Support Web Site at wuw.asg.coH

The Options - Script File Allocations pop-up displays.

2 On the Options - Script File Allocations pop-up, enter the name of the user-defined
PDS containing the VIAPALSC and VIAPQ* members. The Options - Script File
Allocations pop-up, shown in Figure 99, displays.

Figure 99 » Options - Script File Allocations Pop-up

Options - fcript File Allocations
ConMand ===k

R - Restore default Ecript allocations
Enter desired Zcript file concatenation.

2cript file data =et nades:
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3  Exit to the SmartTest primary screen. On the command line, issue the ALLIANCE
command. The ASG-SmartTest/ASG-Alliance Interface pop-up, shown in

Figure 100, displays.

Figure 100 « SmartTest/Alliance Interface Pop-up

AEG-EHartTest-ASG-ALli ance Interface
CoHHand ===k

Pleaze enter the following =

ALliance AKR.... « . gASG-FHartTest-AZG-Alliance Interface.
Application Mane . .

Prograd Name .......

guary HaHe.saeas UIAPQIHE

4  Complete these fields:

Alliance AKR  Specifies the AKR containing the analysis information produced
by Alliance for the specified application and program.

Application Specifies the name of the application containing the program to be
Name processed in Alliance.

Program Name Specifies the name of the program to be processed in Alliance.

Query Name Specifies the name of the query script that SmartTest selected
from the PDS specified in the Options Script File Allocations
pop-up. This field automatically contains with the name of a query
script appropriate for the current environment; however, you can
specify another.

5  Press Enter, verify the information, and press Enter again. The VIAPALSC script
executes and runs the query listed in the SmartTest/Alliance Interface screen. A
series of screens flashes by, ending with an Alliance query display appropriate for
the load module, JCL, transactions, and current SmartTest execution environment.

6  Type END on the command line to exit the query display. The Alliance primary

screen displays. Press PF3/PF15 to exit the Alliance primary screen and redisplay the
SmartTest primary screen.
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This chapter discusses analysis features of SmartTest-PLI and contains these sections:

Topic Page

The Intelligent Search Function 163
Excluding Lines from the Display 166
Searching for PL/I Program Information 167
Printing Program Information 171

The Intelligent Search Function

The SmartTest-PLI Intelligent Search Function uses built-in understanding of the PL/I
language. This function can be used to search the program for information about PL/I
statements, data variables, labels, and other program details. The search function
recognizes and bypasses COMMENT statements, unless specifically requested.

There are six primary commands in the Intelligent Search Function: BREAK,
EXCLUDE, FINDXTND, HIGH, LPRINT, and SCROLL.

Searching for PL/I Language Subsets

SmartTest-PLI classifies statements into subsets by grouping together PL/I statements of
a similar nature. This table describes each of the PL/I subsets and corresponding entities:

Subset Description

Assignment Contains statements that assign a value to a data item, such as
A=B.
BLOcks Contains PROCEDURE, BEGIN block, and END statements.
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CAll Contains statements related to subprogram calls such as CALL and
FETCH.

CONditional Contains statements or parts of statements that conditionally
change the flow of control in a program such as IF, THEN, ELSE,
and SELECT/WHEN.

DEFinition Contains declaratives of data variables.

ENDProcedure Contains statements containing an END PROC name.

ENtry Contains internal entry points (PROCs) and all ENTRY statements
for external entry points.

EXEcutable Contains statements that are executable.

EXIt Contains statements containing a RETURN that returns control to
the calling PROC.

GOto Contains statements containing a GOTO statement or a
SELECT/WHEN structure.

INPUT Contains IO statements (IO, Input, or Output) including CALL

10 statements that are indicated as containing 10, Input, or Output.

Output

LABel Contains statements containing labels.

ONBIlock Contains BEGIN block statements that are executed when an ON
condition is raised.

ONConditions Contains statements establishing ON conditions error handling.

PROcedure Contains PROC statements.

STORage Contains statements controlling program storage allocation.

STructure Contains a group of subsets, which together help show the general
structure of the program.

TESted Identifies the lines of code that have been tested based on
information created and updated with TCA reports.

UNTested Identifies the lines of code that have not been tested based on

information created and updated with TCA reports.
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Many SmartTest-PLI commands can include one or more of these subsets. You can
concatenate subsets by placing a plus sign (+) between them. For example, to highlight
the subset of lines containing IO and PROC statements, type HIGH IO + PRO.

Screen Subsets

Tag Subset

These screen subsets generally are the result of an interactive command:
. Highlighted or HI

. NONHighlighted or NHI

. Excluded or X

. NONExcluded or NX

SmartTest-PLI uses a tag subset to provide information about the source code. The tag
subset displays in columns 73 through 80 on the Program View screen and shows results
of the program analyze as well as command execution.

TAGged or TAGS refers to all lines having informative tags on them. The tag subset can
be used in commands that accept subsets as targets.

When a subset is specified as the target of these commands, the entire program is
searched for all occurrences of statements associated with the subset. All information
pertaining to a function can be presented with a single command.

Determining Impact of Change

Using the SIZE operand with the search function locates all datanames directly or
indirectly affected by a change in the size of the specified dataname. This results in a
complete list of all data items to be reviewed for a size change of the specified dataname.
By including the LEVELS operand, the indirect impact of a size change to a dataname
can be seen one level at a time.

Using the VALUE operand with the search function locates all occurrences of a dataname
directly or indirectly affected by a change in the value of the specified dataname.

The search function can be limited through the use of command operands.

These operands limit the search function to include only these specified data item access
types: MOD, USE, and DEF. The default is REF and includes all dataname reference

types.
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The search function may be limited by using the direction operands NEXT and PREV to
start the search from the current position and locate the closest occurrence. The FIRST
and LAST operands present their respective reference to the dataname specified. ALL is
the search function default, with the exception of the BREAK command, where NEXT is
the default.

The scope of the search function can be limited to particular statement types through the
use of the IN clause.

Excluding Lines from the Display

To display only relevant information on the screen, you can remove extraneous
statements. You can use the search function to suppress the display of statements meeting
specified criteria or all lines in Program View.

To invoke the search function to remove all lines meeting the criteria from the display,
follow this step:

» Select Test » Exclude or type EXCLUDE.

Use the Exclude action to remove specific lines or all lines from the screen. Lines can be
excluded from the display before or after other commands are issued. Excluded lines are
represented by shadow lines stating n LINE (S) NOT DISPLAYED and a line of
dashes. You can suppress the dashed line using the SET SHADOW command. For
example, typing EXCLUDE NHI or X NHI removes all non-highlighted lines from
Program View.

Displaying Individual Excluded Lines

Use the F (First), H (Hidden), L (Last), and S (Show) line commands to display excluded
lines.

The F and S line commands are used to display a specified number of lines in a block of
excluded lines, starting from the top of the block. The H or L line command is used to
display the last lines of a block of excluded lines.

For example, the line command F2 displays the first two lines of an excluded block. The
line command L5 displays the last five lines of an excluded block.

Displaying All Excluded Lines
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Select Excluded lines on the View - Reset Request pop-up or use the RESET
EXCLUDED primary command to display all excluded lines without resetting any
current highlighting and tags.
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To display all excluded lines

1 Select View P Reset and press Enter. The View - Reset Request pop-up, shown in
Figure 101, displays.

Figure 101 » View - Reset Request Pop-up

View - Reset Request
To reset dizplay features, select an Option. Then press Enter.

Reset Options

ALl [Excluded lines, Highlighted lines, Tags, Hessages)
All Lines=

Excluded Lines

Highlighted Lines

Tag CoHHents

Hez=sages

Label=z

Keep Windows

ZooH Mindows

Pseudo Code [Including Breaks and Whens)
Ereaks

Whens

| T T R O T B N B |

2  Type / on the Excluded lines field and press Enter.

Searching for PL/l Program Information

The Intelligent Search function is used to locate statements that meet specified criteria.
This function can be used to display and highlight specific program information,
datanames, sets of lines, or patterns.

Use the Search pop-ups or the FINDXTND primary command to perform the search
function. Statements that meet the criteria are displayed and highlighted.

This function searches the program in source code sequence for occurrences of the
specified target. A target is the object of a search and can be a set of lines, a dataname, or
a pattern. Several target types and operands are available.

Use of a FINDXTND command results in all lines containing the specified target being
highlighted with the cursor positioned on the first target. If lines containing targets are
excluded from the screen, they are redisplayed. Targets highlighted as a result of a
previous command are reset, so only the results of the current FINDXTND command are
highlighted.

The FINDXTND primary command may be abbreviated as FINDX or FX.
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Take care when examining PL/I storage, as usage is controlled by the programmer.
SmartTest-PLI is unable to determine usage of a data item and can only display the
contents based on the initial declaration. For example, a character string can be treated as
a group of bit switches, but SmartTest-PLI attempts to treat the field as displayable
characters. To display the hex equivalent, use the hex features within SmartTest.

Pointer variables and offset variables, which are types of locator data, contain an address
of a storage location or an offset from an address. SmartTest displays both the actual
address contained in the locator and the contents of the field at that address.

PL/I classifies variables as internal or external. The scope of the variable is determined by
this classification; therefore, SmartTest-PLI indicates that a variable is not available if the
test execution location is outside the scope of the variable.

Finding All 10 Statements in a Program
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This example demonstrates how to display only those statements in the program
containing Input and Output statements. The program must be displayed in Program
View.

To display only statements containing Input and Output statements

1 Omit all lines not in the search using the SET XMODE ON command.

Note:
XMODE is a toggle and remains on until set to OFF.

2 Select Search P Subset and press Enter. The Search - Subset Name pop-up, shown in
Figure 102, displays.

Figure 102 « Search - Subset Name Pop-up

Fearch - fubset Mare

Type a szubset nane and select zearch options. Then press Enter.
For- a selection list, twpe a pattern [e.q. RECGE] in the nane area.

Fubset nane

Direction |:||:I1.'i ans ACtion
1 1. Al _ IN-Clause... 1 1. Find
Z. Heut Z. Highlight
3. Preuious 3. Zcroll
4. First 4. Print
£, Last £, Punch
6. Exclude
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Complete these fields:

a Type I0 in the Subset name field.

b Select All in the Direction field.

¢ Leave the Options field blank.

d Select Find in the Action field.

Press Enter to display the Program View screen shown in Figure 103.

Figure 103 « Program View with Input and OQutput Search Results

File Uiew Test

Zearch List Options Help

CoHAand ===

HEEd e
A0a4dy? ok
ARadvE ok
DL )
HEadZa
aaadsl
Haads2
HEadET
aaadsd
LR R
A0adSE
LLIL T
HEadEE

+

Frograd LView 13 STATEHENWTS FOUND
Ecroll ===% CER

EUT 2KI
BUG .
PUT 3KI

P EDIT(* '] [A)X
P EDIT(DIZPLAY_AREA] [R]} #-

FUT ZKIP EDIT' '] [A]:
FUT ZKIP EDIT(' '] [A]:
PUT ZKIP EDIT(' ') [A);
FUT ZKIF
EDITI' UIA-SHARTTEST PL<I DEMOMSTRATIOM COMPLETED'1 (A1}
PUT ZKIPF EDIT(' ') [A);
FUT ZKIP
EDITI" THRME YOU FOR YOUR PARTICIPATION'] (A1}
FUT ZKIP EDIT[' '] [R]:

aaads®  END ZURHARY_ROUTIMEZ

STATUED = REUIENING BACKTRACK HIETORY *  PROGRAAMZ VIAPPLI1 DIRECTION: ENMD
ETHT: @dides OFF: @03172 AHODE: 31 HODWLE: UIAPPLI SECH -1

ZOURCES BAZED_VAR = 'ZAC4" 7 |1

+

To display the excluded lines

1

Select View P Reset and press Enter. The View - Reset Request pop-up, shown in
Figure 104, displays.

Figure 104 « View - Reset Request Pop-up

Reset Option

ALl Lines
Excluded

|

Tag CoHHe
Hez=sages
Labels=

Keep Wind
200K Wind

Ereaks
Whens

To reset display features, select an Option. Then press Enter.

=

ALl [EHcluded lines, Highlighted lines, Tags, Hessages)

Lines

Highlighted Lines

nts

oM
oMz

Pseudo Code [Including Breaks and Whens)

View - Reset Request
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2  Type / in the Excluded Lines field and press Enter (see Figure 105).

Figure 105 » Program View Screen after Displaying All Excluded Lines

File View Test Search List Options Help
Program View VIAPPLI.VIAPPLI1 -A
Command ===> Scroll ===> CSR
>>>>>> CALL PROGRAM INIT;
000298
000314 CALL PARM EDIT; /* INITIAL PARM EDIT */
000315
000316 IF PARM TEXT = 'EXIT' THEN
000317 RETURN;
000318 ELSE
000319 IF PARM TEXT = 'INVALID' THEN
000320 DO;
000321 CALL INVALID_ PARM;
000322 RETURN;
000323 END;
000324
000325 IF CURRENT_PARM NUMBER = +0 THEN
000326 CALL INVALID PARM;
000327
o +
|STATUS: BREAK AT START OF TEST SESSION PROGRAM: VIAPPLI1 DATE: DDMMMYYYY |
| STMT: 000297 OFF: 00029E AMODE: 31 MODULE: VIAPPLI  TIME: HH:MM:SS |
|SOURCE: CALL PROGRAM_INIT; \
o

All lines that were excluded by the targeted search are displayed.

Example of Finding Data Field References

This example demonstrates how to display, tag, and highlight all program references to a
data field. The program must be in Program View. XMODE is assumed to be ON.

To find data field references

1 Select Search P Data and press Enter. The Search - Data Name pop-up, shown in
Figure 106, displays.

Figure 106 * Search - Data Name Pop-up

fearch — Data NawWe

Twpe 4 data nane and select search options. Then press Enter. For
a selection 1ist, enter a pattern [E.g. REC] in the nane area.

Data nawe

References Indirect iHmpact Zize change

1 1. All 1 1. HNone levels o o o ___
2. Defs 2. 0Of size change
3. Uzes 3. 0Of wvalue change
d. Hods

Oirectiaon options Action

1 1. A1l _ Mo odata aliasing 1 1. Find
2. Hext _ IN-clausze... 2. Highlight
3. Preuvious 3. Ecroll
4. First 4. Print
5. Last 5. Punch

B.  EHClude
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2 Complete these fields:
a  Type DATA PACKED DEC in the Data name field.
b  Select All in the References field. This value is required.

c Select All in the Direction field.

Note:

The Indirect impact, Size change, Options, and Action fields are applicable for
COBOL environments. Specifying values in these fields can result in an error.

3 Press Enter to display the Program View screen shown in Figure 107.

Figure 107 » Program View with Data Item Information Search Result

File Uiew Test 3Zearch List O0ptions Help

Prograd Ui ew UIAPPLI.UIAPPLIL -A
ConHand === Ecroll ===F CER
TIIIP' IZIF DHTH

- - - - - - - - - - - 276 LINES NOT DIZPLAYED
OORZTT 1E| EHTH PFII:KEI:I DEI: FI:-:EI:I DEC [15] IMIT[123],
--- - - - - - - 22 LINEZ NOT DIZFLAYED
ggazga  OCL 1 SEII:?_I:HHR EHHR[S] BHSED[HDDR[DHTH PACKED_DEC]];
--- - - - - - - - == === - 126 LIMEZ MOT DIZPLAYED
O0Ed27 DHTH_PHCKED_DEC = El;
--- - - - - - - - = = - 1i& LINEZ NOT DIZFLAYED
LT DHTFI PFICKED DEC = DHTFI PHCKED DEC + 1,
-==- - - - - & LIMEZ HOT DIEPLAYED
O0R5d7 * 1] I:lUERT'rPE THE UHLI.IE I:lF DHTH PHCKED DEC* IM THE ZOOHDAT R
--- - - - - - 2 LINES NOT DISPLHTED
OORSSE #* 'ZET DATA_FACKED_DEC TO @. FRUN'
=== = = = = = = = = = = = = = = = = iF LINEZ MOT DISPLHTED
+ |
ETATUE: PROTECTION EWCEPTION [acd) FPROGRAHI UIAPFLI1L DATEX &40CT 2006

ETAT: a0ld9s OFFC @0317& AHODES 31 HODULE: VWIAPPLI TIHE: 18223155
S0OURCE: BRZED_VAR = "E0Cd' 3 |1
+ i

Printing Program Information

To print program information, follow this step:

» Select Print on any appropriate Search pop-up or type LPRINT to invoke the search
function to copy one or all occurrences of the specified target to the List File.

The List File can be printed at any time using the Option - Log/List/Punch Definition
pop-up. For information on how to process the List File, see "SmartTest User Options" on

page 16.

A printed copy of program information can be obtained by using the search function to
copy program source lines, meeting specified criteria, to the List File.
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For example, the primary command LPRINT COND copies all conditional statements in
the program to the List File for subsequent printing. The primary command LPRINT *
results in the entire virtual screen (all data viewed by scrolling forward and backward)
being copied to the List File. All excluded lines are copied to the List file as excluded
lines (as they appear on the screen at the time the LPRINT * command is entered).

You can use the LPRINT * command on these screens to copy them to the List file:

BackTrack Variable History Screen List - Equates pop-up

Breakpoints List screen List - Program/Subprogram Names pop-up
Execution Counts screen List - User Marks pop-up

Execution Tracking screen Pseudo Code List screen

List - CALL Statements pop-up When Conditions List screen

Scrolling the Display
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The search function can be used to position the display to a statement meeting specified
criteria.

Select Scroll on any appropriate Search pop-up or use the SCROLL command to invoke
the search function to position the display to the first line containing the specified target.
Highlighted lines remain unchanged.

The most common use of the SCROLL command is to move the display to the next
occurrence of information already highlighted by a previous command.

For example, the primary command SC HI NEXT scrolls the display to the next
occurrence of information already displayed by the FINDXTND command.



Additional Languages

SmartTest-PLI and Assembler

The SmartTest-ASM option is designed to alleviate the burden of testing and debugging
Assembler Language Code programs by providing an online, interactive testing
environment with powerful features suited to the needs of assembler programmers. The
assembler component is fully integrated with SmartTest-PLI. All testing and debugging
functions are available with assembler including: Program View, execution control,
breakpoints, monitoring and changing data, and abend processing. The only difference
between using SmartTest-PLI and SmartTest-ASM is some limitation in certain analysis
and debugging facilities.

SmartTest-ASM enables you to work with the source level display of your Assembler
programs in Program View. When a lower level of detail is necessary, SmartTest allows
viewing and manipulation of memory, input data, and the general purpose and floating
point registers.

See the ASG-SmartTest for COBOL and Assembler User’s Guide for more information
about Assembler.

SmartTest-PLI and COBOL

SmartTest for COBOL is a full-featured, source-level testing tool for COBOL programs.
For coverage of the testing and debugging features and additional information on

SmartTest support for COBOL, see the ASG-SmartTest for COBOL and Assembler
User’s Guide.
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Help Facility

This chapter discusses the types of help available with SmartTest-PLI and contains these

sections:
Introduction 175
Screen Help 177
Command Help 178
General Information 180
Specific Information 180
Help Abends 181
Help Messages 182
Printing Messages 184
Introduction

A comprehensive and context-sensitive Help facility, including an online Help Tutorial,
is provided that answers most questions online. The Help Tutorial contains help
information for several types of topics, such as pull-downs, screens, pop-ups, commands,
messages, and abends. The Help Tutorial also includes a Table of Contents that describes
each major SmartTest function, and a comprehensive Index for viewing specific
information.
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You can access the SmartTest online help facility using any of the methods described in

this table:

Screen and pop-up help Help for the current screen is requested by selecting

Help P Current screen. Help for the current screen or pop-up
displays by typing HELP, or by pressing PF1/PF13. No
message can appear on the screen at the time this help is
requested.

Command help

Help for a command is requested by selecting Help » Specific
command, or by typing the command in the command input
area and pressing PF1/PF13. The HELP COMMANDS
command displays a long message that lists most of the
primary commands. Once this message displays, pressing
PF1/PF13 displays a complete list of all SmartTest commands.
This list of commands can also be accessed by selecting

Help » All commands. From the list of commands,
information about a particular command can be displayed by
selecting the appropriate number.

General information

General help information is requested by selecting

Help » Table of contents, or typing TOC on any Help Tutorial
screen, to display the Help Table of Contents. Help
information can be viewed by pressing Enter or by selecting a
menu option.

Specific information

Help for specific topics is requested by selecting Help » Index,
selecting option 7 on the Help Table of Contents, or typing
INDEX from within the Help Tutorial. Help for a specific topic
can be viewed by selecting the appropriate index entry.

System, ASG, and IMS
Abends

Help for abends is requested by selecting Help » Common
abends, or by typing HELP ABENDS. The Abends help screen
displays, which lists and describes the abends. Select one of
these options, depending on the type of abend:

1 displays the System Abends screen.
2 displays the ASG Abend Codes screen.
3,4,5 displays an IMS Abends screen.

Messages

Help for a current message displays by selecting

Help P Current message. Help for a short message, displayed
in the upper right corner of the screen, is requested by typing
HELP, or by pressing PF1/PF13. The corresponding long
message displays at the bottom of the screen. Help for a
specific message can be displayed by selecting Help » Specific
message, or by typing HELP msg#.
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Help Navigational Commands

All of the online help topics listed in the previous table are contained in the Help Tutorial.
Each online help topic can be reached from anywhere within the Help Tutorial by going
through the Help Table of Contents or Index. Once the Help Tutorial is accessed, there
are several commands available for navigating within the Help Tutorial. These
commands are listed in this table.

Help Command Purpose

BACK Redisplays the previous Help Tutorial screen.

END Exits the Help Tutorial.

Enter key Displays the next screen in a continuation series.

INDEX Displays the first screen of the Help Index.

SKIP Goes directly to the next subject.

TOC Displays the Help Table of Contents.

UP Displays the next higher-level subject.

Alpha character Displays the Index screen corresponding to that character

(valid only for index screens).

Screen Help

Help for the current screen is requested by selecting Help » Current screen. Help for the
current screen or pop-up displays by typing HELP, or by pressing PF1/PF13. If any
messages appear, help for the screen or pop-up displays by typing HELP SCREEN. The
Help Tutorial for the current screen displays.

The Help Tutorial for each screen or pop-up describes all the options available on that
screen, lists descriptions of all the fields, and notes any special processing considerations.
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Figure 108 shows the Help Tutorial for the Options - Product Allocations pop-up.

Figure 108 « Pop-up Help Example

AZG-%tRartTest - RE.0 - Options = Product Allocations —---———-—====——-—- HELFP

The dptions - Praduct Allocations pap-up i= used to specify the allocation
paraneters for the Log, List, Punch, and Work files. To access this pop-up
froH the Options pull-down, select Allocation, or enter the ALLOCDEF comAand
on any SCreen.

Hote: Hanagewent Class, Storage Class, and Data Class provide various
paraneters for newly allocated data sets. These paraneters apply only if wau
hauve =HE active at vour site. Your systed adWinistrator deterHines the valid
entries for these paraneters.

The &torage Class and Uolude serial paradeters are Hutually edclusive.

Field Dezcriptions

Log File Epecify either the Hanagewent Class and Storage Class ar the
Gemeric unit and wolude serial nudber for the Log file
that i=s allocated upon entry into ASG-SRartTest. The Log file
iz used for error Hessages and log coHWands. File characteristic
are specified on the options - Log-List<Punch Definition pop-up.

[HORE...press ENTER for HOre infordation.]

Command Help
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Help for a specific command is requested by selecting Help » Specific command, typing
the command in the command input area and pressing PF1/PF13, or typing HELP
followed by the desired command name. A long message displays describing the
command. Pressing PF1/PF13 again displays the Help Tutorial screen for that command.
The Help Tutorial for each command displays the command syntax diagram, and gives a
description of each operand in the command. Typing UP on a command help screen
displays a complete list of all SmartTest commands.

For help on all SmartTest commands, select Help » All commands or type HELP
COMMANDS. The All commands action displays a complete list of all SmartTest
commands. The HELP COMMANDS command displays a long message that lists most
of the primary commands. Once this message displays, pressing PF1/PF13 displays the
list of all SmartTest commands. From this list, information about a particular command
can be displayed by selecting the appropriate number.



Figure 109 shows the Help Tutorial screen for the RECALL command.

Figure 109 « Command Help Example

AZG-EHartTest - RE.O ————————————- RECALL HEL

The RECALL conmand displaws the prewious ASG prirdary oF internal condand,
Heszage, oOF pop-up. The last twentw coWnands that have been edecuted and the
last twenty Hessages that have been displayed are stacked. These cCondands and
Heszages can be dizplaved using RECALL. 0Once the dezired coWHand iz dizplayed
it can be esecuted again by preszing ENTER or changed prior to esecution.

The RECALL cCowWMand syntad is:

RECall >
~CoHmand | CHO- -NERT-
-HEZzage | HaG- -PREU-
-POPUp

HiniHuM Abbreviations are in GAPE
Default operands are highlighted
LEGEND: requi red

|-optiaonal-
The following topic will be presented only if esplicitly selected by nunber:

1 - Operand Descriptions

7 Help Facility

For some commands (on the Program View screen only), pressing PF1/PF13 after the
long message, displays =NOTES= lines giving specific examples for using the command.
Once the =NOTES= lines are displayed, pressing PF1/PF13 again displays the Help
Tutorial for that command. The Help =NOTES= displays for those commands where
specific examples are helpful. Use the RESET primary command to remove the

=NOTES= lines.

Figure 110 shows the Help =NOTES= for the RECALL command.

Figure 110 « Help Notes Example

File Uiew Test Search List O0ptions Help

Progran Liew VIAPPLI
CoHrand === scroll ===} CIR
AZGAEdSI RECALL REDIEPLAYE THE PREVIOUE CORHAND OR HEZSAGE.
SMOTE= +-—-——-—————- Exanples -———--— RECALL --———- Dezcriptions -——--—-——-—- +
=HOTE= RECALL Recalls the last connand that was
=NOTE= entered in the prinary coddand
=HNOTE= area.
=NOTE= | REC H3ZG Recalls the last Wessage that was
=NOTE= displawed in the Hessage area.
=NOTE= | RECALL NEXT once recalling is started, MEXT
=MNOTE= Hay be used to reverse its
=MNOTE= ditection.
=HOTE= +
aEaaal # PROCEEE OPTIONE INSOURCE Z0URCE NEST MOHACRO:
HERaa2 * PROCEESE AGGREGATE E:0 ZTHT GOSTHT;
BEEgDT # PROCESE HARGINE(2,72,1] HARGINI('|'1:
BEEg0d # PROCESS OPT(@] ATTRIBUTES[FULL) MREF[FULL];
HEEOES # PROCESE GOSTHT,LIST,MEST,LIMECOUNT [55],0PTIONS . 30URCE,,NOTEST
OE000E * PROCESE MOOPTIHIZE,MOFLOM,ATTRIEBUTES:
[l LT
BEaE0E
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General Information

General help information is requested by selecting Help » Table of contents, or by typing
TOC on any Help Tutorial screen. The Help Table of Contents displays. Help information
can be viewed by pressing Enter or by selecting a menu option.

Figure 111 shows the Help Table of Contents.

Figure 111 « Help Table of Contents

AZE-EWartTest - RE.O —-—-—- HELP TRELE OF CONTENTE HEL

The topics below represent general categories of infordation about the AZG-ESM
Testing-Debugging CoMponent, ASG-EHartTest. To get help for a pull-down,
zelect the AcCtion Bar topic. This Tabkle of Contents Waw be redisplawved frod
any HELF =creen by entering the TOC Connand.
The following topics will be presented only if esplicitly selected by nunber:
1 overuview of AZG-SHartTest
Introduction to CUR
The Action Ear

2

3

4 CustoMer Fupport

5 RASG-ZHartTest Release 6.8 SUHHary of Revisians
5

Inded for AEG-EHartTest Help

—————— Cur panel = UPTHTOC Pred panel = WPPPRTHE Last H=g = ISRE002Z ————==

Specific Information
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Help for specific topics is requested by selecting Help P Index, selecting option 7 on the
Help Table of Contents, or typing INDEX from within the Help Tutorial. Help for a
specific topic can then be viewed by selecting the appropriate Index entry.

On any Index screen, typing an alphabetic character displays the Index screen
corresponding to that character.
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Figure 112 shows a Help Index screen.

Figure 112 »« Help Index Example

AZG-ERartTest - RE.O ———————-—- INDEX A - E HEL

To select a topic, enter the two- or three-character identifier.

Al — HREBEND:Z
A2 - ADD Connand Bl - BackTrack Facility
A3 - RAddress stop Entry Screen B2 - BackTrack Mariable History Pop-up
Ad - AKR Directaory E3 - BackTrack Uariable Historw Zcreen
AS - AKR Utilities Ed = ERANCH Cornand
A& - ALLOCDEF CoMHand ES - BREAK CoHHand
A7  — ALLIANCE Cornand E6& - Ereakpoints List Zcreen
AS — ALTPCE Hessage Queus List
ECkesn
A® - ALTPCE ZegHent List Fcreen
AlB - ANALYZE CaHnmand
A1l - Analwze Options

Another inded page can be displayed by entering its letter.

Help Abends

ESW products include help for these frequently encountered abend codes:

. System abend codes, such as 0C1, 0C4, x13, x22

. ESW product abend codes

. IMS abend codes

Help for system, ESW product, and IMS user abends is available by selecting Help »

Common abends, typing HELP ABENDS, or typing ABENDS in the command input area
and pressing PF1/PF13. Each of these actions displays the ABENDS screen, as shown in

Figure 113.

Figure 113 « ABENDS Screen

AZG-EHartTest - RE.O ————————————— AEBENDE HEL|

The following topics will be presented only if edplicitly selected by nunber:

Zpsten Abends

AZE Abends

IHZ Abends @05 - E43
IHE Abends 654 - 931
IHE Abends 932 - 3415

o Fe o b2
LI I I A |
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On the ABENDS selection screen, enter the number of the set of abend codes you want to
view. Selecting Option 2 on this screen displays the ASG Abend Codes screen, which
lists and describes the ESW user abend messages.

Figure 114 shows the ASG Abend Codes screen.

Figure 114 « ASG Abend Codes Screen

AZG-ERartTest - RE.O ———————-—- AZG ABEND CODE: HELF

Abend codes in the range ®08 - 9% [M'354 - ' 3EV'] bypass ASG error
recovery, Causing the abend to be handled by ISPF oF by the systen. If the
probled cannot be resolyed, call Custoder Support.

PRSI0 Unable to intercept prograr.

@EY  MWUICY The AEG-Center AUTHORIZE password was not specified during
installation.

PES WIS AN internal error occurked during initialization.

a7E W IR A package load module was called directly.

e v The A%G Edit Honitor encountered a Severs error.

@vd  M'ICE" An intalid VIAZEASE Wodule was found. The current product

edpects a level of CEOSE or greater. Enter HELP 4983 for HoOre
infarnation.
[continuead]

Help Messages

SmartTest messages are displayed in the long message area. This is the format for
messages:

ASGnnnnx text
where:
nnnn is the message number.
x is one of the severity levels listed below.

text is the long or short message text.
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Severity Levels

This table describes the severity levels:

I Informational Indicates that there is no required action.

w Warning Indicates a non-critical error condition exists.

E Error Indicates a critical error condition exists.

D Disaster Indicates that a serious error condition exists and the

product is unable to continue.

T Termination Indicates that the product terminated with the specified
error.

Short messages are displayed when available. Long messages are displayed if a short
message does not exist, or when help is requested immediately after a displayed short
message.

Help for a specific message displays by selecting Help » Specific message, or by typing
HELP followed by the message number. The Help Explanation and Action Panel for that

message displays.

Figure 115 shows the Help Explanation and Action Panel.

Figure 115 « Help Explanation and Action Panel

HELF Explanation and Action Fanel
CoHrand === 3croll === PAGE

Additional support Hay be found at our Web Zitel wuW.asg.coH
AZGAESE  END OF PROGRAM; UZE ERANCH BACKUP TO FOLLOW OTHER ERANCHE:.

EXPLANATION:
This i$ a warning Hessage indicating that BRAMCH has reached the
physical end of the progran.

ACTION:
If wou Wiskh to branch to other paths, use BRANCH BACKUP to reach
the desired decizion paint and then use ERAMCH to follow another
path.

EOTTOH OF DATA
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All SmartTest messages or a range of messages can be printed using the VIASMPRT
program. The VIASMPRT program produces a listing of the specified messages that
includes:

. Message number

. Short message (if available)

. Long message

. Explanation of the message

. Action (if any)

JCL to execute the VIASMPRT program is in ASG.VIACEN xx.CNTL(VIASMPRT)
where xx represents the version of Center installed at your installation. The entire

message file is printed unless a specific range is specified in the PRM parameter. For
example, PRM='"START=300,END=499' would print messages 300 through 499.

The ALL keyword can be specified in the PRM parameter to print all messages.

The default value for START is 1 and the default value for END is 5000. If only the
START value is entered, messages print starting at the message number specified and
ending with 5000. If only the END value is entered, messages print starting with 1 and
end with the message number specified.

The NOTES keyword specifies that any notes associated with a message will be printed.
The default is NONOTES. Typically, notes are provided to show Center primary
commands.
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Figure 116 and Figure 117 on page 186 show the VIASMPRT JCL and the output from
the job.

Figure 116 = VIASMPRT JCL

//ASG JOB ( ),'ASG-CENTER VIASMPRT' 00010000
//* INSERT '/*ROUTE PRINT NODE.USER' HERE IF NEEDED. 00020000
//* 00030000
//k Kk khkhkkhkhkhkhkkhkhkhhhhhhhhkhhhkhhkhkhhkhhkhhkhhhhhk kb kb hkkhhkhkhkhkhkhkhkhkhkhkhkhkhkkkkkx 00040000
//* * ASG, INC. ASG-CENTER * 00050000
//* * * 00060000
//* * UTILITY TO PRINT ASG MESSAGES * 00070000
//* * * 00080000
//* LR RS RS SRS RS ES RS ERES SRS E RS S SRS EEEEEREREEREEEEEEEEEEESS 00090000
//* 00100000
//VIASMPRT PROC VIASOFT='ASG', ASG HI-LVL NODES 00110000
// CENTER='VIACENXX', ASG MIDDLE NODES 00120000
// SYSouT="'x*"', PRINT OUTPUT MESSAGE CLASS 00130000
// PRM=""' PARM FOR MESSAGES TO BE PRINTED 00140000
//* 00150000
//k khkkkhkhkhkhkhkhkhkhkhhhhkhhkhhkhkhkrkhhkhkhhkhhhhhhhk kb hkhhkhhkhkhkdkhkhkhkhkhkhkhkhkkhkkhkhkkhkxkhkkxk 00160000
//* * * 00170000
//* * MESSAGE PRINT UTILITY * 00180000
//* * * 00190000
//* * THIS PROGRAM WILL PRINT ALL OF THE MESSAGES IN THE ASG * 00200000
//* * MESSAGE FILE AND THE HELP TEXT ASSOCIATED WITH EACH * 00210000
//* * MESSAGE IT WILL PRINT THE ENTIRE FILE BY DEFAULT. YOU MAY * 00220000
//* * SELECT A GIVEN RANGE OF MESSAGES BY SPECIFYING THE OPTION- * 00230000
//* * AL PARAMETER KEYWORDS: START AND END. FOR EXAMPLE: * 00240000
//* N PRM="'START=300, END=499" * 00250000
//* * WILL PRINT MESSAGES NUMBER 300 THROUGH 499, INCLUSIVE. * 00260000
//* * THE DEFAULT VALUES FOR START AND END ARE 1 AND 99999 * 00270000
//* * RESPECTIVELY. CONSEQUENTLY THE PRM VALUE 'END=300' WILL  * 00280000
//* *  PRINT MESSAGES 1 THROUGH 300, AND THE PRM VALUE * 00290000
//* * 'START=4000' WILL PRINT MESSAGES 4000 THROUGH 99999. * 00300000
//* * * 00310000
//* * AN OPTIONAL KEYWORD, NOTES, WILL ALSO PRINT ANY NOTES * 00320000
//* * ASSOCIATED WITH A MESSAGE. * 00330000
//* * * 00340000
//* * ADDITIONALLY, THE KEYWORD 'ALL' WILL EXPLICITLY PRINT ALL * 00350000
//* * MESSAGES. * 00360000
//* LR EEEEEESE R RS SRR SRS E SRS SRR R EEEEEREEEREEEEEEEEESES] 00370000
//* 00380000
//* 00390000
//VIAMPRT EXEC PGM=VIASMPRT,REGION=4096K, 00400000
// PARM="&PRM' 00410000
//STEPLIB DD DSN=&ASG..&CENTER..LOADLIB,DISP=SHR 00420000
//VIAMSGS DD DSN=&ASG..&CENTER..VIAMSGS,DISP=SHR 00440000
//VIAPRINT DD SYSOUT=&SYSOUT 00450000
//VIALOG DD SYSOUT=&SYSOUT 00460000
//SYSUDUMP DD SYSOUT=&SYSOUT 00470000
//* 00480000
// PEND 00490000
//* 00500000
//VIASMPRT EXEC VIASMPRT PRINT MESSAGES 00510000
//* 00520000
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Figure 117 « VIASMPRT Output

PRINTING MESSAGES FROM 0771 TO 0772.

2 MESSAGES PRINTED.

END OF MESSAGE PRINT PROCESSING.
ASG0771 SUBSET 'COBOLII' IS NOT VALID IN A LANGLVL 1 OR 2 EDIT SESSION.

EXPLANATION:
The COBOL Edit session was selected to view a program as COBOL

LANGLVL1 (COBOL68) or LANGLVL2 (COBOL74), and the command entered
requested a target of SUBSET COBOLII.

ACTION:
If the program is COBOLII, then reenter the Edit screen with COBOLII

selected; then you may enter commands for SUBSET COBOLII.

ASG0772 THE EDITOR PARAMETER 'l' IS UNKNOWN.

EXPLANATION:
An invalid parameter was entered in the Editor Parms field of the

Edit Options panel.
ACTION:
Refer to the Reference Manual or the Reference Card for a list of
valid editor parameters.




Glossary

ACB
See Application Control Block (ACB).

action bar

The line of keywords at the top of a screen. Each keyword represents a category of
actions that may be performed on that screen. An action is selected by moving the cursor
to the desired keyword and pressing Enter. See "The CUA Interface" on page 4 for more
information.

active program
A program that is being viewed and/or tested on the Program View screen. Also see
qualified program.

address command

A command that is entered in the hexadecimal address area within the status box or in any
address or offset field displayed on a SmartTest screen. These commands display specific
areas of memory such as the current word, 24-bit address, or the 31-bit address. A
message can also be displayed that indicates to where the 24-bit or 31-bit address points.
See the ASG-SmartTest Reference Guide for more information.

address stop
An absolute address and length of storage that is to be monitored during a test session. A
program interrupt occurs before the specified area is actually updated.

AKR
See Application Knowledge Repository (AKR).

alias
A dataname alias includes a Parent (higher level group item), a Child (lower level item), a
RENAMES or REDEFINES, or an 88 level item.

alias name

The name of a program entry point. Alias names are shown on the AKR Directory and
Module Directory screens.
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alias of

A field on a pop-up listing entries in the AKR. If the analyzed program contains an
ENTRY point, Alias Of is the name of the program that contains the ENTRY point. If the
name in the PROC MAIN statement was overridden at the time the analyze job was
submitted, Alias Of is the name that was entered in the AKR program name field on the
File - Analyze Submit pop-up.

analyze
The process used by SmartTest to prepare a COBOL, PL/I, or Assembler program for
testing. See analyzer.

analyzer

The batch component of SmartTest that executes complex algorithmic formulas to
analyze the complexities of a COBOL, PL/I, or Assembler program. It produces a
detailed analysis of the elements and relationships for a program, then places this
information in the AKR. There are three analyzers. The Program Analyzer analyzes
COBOL programs. The Assembler Analyzer analyzes Assembler programs. The PL/I
Analyzer analyzes PL/I programs.

analyzer summary
A summary of the run-time statistics and diagnostic messages that are produced when an
Analyze job completes.

Application Control Block (ACB)
A control block for IMS/DC that contains the PSB and DBD, and is created by the
ACBGEN process.

Application Knowledge Repository (AKR)

The Application Knowledge Repository component of SmartTest. The AKR is a BDAM
or VSAM file organization that contains all analysis information produced by the
Program Analyzer or Assembler Analyzer. Multiple AKRs can be defined for your
installation. SmartTest supports concatenated AKRs.

application plan
See plan name.

Assembler analyzer
See analyzer.

Batch Terminal Simulator (BTS)
An IBM product that allows execution of IMS DB/DC applications in a TSO or batch
environment.

batch test session

A SmartTest test session that is established in an MVS batch region, to which an online
test session can be connected. This feature allows batch program testing to be performed
interactively.
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breakpoint
An interruption that occurs during the execution of a program being tested. Breakpoints
result from a BREAK command or an error condition.

BTS
See Batch Terminal Simulator (BTS).

command input area
The field on SmartTest screens where primary commands are entered, indicated by ===>
on the second line of the screen.

current cursor location

Refers to the source statement where command processing begins. The current cursor
location can be one of these based on the cursor position: If the cursor is in the command
input area, the current location is the first source code line on this screen. If the cursor is
in the line command input area, the current location is the beginning of that line. If the
cursor is in the source code area, the current location is the cursor position.

cursor character

A substitution character that can be used in commands. The command and cursor
character are typed in the command input area, the cursor is placed on the desired token,
then Enter is pressed. SmartTest locates the cursor and reads the specified token as part of
the command. The cursor character is set on the Parameter Definition screen. See the
ASG-SmartTest Reference Guide for more information.

dataname

A standard term for fields defined in the DATA DIVISION of a COBOL program, a
DECLARE in PL/I, or a data area label in an Assembler program. Includes variable
names, files, groups, array elements, and fully qualified datanames.

data usage

Defines how a data item is used: DEF indicates the statements where the data item is
defined; USE indicates the statements where the value is used or tested; MOD indicates
the statements where the value is set or modified; REF indicates any of the above
conditions. Note: This function is only available for COBOL.

database description (DBD)
A control block that describes the physical structure of a database in an IMS
environment.

DBCS
See Double Byte Character Set (DBCS).

DBD
See database description (DBD).
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DB2
An IBM relational database management system.

DB2 Stored Procedure

A user-written program that resides on a DB2 server and is invoked by an EXEC SQL
CALL statement. A stored procedure is a Language Environment compliant program
written in PL/I, COBOL, C/370, or Assembler. The SmartTest DB2 Stored Procedure
option enables programmers/analysts to use SmartTest features to interactively test DB2
Stored Procedures.

debug
The process of locating and correcting program errors.

diagnostic message

An informational or error message generated by the online and batch components.
Online - A short message displays in the upper right corner of the screen (if available). A
long message displays on line three when PF1/PF13 is pressed or HELP is entered for a
short message. Batch - Messages are included in the Analyzer Summary.

DL/1'| DL/
The database (DB) portion of the IMS system.

Double Byte Character Set (DBCS)

A character set that uses two bytes to represent each character. Various Double Byte
Character Sets are used with languages such as Chinese, Korean, and Japanese, which
cannot be represented with single byte codes.

equate

A substitution name for a character string. The substitution name is created using the
EQUATE command. Long commands, patterns, datanames, etc., can be equated to a
substitution name.

IMS
An IBM hierarchical database management system.

label name
Any PROCEDURE DIVISION paragraph or section name and the PROCEDURE and
PROC literals.

line command
An abbreviated keyword that is entered in the line command area (columns 1 through 6)
on the screen.

list file
A file that is allocated the first time the LPRINT command is executed. This file is used
for LPRINT output.
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log file
A file that is allocated upon entry into SmartTest. This file is used for error messages and
log commands.

long message

A diagnostic or error message that displays on SmartTest screens. Long messages are
sometimes preceded by short messages that are displayed in the upper right corner of the
screen. Pressing PF1/PF13 after receiving a short message displays the corresponding
long message.

member
A member in a PDS or source manager such as Panvalet or Librarian. This is the alias
name found in the AKR.

module
A link edited member of a load library PDS. A module can contain several programs.

monitored storage

The data monitored by specifying the absolute addresses and lengths of storage areas on
the Address Stop Entry screen. All storage areas listed on this screen are monitored by
SmartTest and a program interrupt occurs before a specified storage area is actually
updated.

PCB
See Program Communication Block (PCB).

plan name
A DB2 application plan that contains information relating a program to the data used by
the program. A DB2 plan is the output of the BIND process.

PL/l analyzer
See analyzer.

PL/l subset

PL/I statements of a similar nature that have been grouped together. For example,
input/output statements are grouped into the 10 subset. The LIST SUBSETS command
can be used to display all subsets online.

Pop-up

A window that displays as the result of selecting an item on a pull-down or pop-up, or as
the result of entering certain commands. It is superimposed on the screen to allow entry
of information for the requested action.

primary command
A series of keywords that is entered in the command input area of the screen.
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program

Program source member name, the name specified in the IDENTIFICATION DIVISION
of a COBOL program, the PROCEDURE name of a PL/I program, or the CSECT name
of a program that is not COBOL.

program analyzer
See analyzer.

Program Communication Block (PCB)
A definition of the database view used by an application program in an IMS environment.

Program Specification Block (PSB)
All Program Communication Blocks (PCBs) are contained in a PSB.

PSB
See Program Specification Block (PSB).

pseudo code
Statements that are temporarily inserted into program source during a test session. The
syntax of this code is compatible with COBOL.

pull-down

The list that displays when an action is selected on the action bar. On a pull-down, actions
followed by ... display a pop-up when selected. Actions not followed by ... immediately
activate internal commands.

punch file
A file that is allocated the first time the LPUNCH command is executed. This file is used
for LPUNCH output.

qualified program

A program that displays on the Program View screen using the QUALIFY command,
while another program is being viewed and/or tested. The program specified with the
QUALIFY command is a qualified program; the program being viewed and/or tested is
an active program.

SBCS
See Single Byte Character Set (SBCS).
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screen subsets
Lines that have been acted upon by an interactive command that have caused them to be
in one of these screen display set types:

Highlighted | HI
NONHighlighted | NHI
Excluded | X
NONExcluded | NX

script file
A sequential file that contains a predefined sequence of commands that can be read and
executed.

short message

A diagnostic or error message that displays in the upper right corner of SmartTest
screens. Pressing PF1 after receiving a short message displays the corresponding long
message.

Single Byte Character Set (SBCS)

A character set that uses one byte to represent each character. Single Byte Character Sets
are used with languages such as English where the characters can be represented with a
one-byte code.

status box

A box that displays at the bottom of SmartTest screens during a test session. Current
status information for the program being tested is shown. This information includes the
statement number, offset, source statement, program name, module name, date, and time.
When the Assembler mode is set ON, the status box also shows the AMODE value,
Assembler instructions, hexadecimal value, and the general register contents. The status
box can be removed from the screen using the SET STATUS OFF command.

Storage Management Subsystem (SMS)

An operating environment that automates and centralizes the management of storage. To
manage storage, SMS provides the storage administrator with control over data class,
storage class, management class, storage group, and ACS routine definitions.

Stored Procedure
See DB2 Stored Procedure.

subset
A language subset, screen subset, or tagged lines subset. See the ASG-SmartTest
Reference Guide for detailed information on subsets.
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tagged lines subsets

Information shown in columns 73 through 80 as the result of a FLOW or TRACE
command. These tags can be used as subsets in commands that accept subsets as targets:
TAGged | TAGS

TARGet | TGT

DECision

STArt

OPTions

target
An object of a SmartTest primary command.

TCA
See Test Coverage Analysis (TCA).

Test Coverage Analysis (TCA)

SmartTest-TCA, Test Coverage Analysis, is a testing option that measures test suite
coverage for a set of programs. It fosters a systematic approach to assess the quality of
testing performed in the internal operation of programs. Test Coverage Analysis is a tool
for application systems testing and quality assurance testing — to help ensure that program
routines are covered by data execution (i.e., to what extent the data exercises the
program). Test Coverage Analysis records the program's reaction to the data presented,
without user intervention (to preserve the integrity of the results). For detailed
information, see the ASG-SmartTest TCA User’s Guide.

token
A contiguous set of characters preceded by and followed by a blank, period, comma, or
parenthesis.

TSO test session
A SmartTest test session that is executed in a TSO/ISPF environment. Batch JCL is
converted to an allocation CLIST and is used to establish the TSO test session.
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Symbols allocating
& (retain) command 159 ACB library datasets 70
&COUNT command 151 alternate message queue 88
/P cards 83 alternate PCB output dataset 90
/T command 81 an AKR 27
BTS files 83
Numerics BTS input dataset 93
3270 terminals supported 25 BTS program output dataset 91
77 pseudo code statement 151 DB monitoring datasets 71
DFSRESLB and DFSESL 67
A execution parameters 74
ACB IEFRDER dataset 72
allocation 70 IMS files 65
definition 188 IMS PROC libraries 68
action bar 4, 187 ISPF list file 59

active program 5, 187 ISPF log dataset 60
ADD command 150 Log/List/Punch/Work files 18

adding pseudo code 150 output message queue 86

address PSB and DBD library datasets 69
commands definition 187 QALTPCB 88
space 78 QIOPCB 86
stop 187 script files 24

SNAP dump dataset 95,97

swapped space 78
VSAM buffer pools 68

AGN execution parameter 76

AKR 2 allocation CLIST 41, 101
allocating 27 alternate
catalog 28 message queue 88
PCB 84

concatenating 36, 38
definition 1
directory 37
password 28

analyze method
from a User screen 34
from an Edit session 32

SMS classes 28 through SmartTest 31

utilities 27 Analyze Submit Parameters pop-up 33
alias 187 analyzing a program 30
Alliance 129, 160 application control block

accessing from ESW screen xiii  see ACB

description x application group name 76

linking xiii Application Knowledge Repository
Alliance, linking to 160 see AKR

ALLOC parameter 41 application parameters 101
ASG Abend Codes screen 182

ASG-SmartTest Primary screen 15
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Assembler
and SmartTest-PLI 173
integration 2

AutoChange 129
accessing from ESW screen xiii
description x

B
backout and recovery datasets 72
backtrack
recording history 140
reviewing history 141
Batch
connecting for test 112
DFHDRP testing 119
initiating test 114
region testing 108
session setup 109
setup considerations 115
submitting the job 112
test session 112, 188
testing BTS 117
testing DB2 118
testing DL/I 116
Batch Connect facility 108
Batch Session Setup screen
example 109
field descriptions 110
options 110
Batch Terminal Simulator 188
BIND 101
BKO execution parameter 79
BMP
execution parameter 66
parameters 74
region 76
BREAK command 129, 150
break on entry 80, 101
breakpoint
definition 189
displaying 134
inserting 128, 133
removing 134
setting with impact datasets 129
Breakpoints List screen 132
Bridge
accessing from ESW screen xiii
description x
BTS
allocating input dataset 93

allocating program output dataset 91

alternate message queue 88
alternate PCB output dataset 90
BTSDEBUG 95

BTSOUT 91
BTSPUNCH 93
BTSSNAP 97
definition 188
format libraries 86
in TSO session setup 79
input 84
output message queue 86
QALTPCB 88
QALTRAN 90
QIOPCB 86
setup information 79
SNAP dumps dataset 95
STAX indicator 85
system parameters 84
system variables 84
testing in Batch 117
transactions to monitor 81
work file 84
BTS Allocation Selection pop-up
example 83
options 84
BTS Batch Session Setup screen 117
BTS BTSDEBUG Allocation pop-up
example 96
field descriptions 96
BTS BTSOUT Allocation pop-up
example 92
field description 92
BTS BTSPUNCH Allocation pop-up
example 94
field descriptions 94
BTS BTSSNAP Allocation pop-up
example 98
field descriptions 98
BTS FORMAT Libraries pop-up 86
BTS Load Library pop-up 85
BTS QALTPCB Allocation pop-up
example 88
field descriptions 89
BTS QALTRAN Allocation pop-up
example 90
field descriptions 90
BTS QIOPCB Allocation pop-up
example 87
field descriptions 87
BTS Session Setup screen
example 79
options 80
BTSDEBUG allocation 95
BTSIN
dataset 81
patch cards 83
BTSOUT allocation 91



BTSPUNCH allocation 93
BTSSNAP allocation 97
BUF execution parameter 77
buffers, page-fixed 76

C
CALLed load modules, testing 124
CANCEL command 134
cancelling execution 134
capturing scripts 155
Center, description x
changing data values 135, 140
checkpoint/restart ID 75, 78
CKPTID execution parameter 75, 78
CLIST
converting JCL 40
VIAPUBTS 84
VIAPUIMS 66
VIAPUSPF 56
COBOL
CASE generated COBOL support 3
COBOL IT support 3
pseudo code 151
reserved words 151
subsets 163
command scripts 155
command syntax, learning 122
commands
& (retain) 159
&COUNT 151
JT 81
ADD 150
ALLIANCE 162
BR (Breakpoint) 128
BREAK 129, 150, 163
CANCEL 134
EQUATE 158
EXCLUDE 163, 166
EXECUTE 133, 156
F (first) 166
FINDXTND 163, 167
GO 127
GO TO 150
HIGH 163
IF/THEN/ELSE 150
KEEP 138
KG (keep group) 138
KGH (keep group hex) 138
KH (keep hex) 138
L (last) 166
line 6
LIST ADSTOP 122
LIST BREAKS 134
LIST COUNTS 122

Index

LIST EQUATES 158

LIST PSEUDO 153

LIST TAILOR 155

LIST TRACKING 122

LOCATE * 133,157

LPRINT 163,171

MOVE 150

primary 5

processing order 4

PRODLVL 160

QUALIFY 124,154

RECALL 159

RESET 138

RESET EXCLUDED 166

RESET PSEUDO 153

RUN 122,125

RUN PROGRAM 101

S (show) 166

SCROLL 163,172

SET 26

SET BACKTRACK 140

SET SCRIPT 155

SET XMODE 168

simplify entering 158

STEP 126

SUBTRACT 150

TESTPOINT 130

WHEN 150

ZD (zoom display) 135

ZG (zoom group) 137

ZGH (zoom group hex) 137

ZH (zoom hex) 135

Z0 (zoom out) 138

ZOOMDATA 138
Common User Access (CUA) 4
concatenating AKRs 36
Connect to Job pop-up

example 113

options and status descriptions 113
continuous execution 125
controlling execution

locating next statement 133

specified number of statements 126
conventions page xvi
Convert Batch JCL pop-up

example 41

field descriptions 42

options 41
converting JCL to CLIST 40
CPUTIME execution parameter 76
CUA

action bar 4

overview 2,4

pop-up 4
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cursor character 189

cursor substitution 158

cursor token 158

customizing DSN for Log, List, and Punch
files 23

D
data
classes, SMS 28
element 7
field references, finding 170
values, changing 140
data windows
at top of screen 138
inline 135
Keep 138
removing from screen 139
Zoom 135
database
DB2 support 4
dynamic backout 79
ISM/DB support 4
plan name 191
VSAM support 4
Database Recovery Control 78
dataname
alias 187
description 7
elementary dataname 7
fully qualified 7
group level 7
DB monitoring datasets 71
DB2
allocating load library 67
in TSO session setup 100
load library datasets 67
plan 101
plan name 191
subsystems 76
test session 100
testing in Batch 118
DB2 Batch Session Setup screen 118
DB2 Session Setup screen
example 100
field descriptions 101
options 100
DB2 Stored Procedure
definition 102
displaying parameters 105
entering test data 105
initiating the test 107
requirements 102

session setup 102
setting up the test 103
Testing Option 102
DBB
execution parameter 66
parameters 76
DBCS (Double Byte Character Set) 190
DBD
allocation 69
libraries 66
DBRC execution parameter 78
DD statements
BTS load library 85
BTSDEBUG 95
BTSOUT 91
BTSPUNCH 93
BTSSNAP 97
DFSRESLB and DFSESL 67
DFSVSAMP and PROCLIB 68
FORMAT 86
IEFRDER 72
IMSACB 70
IMSMON 71
PSB and DBD 69
QALTPCB 88
QALTRAN 90
QIOPCB 86
VIAQUEUE 111
DEALC parameter 42
default ISPF libraries 58
defining PF key values 25
DFHDRP
batch JCL 119
testing in Batch 119
DFSESL allocation 67
DFSRESLB allocation 67
DFSVSAMP allocation 68
DIRCA execution parameter 75
directory, AKR members 37
displaying memory
see address command
displaying, excluded lines 166
DLI execution parameter 66
DLI parameters 76
Double Byte Character Set 190

E

editing pseudo code 152

Encore
accessing from ESW screen xiii
description xi

ending a test session 49

entering pseudo code 152



entry point, alias name 187
Environment Selection pop-up

example 36
options 36
equate 190

EQUATE command 158
Estimate 129
accessing from ESW screen xiii
description xi
ESW
description ix
invoking products xii
product integration xiii
ESW integration 2
EXCLUDE command 166
excluding lines
in search function 166
SET XMODE 168
EXCPVR execution parameter 78
executable statement, finding next 157
EXECUTE command 133
executing a program
by statement 126
cancelling 134
changing data 135
changing sequence 127
continuous 125
displaying breakpoints 134
interrupting 128
executing a specified number of
statements 126
executing pseudo code 153
execution parameter
BMP 66
DLI/DBB 66
Execution Tracking screen 123
Existing Systems Workbench (ESW)
example of primary screen 14
exiting SmartTest-PLI 135

F
F (first) command 166
fast path
data buffers 76
databases 76
File - AKR Allocate/Expand pop-up 28
File - AKR Utility pop-up 27
File - Analyze Submit pop-up 31
File - Execute Script pop-up 157
File pull-down 154
finding
data field references 170
I/O statements 168
FINDXTND command 167

Index

FMTO execution parameter 78

format libraries 86

Formatted Dump Delete List (FDDL) 78
formatted dump output 78

G

getting started 13

GO command 127
GO TO command 150

guidelines for using
MONITOR/NOMONITOR 123

H

help
for abends 181
for commands 178
for general information 180
for messages 182
for screens 177
for specific information 180
index 180
navigational commands 177
NOTES 179
online 175
printing messages 184
requesting 177
Table of Contents 180

Help Explanation and Action Panel 183

|

I/O statements, finding 168

IEFRDER allocation 72

IF/THEN/ELSE statements 150

impact datasets 129

impact of change 165

impact types 131

IMS
AGN execution parameters 76
allocating backout and recovery

datasets 72

BKO execution parameters 79
BMP execution parameters 66
BMP parameters 74
BUF execution parameters 77
CKPTID execution parameters 75, 78
control region 76
control region options 75
CPUTIME execution parameters 76
DBB execution parameters 66
DBRC execution parameters 78
DIRCA execution parameters 75
DLI execution parameters 66
EXCPVR execution parameters 78
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file allocations 65
FMTO execution parameters 78
identifier 78
IMSID execution parameters 76, 78
IN execution parameters 75
IRLM execution parameters 79
IRLMNM execution parameters 79
load library 66
load library datasets 56, 67, 85-86
LOGA execution parameters 78
logging facility 66
MON execution parameters 78
monitoring 78
NBA execution parameters 76
OBA execution parameters 76
OPT execution parameters 75
OUT execution parameters 75
PARDLI execution parameters 76
PREINIT execution parameters 76
PRLD execution parameters 75, 78
RST execution parameters 78
SPIE execution parameters 75, 77
SRCH execution parameters 78
SSM execution parameters 76
STIMER execution parameters 75
SWAP execution parameters 78
system parameters 66
system variables 66
TEST execution parameters 75, 77
IMS ACB Allocation pop-up 70
IMS Allocation Selection pop-up
example 65
options 66
IMS Batch Session Setup screen 116
IMS BMP parameters
AGN 76
CKPTID 75
CPUTIME 76
DIRCA 75
IMSID 76
NBA 76
OBA 76
OPT 75
ouT 75
PARDLI 76
PREINIT 76
PRLD 75
SPIE 75
SSM 76
STIMER 75
TEST 75
IMS BMP Parameters pop-up
example 74
field descriptions 75

IMS DFRESLB/DFSESL Allocation pop-up

example 67
field descriptions 67
IMS DLI/DBB parameters
BKO 79
BUF 77
CKPTID 78
DBRC 78
EXCPVR 78
FMTO 78
IMSID 78
IRLM 79
IRLMNM 79
LOGA 78
MON 78
PRLD 78
RST 78
SPIE 77
SRCH 78
SWAP 78
TEST 77
IMS DLI/DBB Parameters pop-up
example 77
field descriptions 77
IMS IEFRDER Allocation pop-up
example 73
field descriptions 73
IMS IMSMON Allocation pop-up
example 71
field descriptions 72
IMS PROCLIB/DFSVSAMP Allocation
pop-up
example 68
field descriptions 69
IMS Resource Lock Manager (IRLM) 79
IMS/DB
setup 63
TSO foreground 63
IMS/DB PSB/DBD Allocation pop-up 69
IMS/DB Session Setup screen
example 63
field descriptions 64
options 63
IMS/OSAM buffer pool 77
IMSCTRL macro 79
IMSID execution parameter 76, 78
IMSMON allocation 71
IN clause, in search function 166
IN execution parameter 75
Insight
accessing from ESW screen xiii
description xi
using analysis functions xiii
Intelligent Search Function 163



intercepting
load modules 54
programs 124
intercepts 124
interregion communication area 75
introduction for new users 13
IO statements 165
IRLM (IMS/VS Resource Lock
Manager) 79
IRLM execution parameter 79
IRLMNM execution parameter 79
ISAM/OSAM buffer 78
ISPF
allocating log dataset 60
specifying list file 59
system variables 56
ISPF Allocation pop-up
example 55
options 55
ISPF List Data Set Allocation pop-up
example 59
field descriptions 59
ISPF Log Data Set Allocation screen
example 60
field descriptions 61
ISPF Panel/Link Libraries pop-up 57
ISPF Program Load Library pop-up 56
ISPF Session Setup screen
example 52
field descriptions 53
options 53
ISPF Table/Message/Skeleton Libraries
pop-up 58
ISPMAIN, specifying location 55
ISPMLIB 58
ISPSLIB 58
ISPTLIB 58

J
JCL
convert to CLIST 40
VIASMPRT program 184
Job Pack Area (JPA) 78
job statuses 113
JOBLIB/STEPLIB 78
JPA (Job Pack Area) 78

K

K (keep) command 138

KEEP command 138

Keep window
removing globally 139
removing individually 139

KG (keep group) command 138
KGH (keep group hex) command 138
KH (keep hex) command 138

L
L (last) command 166
label name 7
language support

Assembler 3

COBOL 3

PL/T 3
LEARN mode 122
learning command syntax 122
libraries

default 58

panel and link 55

PSB and DBD 66

table/message/skeleton 55
line range 8
link libraries, specifying 55
Link Pack Area (LPA) 78
LINKLST 78
List - Analyze Submit pop-up 123
List - BackTrack Variable History

pop-up 148
LIST ADSTOP command 122
LIST BREAKS command 134
LIST COUNTS command 122
LIST dataset 56
LIST EQUATES command 158
LIST PSEUDO command 153
LIST TAILOR command 155
LIST TRACKING command 122
Load Module Intercept List pop-up 54
load modules, intercepting 54
LOCATE * command 133
LOCATE command 157
locating next executable statement 133
log dataset, ISPF 56
Log Name Customization pop-up 23
Log/List/Punch processing options 19
LOGA execution parameter 78
logging

access method 78

facility 66

run-time activities 66
logical terminal name 75
long message area 6
LPA (Link Pack Area) 78
LPRINT command 171

Index
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M

MAIN option, advisory modes 26
management classes, SMS 28
Message Format Service library 86
message libraries, specifying 55
message queues 75, 88
messages

long 6, 183

printing 184

short 5, 183
MFS (Message Format Services) 84
modify program logic 149
MON execution parameter 78
MONITOR

guidelines 123

testing mode 122
monitoring

BTS transactions 81

dataset 66
MOVE command 150
multiple program processing 154
MYVS Batch session 188

N
NBA execution parameter 76
new user introduction 13
NOMONITOR
facilities not available 123
guidelines 123
testing mode 123
NOTES in help 179
NVC 75

o
OBA execution parameter 76
Open pull-down 154
OPT execution parameter 75
optimization considerations 9
Options - Allocation Definition
pop-up 112
Options - Log/List/Punch Definitions pop-up
example 20
field descriptions 20
Options - Modes pop-up 26
Options - PF Key Definition pop-up 25
Options - Product Allocations pop-up
example 18
field descriptions 19
Options - Product Parameters pop-up
example 17
field descriptions 18

Options - Script File Allocations pop-up

example 24

field descriptions 24

setting defaults 24
Options Menu screen 16
options, setting and verifying 16
OUT execution parameter 75

P

page-fixed buffers 76
panel libraries, specifying 55
parameter definition 17
PARDLI execution parameter 76
patch (./P) cards 83
pattern string 8
PCB alternate output 84, 90
PF keys, defining 25
PL/I
optimization considerations 9
statements 163
subsets 163
plan name 191
pop-up 4
PREINIT execution parameter 76
Preview BTSIN Data Set screen
example 82
field descriptions 82
printing
messages 184
program information 171
PRLD execution parameter 75, 78
PROC statements 165
PROCLIB allocation 68
PRODLVL command 160
product integration xiii
profile
restoring 49
saving 47
sharing 48
test session setup 47

Profile Data Set Member List screen 47

program
analyzing 30
controlling execution 124
entry point alias name 187
intercepting 124
modifying logic 149
printing information 171
VIASMPRT 184
Program View screen 5, 133
example 114
line numbers 8
screen descriptions 114



PSB
allocation 69
libraries 66
pseudo code
&COUNT 151
77 151
adding 150
BREAK 150
COBOL reserved words 151
concepts 149
definition 192
editing 152
entering and editing 152
executing 153
GO TO 150
IF/THEN/ELSE 150
listing 153
making permanent 154
MOVE 150
pslabel 150
removing 153
SUBTRACT 150
viewing 153
WHEN 150
pslabel statement 150
pull-down, Test 125
punch file 192

Q

QALTPCB allocation 88
QALTRAN allocation 90
QIOPCB allocation 86
qualified program 5, 192
QUALIFY command 124, 154

R
RECALL command 159
recalling
commands 159
messages 159
pop-ups 159
Recap
accessing from ESW screen xiii
description xi
recording backtrack execution history 140
region size 112
release and level numbers 160
removing
data windows 138
pseudo code 153
replaying scripts 156
repositioning the display 172
RESET command 138

Index

RESET EXCLUDED command 166
RESET PSEUDO command 153
RESET ZOOM command 138
restoring test session setups 49
retaining commands 159

REUS parameter 123

RST execution parameter 78

RUN command 122, 125

RUN PROGRAM command 101
run-time activities 66

S

S (show) command 166

Sample Edit Session screen 32

sample SmartTest session 13

saving
scripts 155
test session setup 47

scratch pad area §3

screen
Analyze Submit Parameters 33
ASG Abend Codes 182
Batch Session Setup 109
Batch Submit 118
Breakpoints List 132
BTS Allocation Selection 83
BTS Batch Session Setup 117
BTS BTSDEBUG Allocation 96
BTS BTSOUT Allocation 92
BTS BTSPUNCH Allocation 94
BTS BTSSNAP Allocation 98
BTS FORMAT Libraries 86
BTS Load Library 85
BTS QALTPCB Allocation 88
BTS QALTRAN Allocation 90
BTS QIOPCB Allocation 87
BTS Session Setup 79
command input area 5
Connect to Job 113
Connect to Job Message 112
Convert Batch JCL 41
DB2 Batch Session Setup 118
DB2 Session Setup 100
Environment Selection 36
Execution Tracking 123
Existing Systems Workbench 14
File - AKR Allocate/Expand 28
File - AKR Utility 27
File - Analyze Submit 31
File - Execute Script 157
format example 5
general field descriptions 5
Help Explanation and Action
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IMS ACB Allocation 70

IMS Allocation Selection 65

IMS Batch Session Setup 116

IMS BMP Parameters 74

IMS DFSRESLB/DFSESL
Allocation 67

IMS DLI/DBB Parameters 77

IMS IEFRDER Allocation 73

IMS IMSMON Allocation 71

IMS PSB/DBD Allocation 69

IMS/DB in TSO session setup 63

ISPF Allocation 55

ISPF List Data Set Allocation 59

ISPF Log Data Set Allocation 60

ISPF Panel/Link Libraries 57

ISPF Program Load Library 56

ISPF Session Setup 52

ISPF Table/Message/Skeleton
Libraries 58

line command input area 6

List - Analyze Submit 123

List - BackTrack Variable
History 147-148

Load Module Intercept List 54

long message area 6

Options - Log/List/Punch
Definition 20

Options - Modes 26

Options - PF Key Definition 25

Options - Product Allocations 18, 112

Options - Product Parameters 17

Options - Script File Allocations 24

Options Menu 16

Preview BTSIN Data Set 82

PROCLIB/DFSVSAMP
Allocation 68

Profile Data Set Member List 47

Program View 5,8, 114, 133

Pseudo Code List 153

Sample Edit Session 32

Script File Allocations 161

Search - Data Name 170

Search - Subset Name 168

short message area 5

SmartTest Primary 15

SmartTest/Alliance Interface 162

subsets 165

Test - ASG-SmartTest Testpoint
Generation 130

Test - Run Request 125

Test - Run Request (Backtrack
active) 142

Test - Step Request 126

Test - Step Request (Backtrack
active) 144
Test - Testpoint Qualified Program
List 131
Test Session Tailoring 155
TSO Session Setup 38
TSO/ISPF Edit 5
View - Reset Request 167, 169
screen subset 193
script
definition 193
file 2,193
recording 155
replaying 156
STFINDAT 133
SCROLL command 172
scrolling 6, 172
Search - Data Name pop-up 170
Search - Subset Name pop-up 168
search function
excluding lines 166
impact of change 165
IN clause 166
intelligent 163
language subsets 163
limiting 165
primary commands 163
session tailoring 155
SET BACKTRACK command 140
SET command 26
SET SCRIPT command 155
SET XMODE command 168
setting up the DB2 Stored Procedure
test 103
setup
Batch connect 109
BTS in TSO 79
DB2 in TSO 100
DB2 stored procedure 102
IMS/DB in TSO 63
ISPF Dialog Manager 52
using wizards 125
setup considerations
Batch region 115
TSO foreground 46
sharing test session setups 48
simplify entering commands 158
skeleton libraries, specifying 55
SmartDoc
accessing from ESW screen xiii
description xi
SmartEdit
accessing from ESW screen xiii
description xii



SmartTest
accessing from ESW screen xiii
description xii
method of operation 122
terminals supported 25
SmartTest-ASM 173
SmartTest-PLI
and Assembler 173
and COBOL 173
exiting a test session 135
getting started 13
sample session 13
setting up a test session 35
SMS classes 28
SNAP dump 84
SNAP dumps dataset, allocating 95
SPIE execution parameter 75, 77
SRCH execution parameter 78
SRM (System Resource Manager) 78
SSM execution parameter 76
statement execution 126
status box 6
status of job 113
STAX indicator 85
STEP command 126
STFINDAT script 133
STIMER execution parameter 75
storage classes, SMS 28
subset
screen 165
search function 163
tag 165
subsystem identifier 76, 78
SUBTRACT command 150
SWAP execution parameter 78
System Resource Manager (SRM) 78

T

table entry 7
table libraries, specifying 55
tag subset 165
target
dataname 7
description 7
label name 7
pattern string 8
TCA definition 194
terminals supported by SmartTest 25
terminating a test session 49
Test - ASG-SmartTest Testpoint Generation
pop-up 130
Test - Run Request pop-up 125
Test - Run Request pop-up (with Backtrack
active) 142

Index

Test - Step Request pop-up 126
Test - Step Request pop-up (Backtrack
active) 144
Test - Testpoint Qualified Program List
pop-up 131
Test Coverage Analysis (TCA) option 194
TEST execution parameter 75, 77
test initiation
Batch 114
Test pull-down menu 125
test session
allocating an AKR 27
analyzing a program 30
beginning 14
converting JCL to CLIST 40
initiating 45
restoring setups 49
saving setup 47
selecting the test environment 35
setup 35
setting and verifying options 16
sharing setups 48
terminating 49
TSO setup 38
using setup wizards 125
Test Session Tailoring screen 155
testing
Batch region 108
DB2 118
DFHDRP 119
dynamically CALLed load
modules 124
using MONITOR 122
using NONMONITOR 123
TESTPOINT command 130
token 194
token/cursor substitution 158, 189
trace table 84
transaction code name 82
TSO
SYSPROC DD statement 42
terminal attention exit 85
TSO foreground
BTS 79
DB2 programs 100
IMS/DB programs 63
setup 46
TSO Session Setup screen
example 38
field descriptions 39
TSO/ISPF environment 1
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V)
UCEF (Utility Control Facility) 78
user call list 75,77

user options 16
Utility Control Facility (UCF) 78

\%
VIAPALSC CNTL member 161
VIAPDLI 119
VIAPQ* CNTL members 161
VIAPUBTS CLIST 84
VIAPUIMS CLIST 66
VIAPUSPF CLIST 56
VIAQUEUE 111
VIASMPRT program

example JCL 185

JCL 184

output example 186

printing messages 184
View - Reset Request pop-up 167, 169
viewing data 135

at top of screen 138

declarations 138

inline 135

removing windows 138
viewing pseudo code 153
VS identifier 78
VSAM buffer pool, allocating 66

w

WHEN command 150
wizard, setting up environment 125

V4

ZD (zoom display) command 135

ZG (zoom group) command 137

ZGH (zoom group hex) command 137
ZH (zoom hex) command 135

Z0 (zoomout) command 138
ZOOMDATA command 138
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